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Preface

1. About This Document

This user guide is designed to be used as areference in your everyday use of Quantity
One® Software. It provides detailed information about the tools and commands of
Quantity One for the Windows and Macintosh platforms. Any platform differencesin
procedures and commands are noted in the text.

This guide assumes that you have aworking knowledge of your computer operating
system and its conventions, including how to use a mouse and standard menus and
commands, and how to open, save, and close files. For help with any of these
techniques, see the documentation that came with your computer.

This guide uses certain text conventions to describe specific commands and

functions.
Example Indicates
File > Open Choosing the Open command under the File menu.
Dragging Positioning the cursor on an object and holding down
the left mouse button while you move the mouse.
Ctrl+s Holding down the Control key while typing the letter s.
Right-click/ Clicking the right mouse button/
Left-click/ Clicking the left mouse button/
Double-click Clicking the left mouse button twice.

Some of the illustrations of menus and dialog boxes found in this manual are taken
from the Windows version of the software, and some are taken from the Macintosh
version. Both versions of amenu or dialog box will be shown only when thereisa
significant difference between the two.
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2. Bio-Rad Listens

The steff at Bio-Rad are receptive to your suggestions. Many of the new features and
enhancementsin thisversion of Quantity One are adirect result of conversationswith
our customers. Please let us know what you would like to see in the next version of
Quantity One by faxing, calling, or e-mailing our Technical Services staff. You can
also use Solobug (installed with Quantity One) to make software feature requests.



1. Introduction

1.1 Overview of Quantity One

Quantity Oneis apowerful, flexible software package for imaging and analyzing 1-D
electrophoresis gels, dot blots, arrays, and colonies.

The software is supported on Windows and Macintosh operating systems and has a
graphical interface with standard pull-down menus, toolbars, and keyboard
commands.

Quantity One can image and analyze awide variety of biological data, including
radioactive, chemiluminescent, fluorescent, and color-stained samples acquired from
densitometers, phosphor imagers, fluorescent imagers, and gel documentation
systems.

Animage of asampleis captured using the controls in the imaging device window
and displayed on your computer monitor. Image processing and analysis operations
are performed using commands from the menus and toolbars.

Images can be magnified, annotated, rotated, and resized. They can be printed using
standard and video printers.

All datain the image can be quickly and accurately quantitated using the Volume
tools.

The lane-based functions can be used to determine molecular weights, isoelectric
points, VNTRSs, presence/absence and up/down regulation of bands, and other values.
The software can measure total and average quantities, determine relative and actual
amounts of protein, and count coloniesin a Petri dish.

The software can cope with distortions in the shape of lanes and bands. Lanes can be
adjusted along their lengths to compensate for any curvature or smiling of gels.

Image files can be shared among all The Discovery Series™ software. Images can
also be easily converted into TIFF format for compatibility with other Macintosh and
Windows applications.

1-1
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1.2 Digital Data and Signal Intensity

The Bio-Rad imaging devices supported by Quantity One are light and/or radiation
detectors that convert signals from biological samplesinto digital data. Quantity One
then displays the digital data on your computer screen, in the form of gray scale or
color images.

A data object as displayed on the computer is composed of tiny individual screen
pixels. Each pixel hasan X and Y coordinate, and avalue Z. The X and Y coordinates
are the pixel’s horizontal and vertical positions on the image, and the Z valueisthe
signal intensity of the pixel.

Signal intensity of a single pixel

Intensity

¥

- gy

3-D View

2-D View

Fig. 1-1. Representation of the pixels in two digitally imaged bands in a gel.

For a data object to be visible and quantifiable, the intensity of its clustered pixels
must be higher than the intensity of the pixels that make up the background of the
image. Thetotal intensity of a data object isthe sum of the intensities of all the pixels
that make up the object. The mean intensity of a data object is the total intensity
divided by the number of pixelsin the object.

The units of signal intensity are Optical Density (O.D.) in the case of the GS-700™
imaging densitometer, GS-710™ calibrated imaging densitometer, and GS-800™
calibrated densitometer, the Gel Doc™ system, ChemiDoc™ system, ChemiDoc
XRS™ system with awhite light source, or the Fluor-S™ Multilmager system,
Fluor-S™ MAX Multilmager system, Fluor-S™ MAX2 Multilmager system and
VersaDoc™ imaging systems with white light illumination. Signal intensity is
expressed in counts when using the Personal Molecular Imager™ system or the
Molecular Imager FX™ system, Molecular Imager FX Pro™ fluorescent imager,

1-2
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Molecular Imager FX Pro Plus™ multiimager system, or in the case of the Gel Doc,
ChemiDoc, ChemiDoc XRS, Fluor-S, Fluor-SMAX, or VersaDoc when using the UV
light source.

1.3 Gel Quality

Quantity Oneis very tolerant of an assortment of electrophoretic artifacts. Lanes do
not have to be perfectly straight or parallel. Bands do not have to be perfectly
resolved.

However, for accurate lane-based quantitation, bands should be reasonably flat and
horizontal. Lane-based quantitation involves calculating the average intensity of
pixels across the band width and integrating over the band height. For the automatic
band finder to function optimally, bands should be well-resolved.

Dots that appear as halos, rings, or craters, or that are of unequal diameter, may be
incorrectly quantified using the automatic functions.

1-3
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1.4 Quantity One Workflow

The following steps are involved in using Quantity One.

Acquire Image

v

Optimize Image

v v v

Lane and Band Analysis Volume Analysis Colony Counting

v
Report Results

Fig. 1-2. Quantity One workflow.

1.4.a Acquire Image

Before you can use Quantity One to analyze a biological image, you need to capture
the image and save it as an image file. This may be done with one of the several Bio-
Rad imaging instruments supported by this software: the Molecular Imager FX and
Personal Molecular Imager systems; the GS-700, GS-710, and GS-800 Imaging
Densitometers; the Gel Doc, ChemiDoc, and ChemiDoc XRS gel documentation
systems; the Fluor-S and Fluor-S MAX Multilmagers; and the VersaDoc.

The resulting images can be stored in files on a computer hard disk, network file
server, or removable disks.

1.4.b Optimize Image
Once you have acquired an image of your sample, you may need to reduce noise or

background density in theimage. Quantity One has avariety of functionsto minimize
image background while maintaining dataintegrity.

1-4
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1.4.c Analyze Image

Once a“clean” image is available, you can use Quantity One to gather and analyze
your biological data. In the case of 1-D gels, the software hastools for identifying
lanes and defining, quantifying, and calculating the values of bands. Volume tools
allow you to easily measure and compare the quantities of bands, spots, or arrays. The
colony counting controls allow you to count the number of coloniesin a Petri dish, as
well as perform batch analysis.

Qualitative and quantitative data can be displayed in tabular and graphical formats.

1.4.d Report Results

When your analysisis complete, you can print your results in the form of simple
images, images with overlays, reports, tables, and graphs. You can export your
images and data to other applications for further analysis.

1.5 Computer Requirements

This software is supported on Windows 98, XP, NT 4.0, and 2000, or on a Macintosh
PowerPC.

The computer memory requirements are mainly determined by the file size of the
images you will scan and analyze. High-resolution image files can be very large. For
this reason, we recommend that you archive images on a network file server or high-
capacity removable disk.

PC

The following is the recommended system configuration for installing and running
onaPC:

Operating system: Windows 98 SE
Windows NT 4.0 with service pack 6
Windows 2000
Windows XP

Processor: Pentium = 333 MHz

1-5



Quantity One User Guide

RAM:

Hard disk space:

Monitor:

SCSI:

Printer:

Macintosh

= 128 MB or better for Gel Doc, ChemiDoc, ChemiDoc
XRS, and VersaDoc systems.

= 256 MB or better for Molecular Imager FX systems,
Personal FX system, and GS-800 densitometer.

=23GB

17" monitor, 1024 x 768 resol ution (absolutely required),
True color.

Required for all Bio-Rad imaging devices except the Gel
Doc, ChemiDoc, ChemiDoc XRS, and VersaDoc systems.
Adaptec SCSI card recommended.

Optional.

The following is the recommended system configuration for installing and running

on aMacintosh:
Operating system:
Processor/Model:
RAM:

Hard disk space:

Monitor:

SCSl:

Printer:

System 9.0 or higher, excluding Mac OS X.
PowerPC G3 processor or better.

= 256 MB for all Bio-Rad imaging systems.
=23GB

17" monitor, 1024 x 768 resol ution (absolutely required),
Millions of colors.

Required for all Bio-Rad imaging devices except the Gel
Doc, ChemiDoc, ChemiDoc XRS, and VersaDoc systems.
Adaptec SCSI card recommended.

Optional.

Note:  The default amount of memory assigned to this program on the Macintosh is 128
MB. If the total RAM in your Macintosh is 128 MB or less, you should reduce
the amount of memory assigned to the program to 10 MB |ess than your total
RAM. With the application icon selected, go to File > Get Info in your Finder to

1-6
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reduce the memory requirements for the application. See your Macintosh
computer documentation for details.

1.6 Installation

1.6.a Windows

Note:  Windows NT and 2000 users: You must be a member of the Administrators
group to install The Discovery Series software. After installation, members of the
Users group must have “write” accessto The Discovery Seriesfolder to use the
software.

Insert The Discovery Series CD-ROM into your computer. The installer will start
automatically. (If the CD does not auto-start, use Windows Explorer to open the root
directory on the CD-ROM and double-click on the Setup.exefile.)

Theinstaller program will guide you through the installation. Theinstaller will create
adefault directory under Program Files on your computer called Bio-Rad\The
Discovery Series (you can select your own directory if you wish). The application
program will be placed in the Bin folder inside The Discovery Series folder.
Additional directoriesfor storing user profiles and sample images will also be created

Theinstaller will place an application icon on your desktop and create afolder named
The Discovery Series under Programs on your Windows Sart menu.

After installation, you must reboot your computer before using an imaging device.

1.6.b Macintosh

Insert The Discovery Series CD-ROM into your Macintosh. The TDS-Mac folder
will open on your desktop, displaying the installers for The Discovery Series
applications. Double-click on theinstaller for your application.

1-7
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&

Fig. 1-3. Installation program icon (Macintosh).

Theinstaller will guide you through a series of screens. The installer will create a
folder on your hard drive that contains the main application and associated sample
images (you can select adifferent folder if you wish). Theinstallation will also create
afolder called The Discovery Seriesin the Preferences folder in your System folder;
this contains the Help file and various system files.

Once installation is complete, the folder containing the application icon will appear
open on your desktop.

1.7 Hardware Security Key (HSK)

Note:  Initial installation of a network server does require the Hardware Security Key
included in the software package. Installation of an additional Network Client
User to a Network License Server System does not require an HSK. Please refer
to the Network License Installation Guide that ships with Network Licenses.

The Discovery Series software is password-protected using a Hardware Security Key
(HSK), which isincluded in your software package. You must attach the Hardware
Security Key to your computer before you can run the software.

1.7.a Windows

g

> \
N 4
R

Fig. 1-4. PC Hardware Security Key

1-8
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Before proceeding, please turn off your computer.

The HSK attaches to the paralld port on the back of your PC. If aprinter cableis
attached to this port, turn off the printer and disconnect it. After you have attached the
HSK, you can attach the printer cable to the key itself and restart your computer and
printer.

Note:  Some parallel port devices such as zip drives may be incompatible with HSKs.
Please check with your peripherals vendor.

The code for the PC hardware security key isEYYCY. Thisis printed on the key
itsalf.

You will also need to install the system driver that allows the computer to recognize
the HSK.

Note:  Windows NT and 2000 users must be in the local administrator group to install
the HSK driver.

To install the driver, open the Windows Sart menu and select Programs > The
Discovery Series. Select Install HASP Har dware Security Key Driver to begin
installation.

Note:  Windows 98 users must reboot their computer after installing the HSK. Windows
XP, NT and 2000 users do not have to reboot.

1.7.b Macintosh

b/ PtV =

Fig. 1-5. Macintosh Hardware Security Key

Before proceeding, please turn off your Macintosh.

The Macintosh HSK must be inserted in the Apple Desktop Bus (ADB) path. The
ADB port islocated on the back of your Macintosh.

1-9
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I

Fig. 1-6. Apple Desktop Bus icon on back of Macintosh.

The HSK can be inserted at any point in the ADB path—between the computer and
the keyboard, between the keyboard and the mouse, between the keyboard and the
monitor, etc. After you have attached the HSK, you can restart your computer.

The code for the Macintosh HSK is QCDIY. This code is printed on the key itself.

Note:  If your Macintosh does not have an ADB, you may use an ADB-USB converter.

1.8 Starting the Program

The Hardware Security Key must be attached to the computer before you can start the
software (unless you are using a network license).

1.8.a Windows

Theinstallation program creates an application icon on your desktop. To start the

program, double-click on thisicon.

Fig. 1-7. Application icon.

You can also start the program from the Windows Sart menu. Click on the Sart
button, select Programs, select The Discovery Series, and select the application name.

1-10
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1.8.b Macintosh

After installation, the main application folder will be open on your desktop. To start
the program, double-click on the application icon shortcut inside the folder. You can
move this shortcut icon to your desktop.

1.9 Software License

When the software opensfor thefirst time, you will see a Software License screen that
shows the current status of your software license.

With anew HSK or network license, you receive a 30-day temporary license (“Your
license will expire on "). Thetemporary license is designed to give you time
to purchase the software, if you have not already done so.

a Welcome to Quantity One,

Current License Check License

Single system license.
License expires on 24-Aug-2002. Fun

Check Licenze On-ine. Enter Pazsword

If pour registration has been updated with Bio-Rad, this

will update pour pagzword and service will continue Reqistration Form
without interruption.

Ewit Qluantity Ore
Run.
Fiun the program as usual. EEE

Fig. 1-8. Temporary license screen.

During the 30-day period, the Software License screen will appear every time you
open the software. To use the software during this period, click on the Run button.

1-11
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Network license holders can click on the Check License button at any time during the
30-day period to activate their full network license. (If your network license is not
activated when you click on Check License, notify your network administrator.)

HSK users have 30 days to purchase the software and obtain a purchase order number
and software serial number from Bio-Rad. When you have this information, click on
the Check License or Registration Form button in the Software License screen to

register your software.

£ Software License Registration Form

Flease fill out the form below to authorize full use of your software

If you have Intermet access, please send the form directly to Bio-F ad by clicking on the Submit via Internet button
This will immediately update your registration.

If pou do not have Intermet access, you can print out this form and send it to Bio-Rad. NOTE: There will be a delay
while we update your registration. ‘You can either.

1. Fax the form ta Bio-Flad at 1-510-741-5885. ‘We wil then e-mail or Fax you your passsword.
2. Call 1-800-424-6723 #2601 [inzide U.S.) ar 1-510-741-2601 [Intl.] and ask for Software Registration.
3. E-mail the cantents of thiz farm ta LSG. Software. Hegistration@Bio-Rad.com

Far netwark license registrations or software upgrade registrations, please submit your request for a new password
by emai anly. Include pour system 10, purchase order number, and the software catalogue number purchased along
with the standard registration info in wour message text.

Software User | |Company ar Institut\onl | Purchase Information | | Software and Systemn

Dir_dtdr At s

First Mame* |

Last Mame* |

Fhone #* |
Fax #

|
E-mail |

Submit via Intemel| =1 Frint | Close |

Fig. 1-9. Software License Registration Form.

Fill out the information in the Software License Registration Form. Be sure to enter
your purchase order number and software serial number under the Purchase

I nformation tab when registering.

1.9.a Registering by Internet

If you have Internet access from your computer, click on the Submit via Internet

button to send the Software Registration Form directly to Bio-Rad.

1-12
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Your information will be submitted, and a temporary password will be generated
automatically and sent back to your computer. Simply continue to run the application
as before.

Bio-Rad will confirm your purchase information and generate a permanent license.
After 2-3 days, click on Check License in the Software License screen again to
update to a permanent password. (The Software License screen will not appear
automatically after the temporary password has been generated; the software will
simply open normally. Go to the Help menu and select Register to open the Software
License screen.)

1.9.b Registering by Fax or E-mail

If you do not have Internet access, click on the Print button in the Software License
Registration Form and fax the form to Bio-Rad at the number listed on the form.
Alternatively, you can enter the contents of the form into an e-mail and send it to Bio-
Rad at the address listed in the Registration Form.

Bio-Rad will contact you by fax or e-mail in 2-3 days with afull license.

1.9.c Entering a Password

If you fax or e-mail your registration information, you will receive a password from
Bio-Rad. You must enter this password manually.

To enter your password, click on Enter Passwor d in the Software License screen. If
you are not currently in the Software License screen, select Register from the Help
menu.

1-13
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Enter Password

To register, please contact Bio-Rad durind - cynent license
U5/Facific business hours: g ]
Single system license.

Phane: 1-800-424-8723 x2801 (in the U.S.] License expires on Z24-Aug-200Z_
1-510-741-2601 (Intl)

e ~Sustem 1D
Agk, for Software Registration.
Fax  1-510-741-5885 CWPALANES
e-mail  L5GE. Software Registration(@Bio-F ad.com Plesamar)
Please provide the information in the Quantity One | 0K Mot Ok

completed registration farm.

Far hetwark licenze registrations or software upgrade

reqgistrations, please submit your request for a new Enter | Cancel
pazaword by email only. [nclude vour spstem 1D, Q
purchaze arder number, and the software catalogue

number purchased along with the standard registration

info in your meszage text.

Fig. 1-10. Enter Password screen.

In the Enter Password screen, type in your password in the field.

Once you have typed in the correct password, the OK light next to the password field
will change to green and the Enter button will activate. Click on Enter to run the
program.

1.10 Downloading from the Internet

You can download atrial version of the software from Bio-Rad’'s Web site. Go to The
Discovery Series download page at www.bio-rad.com/softwar edownloads and
select from the list of applications. Follow the instructions to download the installer
onto your computer, then run the installer.

After installation, double-click on the application icon to run the program. The
software will open and the Software License screen will be displayed.

Note: I you attempt to start the downloaded program and receive an “Unable to obtain
authorization” message, you will need a Hardware Security Key to run the
program. Contact Bio-Rad to obtain a key.
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Software License

a Welcome to Quantity One.

30-day Free Trial. Free Trial |
Allows you to fully uze the package to create and
analyze the images of vour choice. ou will need Bl
ta fill aut the Registration Forn and submit it ko
Bio-Rad.
Enter Passwond
Basic mode.

Allows you to acquire new images, open existing images, Reqistration Farm

perform basic editing funchions, print, export ta TIFF,

and Save. Click Help for further information. Contact Exit Quantity One

your local Bio-Fad office for information on purchasing
Help

a full user license, or wisit us on-line at www. bio-rad.com.

Fig. 1-11. Free Trial screen.

In the Software License screen, click on the Free Trial button. Thiswill open the
Software License Registration Form. Enter the required information (you will not
have a purchase order number or software serial number, and can leave these fields
blank) and click on Submit Via Internet.

A freetria password will be automatically downloaded to your computer. This
password will allow you to use the software for 30 days.

If you decide to purchase the software during that period, contact Bio-Rad to receive
a software package and a Hardware Security Key. You can then complete the
registration process as described in the previous sections.

1.11 Quantity One Basic

Quantity One can be run in Basic mode. Quantity One Basic does not require a
software license. The program can be installed and used simultaneously on unlimited
numbers of computers. Quantity One Basic is alimited version of the flexible and
powerful Quantity One.
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The following functionality is active in Basic Mode: Image acquisition with Bio-Rad
imaging devices, Transform, Crop, Flip, Rotate, Text Tool, Volume Rectangle Toal,
Volume Circle Tool, Density Tools, Print, Export to TIFF, and Save.

1.12 Contacting Bio-Rad

Bio-Rad technical service hours are from 8:00 am. to 4:00 p.m., Pacific Standard
Timeinthe U.S.

Phone: 800-424-6723
510-741-2612
Fax: 510-741-5802
E-mail: LSG.TechServ.US@Bio-Rad.com

For software registration:
Phone: 800-424-6723 (inthe U.S.)
+1-510-741-6996 (outside the U.S.)
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2.

General Operation

This chapter describes the graphical interface of Quantity One, how to access the
various commands, how to open and save images, how to set preferences, and how to
perform other basic file commands.

2.1 Menus and Toolbars

2.1.a Menu Bar

Quantity One has a standard menu bar with pulldown menus that contain all the major
features and functions available in the software.

File—Opening and saving files, imaging device controls, printing, exporting.
Edit—Preferences, other settings.

View—Image magnification and viewing tools, tools for viewing image data.

Image—Image transform, advanced crop, image processing and modification.
Lane—L ane-finding tools.

Band—Band-finding and band-modeling tools.

Match—Tools for calculating molecular weights and other values from
standards, tools for comparing lanes and bands in lanes.

\olume—Band quantity and array datatools.

Analysis—Colony counting, Differential Display, VNTR analysis.
Reports—Band and lane analysis reports, Phylogenetic Tree, Similarity Matrix.
Window—Commands for arranging multiple image windows.

Help—Quick Guides, on-line Help, software registration.

Below the menu bar is the main toolbar, containing some of the most commonly used
commands. Next to the main toolbar are the status boxes, which provide information
about cursor selection and toolbar buttons.
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2.1.b Main Toolbar

The main toolbar appears below the menu. It includes buttons for the main file
commands (Open, Save, Print) and essential viewing tools (Zoom Box, Grab, €tc.),
aswell as buttons that open the secondary toolbars and the most useful Quick Guides
(Printing, Volumes, Molecular Weight, and Colony Counting).

RE | Javacnm A0 PSS TETT st

| I I I |
| | |

File commands Viewing commands Toolbars Quick Guides

Fig. 2-1. Main toolbar.

Tool Help
If you hold the cursor over atoolbar icon, the name of the command will pop up
below the icon. This utility is called Tool Help. Tool Help appears on atime delay

basis that can be specified in the Preferences dialog box (see section 2.5,
Preferences). You can also specify how long the Tool Help will remain displayed.

2.1.c Status Boxes

There are two status boxes, which appear to the right of the main toolbar.

':'i'l,J Foo Box Dirar abiozx to expand the image inside.

Fig. 2-2. Status boxes.

The first box displays any function that is assigned to the mouse. If you select a
command such as Zoom Box, the name and icon of that command will appear in this

status box and remain there until another mouse function is selected or the mouseis
deassigned.

The second status box is designed to supplement Tool Help (see above). It provides
additional information about the toolbar buttons. If you hold your cursor over a
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button, ashort explanation about that command will be displayed in this second status
box.

2.1.d Secondary Toolbars

Secondary toolbars contain groups of related functions. You can open these toolbars
from the main toolbar or from the View > Toolbars submenu.

The secondary toolbars can be toggled between vertical, horizontal, and expanded
formats by clicking on the resize button on the tool bar itself.

Expanded format Horizontal format Vertical format
mage Tools x| | Image Tools =] El
Crop ﬂ gt | * | diml e Y| 4 B & 'Ei
Hotate 90 Left -
f‘% Yertical Flip ﬂ [ETEEE0| 4 ol
Ta . - T
3 Hearizontal Flip j Hold cursor over icon E
to reveal the “tool tip” -
g‘f:,-,_ Rotate 90 Left j £
;}R Fictate 90 Right ﬂ < Click on guestion marks g'a.h
for on-line help
150
)| Rotatetsn 7 D
)gfq Custorn Fotation j W
Zio| Fiterwizard.. 7| %
Z@| Invert Data... ? -
j J Click on resize button
gf | € totoggle format > i3

Fig. 2-3. Secondary toolbar formats and features.

The expanded toolbar format shows the name of each of the commands. Click on the
? icon next to the name to display on-line Help for that command.
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2.1.e Quick Guides

The Quick Guides are designed to guide you through the major applications of the
software. They are listed under the Help menu; four of these are also available on the
main toolbar.

Help
Quantity Cne Basic Quick Guide 7 7 ?E: 7
Printing Quick Guide % =2 =
Yolumes Quick Guide | ‘ ‘

Band Analysis Quick Guide
Colony Counting Quick Guide
Differential Display Cuick Guide
Phylogenetic Tree Quick Guide
VTR Cuick Guide

Fig. 2-4. Quick Guides listed on Help menu and main toolbar.

The Quick Guides are similar in design to the secondary toolbars, but are application-
specific. Each Quick Guide contains all of the functions for a particular application,
from opening the image to outputting data.
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i YH 7
@ i .EE .
Select Volumes

Quick Guide from
main toolbar

Commands are numbered

to indicate sequence for
preparing the image, —
creating volumes, and
outputting data

Yolumes Quick Guid

_@1.
=

3.
@4.
ﬂs
|,
ﬂ?
@a.

Select Scanner...
Open...

Zoom Box

Trarzfarm...

Wolurne Rect Toal
Yolurne Free hand T ool
Yolume Contour Tool

Select Tool

Print Image... !

| Wolume Analyziz Report. .. ﬂ

Key commands —— » keyboard commands:
Chrl-click = copy a volume box
Shift-click = ratate a walume box

IR

Question marks
open on-line
Help

——Toggle format

Fig. 2-5. Example of a Quick Guide: Volumes

In their expanded format, the Quick Guide commands are numbered as well as
named. The numbers provide a suggested order of operation; however, not every
command isrequired for every application.

Aswith the secondary toolbars, you can click on the ? next to the name of afunction

to display the Help text.

2.1.f Right-Click Context Menu

With an image open, right-click anywhere on the image to display a context menu of

common commands.
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] iew Ertire Image
'&{izmm B

']
Tranzfarm...

[+ Select Taol

Hide Cverlays
@ Image Infa...
EhPrint Image...
. Image Colars...

"o Denaity at Cursar

¥ Band Attributes...

Fig. 2-6. Selecting Zoom Box from the right-click context menu.

You can select commands from this menu as you would from a standard menu.

2.1.g Keyboard Commands

Many commands and functions can be performed using keyboard keys (e.g., pressthe
F1 key for View Entire Image; press Ctrl+S for Save). Select Keyboard L ayout
from the Help menu to display alist of keys and key combinations and their
associated commands.

The pulldown menus also list the shortcut keys for the menu commands.

2.2 File Commands

The basic file commands and functions are located on the File menu.
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File Edit Yiews Image Lane Band

Qpen... Chrl+O
Save Chrl+5
Save As...

Save Al Chrl+y
Close Alc+F4
Close Al

Unload

Change Wersion...
Resvert ko Saved...
Image Info... Chrl+I
Reduce File Size. ..

Gel Doc...
ChemiDac...
ChemiDoc XRS...
G5-700., .,
G5-710..,
5-500, .,
Fluor-5...
Fluor-5 Max. ..
Fluor-5 MAXZ. ..
VersaDoc. ..
Personal Fi,..
Fx...

Print 4
Export bo TIFF Image. ..

Exit Chrl+Q

Fig. 2-7. File menu.

2.2.a Opening Images
To open a saved image, select Open from the File menu or click on the Open button

on the main toolbar. This opens the standard Open dialog box for your operating
system.
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Macintosh version: select a File:
[Gg Sample Images | 2 | =, Disk 1
Colony Counting.15C B
MicroSatellite.15C
Proteins.15C
]
I Show all files
Windows version:  [if=3 (2] <]
Look in: IaDw Database j = rji v
- Mame * | Sizel Type | Modified |
@ [Z1 backup File Folder B/9/2000 3:25 P
History Dztabase.1.ddb 109KE  TDS DivDE Databas.. 5/9/2000 3:25 PM
Database.2.ddb Z6KE  TDS DivDE Datahas.. 5/3/2000 214 PM

33KB  TDS DivDBE Databas..  11/4/1993 10:02 AM
483KB  TDS 1-D Scan file 441242000 343 PM

@

m. Image.2.15c S89KE  TDS 1-D Scan file 1144415933 10:02 &M
[ Image. 3.1sc E10KE  TDS 1-D Scan file 1144415999 10:02 &M
tdp Documents Image 4.13c R96 KB TDS 1-D Scan file 11/4/199310:02 AM
| Image.5.15c E22KB  TDS 1-D Scan file 5/3/2000 215 PM
Image.6.1sc 572KB  TDS 1-D Scan file 114441999 10:02 &M
test.Tsc TOKE TDS 1-D Scan file 5/3/2000 1:56 Pk

File name: I j Open I
Files of type: ILUadabIe Images & D atabases j Cancel |

2

Fig. 2-8. Open dialog box.

In the dialog box, open afile by double-clicking on the file name. To open multiple
files, first select them using Ctrl-click or Shift-click key combinations, and then click
on the Open button.

An image created in the Windows version of Quantity One can be opened in the
Macintosh version, and visa versa. However, you must add a .1sc extension to your
Macintosh files to open them in Windows.

Note:  Thisversion of Quantity Onewill open any image created with an earlier version
of Quantity One.
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You can also open images from other The Discovery Series software (PDQuest,
Diversity Database, DNACode).

The application comes with a selection of sample images. In Windows, these are
located in The Discovery Series/Sample Images/1D directory. On the Macintosh, they
are stored in the Sample Images folder in the Quantity One folder.

Opening TIFF Images

The Open command can also be used to import TIFF images created using other
software applications.

There are many types of TIFF formats that exist on the market. Not all are supported
by The Discovery Series. There are two broad categories of TIFF filesthat are
supported:

1

Note:

8-hit Grayscale. Most scanners have an option between line art, full color, and
grayscale formats. Select grayscale for use with The Discovery Series software.
In agrayscale format, each pixel is assigned avalue from 0 to 255, with each
value corresponding to a particular shade of gray.

16-bit Grayscale. Bio-Rad's Molecular Imager FX and Personal Molecular
Imager and Fluor-S, and VersaDoc imaging systems use 16-bit pixel valuesto
describe intensity of scale. Molecular Dynamics™ and Fuji ™ imagers also use 16-
bit pixel values. The Discovery Series understands these formats and can
interpret images from both Bio-Rad and Molecular Dynamics storage phosphor
systems.

The program can import 8- and 16-bit TIFF images from both Macintosh and PC
platforms.

TIFF files that are not supported include:

1

1-bit Line Art. Thisformat is generally used for scanning text for optical
character recognition or line drawings. Each pixel in animageisread as either
black or white. Because the software needs to read continuous gradations to
perform gel analysis, this on-off pixel format is not used.

24-bit Full Color or 256 Indexed Color. These formats are frequently used for
retouching photographs and are currently unsupported in The Discovery Series,
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although most scanners that are capable of producing 24-bit and indexed color
images will be able to produce grayscale scans as well.

3. Compressed Files. The software does not read compressed TIFF images. Since
most programs offer compression as a sel ectable option, files intended for
compatibility with The Discovery Series should be formatted with the
compression option turned off.

2.2.b Saving Images

To save anew image or an old image with changes, select Save from the File menu.
In Windows, new images will be given a .1sc extension when they are first saved.

Save As can be used to save anew image, rename an old image, or save a copy of an
image to a different directory. The standard Save As dialog box for your operating
system will open.

To save al open images, select Save All from the File menu or click on the button on
the main toolbar.

2.2.c Closing Images

To close an image, select Close from the File menu. To close all open images, select
Close All. You will be prompted to save any changes before closing.

2.2.d Revert to Saved

To reload the last saved version of an image, select Revert to Saved from the File
menu. Because any changes you made since last saving the file will be lost, you will
be prompted to confirm the command.

2.2.e Image Info

Image I nfo on the File menu opens a dialog box containing general information
about the selected image, including scan date, scan area, number of pixelsin the
image, data range, and the size of the file. Type any description or comments about
theimage in the Description field.
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%% Image.1 [1D Scan)

C:
Program Files
Bio-Rad

File
The Discowery Series
Info
Sample Images
Iiv Database
Image.l.lsc
Description
Scan date September 1, 15593
Scanner Desktop

Scan area[mm] ¥ 11z.8 Y. 35.9
Scan pinels ®ollz0 Y 38l
Pinel size [um] ¥ 238 Y. 99.§
[Data range 0.0 - 1.00 OD

Memory size 400.29 Kb

Higtary

ak. | Cancel | Print |

Fig. 2-9. Image Info box.

History lists the changes made to the image including the date. If you have Security
Mode active, the name of the user who made the changeis also listed (See Section
2.5, Preferences for information on Security Mode).

To print the file info, click on the Print button in the dialog box.

Changing the Image Dimensions

You can change the dimensions of certain images using the Image Info dialog box.
Thisfeature is only available for images captured by a camera or imported TIFF
images in which the dimensions are not already specified.
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For these types of images, the Image Info dialog box will include fields for changing
the image dimensions.

= Colony Counting ¥2 (1D Scan)

WINNT

File Profiles
Info swarric
Desktop

Colony Counting wZ.lsc

Description
Scan date 08-Jun-1999 1Z:30
Scanner

Fields for changin

X . 9 g Scan area [mm] : |J.6?_3 ' |J.63_3

the image dimensions
Scan pivels = 7T 405
Pixel gize [um] |403_2 ' |403.2
Data range 0.0 - Z55.00 Int

temon size 166,62 Kb

Histaory

Ok, | Cancel | Pritat |

Fig. 2-10. Image Info dialog box with fields for changing the image dimensions.

Enter the new image dimensions (in millimeters) in the appropriate fields. Note that
the pixel sizein the image (in micrometers) will change to retain the same number of
pixelsin theimage.

2.2f Reduce File Size

High-resolution image files can be very large, which can lead to problems with
opening and saving. To reduce the file size of an image, you can reduce the image
resolution by reducing the number of pixelsin theimage. (You can also trim
unneeded parts of an image to reduce its memory size. See section 3.9.a, Cropping
Images.)

2-12



Chapter 2. General Information

This function is comparable to scanning at alower resolution, in that you are
increasing the size of the pixelsin the image, thereby reducing the total number of
pixels and thus the file size.

Note:  Inmost cases, reducing the resolution of an image will not affect quantitation. In
general, aslong as the pixel size remainsless than 10 percent of the size of the
objects in your image, changing the pixel sizewill not affect quantitation.

Select Reduce File Size from the File menu to open the Reduce File Sze dialog box.
The dialog box lists the size of the pixelsin the image (Pixel Size: X by Y microns),
the number of pixelsin theimage (Pixel Count: X by Y pixels), and the memory size
of theimage.

2o -3l Fieduce File Size

Wideh () Height (Y}
Pisel Size |169_53 by |169_39 wicrons
Pixel Count |633 by |’?56

Memom Size 457,322 Hb

QK | Cancel | Help

Pixel size in the “x” dimension increased

Reduce File Size

After:
Width (X Height (Y}
Pisel Sizs  [255. 76 by 16539 wicrons
Pixel Count |358 by |’?56

Memom Size ze4. 320 Hb

/ QK | Cancel | Help

Pixel Count and Memory Size reduced

Fig. 2-11. Reduce File Size dialog box, before and after pixel size increase.

Lower the resolution by entering lower valuesin the Pixel Count fields or higher
valuesin the Pixel Szefields (seethe figure for an example).

2-13



Quantity One User Guide

Note:  Since with most 1-D gels you are more concerned with resolving bandsin the
vertical direction than the horizontal direction, you may want to reduce the file
size by making rectangular pixels. That is, keep the pixel sizeinthe“y”
dimension the same, while increasing the sizein the “x” dimension.

When you are finished, click on the OK button.

A pop-up box will give you the option of reducing the file size of the displayed image
or making a copy of the image and then reducing the copy’s size.

Reducing thefile sizeisan irreversible process. For that reason, we suggest that you
first experiment with a copy of the image. Then, when you are satisfied with the
reduced image, delete the original.

= Quantity One

A Confirm reduce rezolution?

Feady to reduce 'Protein «2 [10 Scan]' to
[400.43, 163.39] micron resolution. The image
zize will be [268,756) pixels. |f you choose

to reduce in place the descriptions of objects
i thiz zcan will be logt, Only the zcan image
itzelf will be retained.

Reduce | Reduce and Cnpyl Cancel

Fig. 2-12. Confirm Reduce File Size pop-up box.

2.3 Imaging Device Acquisition Windows

The Filemenu containsalist of Bio-Rad imaging devices supported by Quantity One.
These are:

1. Ge Doc

2. ChemiDoc

3. ChemiDoc XRS
4

GS-700 Imaging Densitometer
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GS-710 Imaging Densitometer
GS-800 Calibrated Densitometer
Fluor-S Multilmager

Fluor-S MAX Multilmager

© ®© N o o

Fluor-S MAX2 Multilmager
10. VersaDoc

11. Personal Molecular Imager FX
12. Molecular Imager FX

To open the acquisition window for an imaging device, select the name of that device
from the File menu.

See theindividual chapters on the imaging devices for more details.

2.4 Exit

To close Quantity One, select Exit from the File menu. You will be prompted to save
your changes to any open files.

2.5 Preferences

You can customize basic features of Quantity One—such as menu options, display
settings, and toolbars—using the Preferences dialog box. Select Prefer encesfrom the
Edit menu to open this dialog.
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= Preferences

Mizc || Paths || Dizplay || Toolbars ||Applicati0n|| Imagers

tdemamny Allowance (E1z2. 00 Mb

Ikstitute M ame |Bio—Rad Lakoratories
[#] S ecurity Mode [C1Masimize application window
Edit Users. . []Use Custom Open Dialog

[ &uto Logout After | =0 Minutes.
[ GLP/GMP Made

[_]1Enable DOS filename parsing
[#] Enable Linix filename parsing

v 0K I }(_Cancel| Z Help |

Fig. 2-13. Preferences dialog box.

Click on the appropriate tab to access groups of related preferences. After you have

selected your preferences, click on OK to implement them.

2.5.a Misc.

Click on the Misc tab to access the following preferences.

Memory Allowance

To specify the amount of virtual memory allocated for the application at start-up,
enter avalue (in megabytes) in the Memory Allowance field. The default value of
512 megabytesis recommended. If you receive awarning message that the amount of
virtual memory is set too high, you can enter asmaller valuein this field. However,
this should be considered a temporary fix, and you should consider expanding your

hard drive.

Institute Name

Enter the name of your institution in thisfield.
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Security Mode

Security Mode alows you to set up alist of users who can activate Quantity One
functions on thelocal machine. Security Mode allows you to track any changes made
to images. If Security Mode is active, select File>Image Info... to view thelist of
changes to the file and who made the changes.

To activate Security Mode, check the box labeled Security Mode. Once checked, you
will be prompted for anew Security Mode password which will be required for
making changes, adding or removing users, or for disabling Security Mode.

With Security Mode active, a user must enter a user name and password to activate
Quantity One commands. Security Mode is machine specific, so any images residing
on a network or shared drive can be accessed from another machine that does not
have Security Mode active. Although changes made on other machines are recorded
in the Image info dialog, no user name appears. The same is also true for changes
made to images while Security Mode isinactive.

Auto L ogout

To have Quantity One automatically log out the current user after a period of
inactivity, check the box labeled Auto Logout after and enter a number of minutesin
thefield. After the time has expired, the user will have to log in again to resume using
Quantity One.

Adding and Removing Users

Once you activate Security Mode, you can add users to your list. Click Edit Usersto
open the Security Mode Users dialog.
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= Security Mode Users

Edit Llsers

Alan
Eruce
Gary
Kewin
Nedil

Mew. .. |Ehangem| Delete |

Cancel| OF

Fig. 2-14. Security Mode Users Dialog

Click Add to add a new user. Enter a user name and password. To remove a user,
highlight the name in the list and click Remove. This permanently removes the user
from thelist. However, any changes made by this user remain in the history section of
the Image Info dialog.

GLP/GMP Mode

The GLP/GM P Mode checkbox allows you to prevent changes to an image that
would change the raw image data. In GLP/GMP mode, the following commands and
submenus will be disabled:

e ReduceFile Size (File menu)

e Subtract Background (Image menu)
e Custom Rotation (Image menu)

e Filter Wizard (Image menu)

e Filter List (Image menu)
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e Invert Data (Image menu)

If you attempt to use any of these functionsin GLP/GMP mode, you will receive a
message that the function is not available.

To set GLP/GMP mode, click on the checkbox. You will be prompted to enter the
Security Mode password.

To disable GLP/GMP mode, click on the checkbox to deselect it, then enter the
Security Mode password for confirmation.

Note:  GLP/GMP modeisonly availableif Security Modeis active.

Use Custom Open Dialog

By default, Quantity One uses the standard Open dialog box for the operating system
you are using (Windows and Macintosh). Quantity One also has a customized Open
dialog box, which includes some navigational features that are specifically tailored to
The Discovery Series software. Select this checkbox to display this custom dialog
box.

Maximize Application Window

In the Windows version, select the Maximize Application Window checkbox to
automati cally maximize the application window when Quantity One first opens. If
thisis unchecked, the menu and status bars will appear across the top of the screen
and any toolbars will appear “floating” on the screen.

Enable DOS Filename Parsing

If this checkbox is selected, for 8-character file names ending in two digits, the final
two digits are interpreted as version and exposure numbers. For example, the file
name IMAGE-11.1sc would be parsed asIMAGE ver 1 xpo 1.1sc. Thisisdesigned to
enable backwards compatibility for users with DOS image files. You should only
check this box if you are using these imagefiles.
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Enable UNIX Filename Parsing

Thisissimilar to DOS file name parsing. Windows and Macintosh users are unlikely
to runinto difficulties with UNIX parsing; therefore, this setting is checked by
default.

2.5.b Paths

Click on the Paths tab to access the following preference.

Temporary File Location

Temporary image files are normally stored in the TMP directory of your The
Discovery Seriesfolder. The full pathislisted in the field. To change the location of
your temporary files, click on Browse and select a new directory. To return to the
default TMP directory, click on the Default checkbox.

2.5.c Display

Click on the Display tab to access the following preferences.

Zoom %

Zoom % determines the percentage by which an image zoomsin or out when you use
the Zoom In and Zoom Out functions. This percentage is based on the size of the
image.

Pan %

Pan % determines the percentage by which the image moves side to side or up and
down when you use the arrow keys. This percentage is based on the size of theimage.

Jump Cursor on Alert (Windows only)

Select Jump Cursor on Alert to set the cursor to automatically jump to the OK
button in a pop-up dialog box.
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Auto “Imitate Zoom”

When this checkbox is selected, the magnifying and image positioning commands
used in one window will be applied to al open windows. Thisis useful, for example,
if you want to compare the same band of group of bandsin different gels; magnify the
band(s) in one gel, and the same area will be magnified in al the other gel images.

Note that the images must be approximately the same size.

Band Style

Bands in your gel image can be marked with brackets that define the top and bottom
boundaries of the band, or they can be marked with a dash at the center of the band.
Indicate your preference by clicking on the Brackets or Lines button. (This setting
can be temporarily changed in the Band Attributes dialog box. However, all newly
opened images will use the preferences setting.)

2.5.d Toolbar

Click on the Toolbar tab to access the following preferences, which determine the
behavior and positioning of the secondary toolbars and Quick Guides.

Show Volumes Quick Guide

If this checkbox is selected, the Volumes Quick Guide will open automatically when
you open the program.

Align Quick Guide with Document

If this checkbox is selected, the Quick Guideswill open flush with the edge of your
documents. Otherwise, they will appear flush with the edge of the screen.

Guides Always on Top

If this checkbox is selected, Quick Guides will always appear on top of images and
never be obscured by them.
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Quick Guide Placement and Toolbar Placement
These checkboxes determine on which side of the screen the Quick Guides and
toolbars will first open.

Placement Behavior

This setting determines whether a Quick Guide or toolbar will always pop up in the
same place and format (Always Auto), or whether they will pop up in the last
location they were moved to and the last format selected (Save Prior).

Toolbar Orientation

These option buttons specify whether toolbars will first appear in avertical,
horizontal, or expanded format when you open the program.

Tool Help Delay and Persistence

Specify the amount of time the cursor must remain over atoolbar icon before the Tool
Help appears by entering avalue (in seconds) in the Tool Help Delay field.

Specify the amount of time that the Tool Help will remain on the screen after you
move the cursor off a button by entering a value (in seconds) in the Tool Help
Persistencefield.

2.5.e Application

Click on the Application tab to access the following preferences.

Relative Quantity Calculation

The Relative Quantity Calculation option allows you to define how the relative
quantities of defined bandsin laneswill be determined for all reports, histograms, and
band information functions: either as a percentage of the signal intensity of an entire
lane or as a percentage of the signal intensity of the defined bandsin alane.

Selecting % of Lane means that the total intensity in the lane (including bands and
theintensity between bands) will equal 100 percent and the intensity of aband in that
lane will be reported as a fraction thereof.
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Selecting % of Bandsin L ane means that the sum of the intensity of the defined
bandsin alane will equal 100 percent, and the intensity of an individual band will be
reported as a fraction of that sum.

If you create, adjust, or remove bands in alane with Relative Quantity defined as %
of Bandsin L ane, the relative quantities of the remaining bands will be updated.
Relative Front Calculation

The Relative Front Calculation option lets you select the method for calculating the
relative positions of bandsin lanes. This affects the calculation of both Relative Front
and Normalized Rf values.

Relative front is calculated by either:

1. Dividing the distance a band has traveled down alane by the length of the lane
(Follow Lane). Thisisuseful if your gel imageis curved or slanted.

2. Dividing the vertical distance a band has traveled from the top of alane by the
vertical distance from the top of the lane to the bottom (Vertical).

Note:  “Lane” and “band” refer here to lanes and bands as defined by overlays on the
gel image. For example, the top of alane refersto the beginning of the lane line
created in Quantity One, not necessarily the actual gel lane.

Notethat if alaneis straight and vertical, both calculation methods will give the same
result.

2.5.f Imagers
Click on thistab to specify the imaging devices that you want to appear on the File

menu. By default, all supported imaging devices will be included; deselect the
checkboxes of the imagers that you do not want to include on the File menu.

2.6 User Settings

If Quantity Oneis on aworkstation with multiple users, each user can have his or her
own set of preferences and settings.
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In multiple-user situations, the preferences and settings are associated with individual
user names. Under Windows, your user name is the name you use to log onto the
computer. On a Macintosh, your user name is the Owner Name on the File Sharing
control panel.

If you do not log onto your Windows PC or do not have a Owner Name on your
Macintosh, then you do not have a user name and your preferences and settings will
be saved in ageneric file.
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3. Viewing and Editing
Images

This chapter describes the viewing tools for magnifying and optimizing images. This
chapter also describes the tools for cropping, flipping, and rotating images, reducing
background intensity and filtering noise, and adding text overlays to images.

These tools are located on the View, Image, Window, and Edit menus.

Note:  The following chapters contain instructions for analyzing X-ray films, wet and

dry gels, blots, and photographs. For the sake of simplicity, these are all referred
toas“gels.”

3.1 Magnifying and Positioning Tools

The magnifying and positioning tools are located on the View menu and Window
menu; some of these functions are also found on the main toolbar.

These commands will only change how the image is displayed on the computer
screen. They will not change the underlying data.
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Toolbars 4

View Entire Image Fi

Zoar Box Fz

Grab Ctrl+G

Zoom In Alt-+F2

Zoom Cuk Ctrl+F2

Plot Density K

Show Lanes and Bands FS

Hide Overlays F4

Multi-channel Yiewer
Image Stack Tool
30 Viewer

Fig. 3-1. Viewing functions on View menu and main toolbar.

Zoom Box

Use Zoom Box to select asmall area of the image to magnify so that it fills the entire
image window.

Click on the Zoom Box button on the main toolbar or select the command from the
View menu. Then drag the cursor on the image to enclose the area you want to
magnify, and release the mouse button. The area of the image you selected will be
magnified to fill the entire window.
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1. Click on Zoom Box button.

2. Drag box on image. 3. Boxed region is magnified to fill window.
[ maed(DSea) _________MEIH|
- T TR T |

[

Kl | a7

Fig. 3-2. Zoom Box tool.

Zoom In/Zoom Out
These toolswork like standard magnifying toolsin other applications.

Click on the Zoom In or Zoom Out button on the main toolbar (or select from the
View menu). The cursor will change to a magnifying glass. Click on an area of the
image to zoom in or out a defined amount, determined by the setting in the
Preferences dialog (see section 2.5, Preferences).

Grab

Thistool allows you to change the position of the image in the image window. Select
Grab from the main toolbar or View menu. The cursor will change to a“hand”
symbol. Drag the cursor on the image to move the image in any direction.

Arrow Keys

You can also move the image inside the image window by using the Arrow keys on
the keyboard. Click on an arrow button to shift the image incrementally within the
window. The amount the image shifts is determined by the Pan % setting in the
Preferences dialog (see section 2.5, Preferences).
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View Entire Image

If you have magnified part of an image or moved part of an image out of view, select
View Entire I mage from the main toolbar or View menu to return to the original, full
view of theimage.

Centering an Image

You can center the image window on any point in an image quickly and easily using
the F3 key command. Thisis useful if you are comparing the same region on two gel
images and want to center both image windows on the same point.

Position the cursor on the point on the image that you want at the center of the image
window, then pressthe F3 key. Theimagewill shift so that point is at the center of the
image window.

Imitate Zoom

To magnify the same area on multiple images at the same time, use the I mitate Zoom
command on the Window menu.

First, adjust the magnification in one of the images. Then, with that image window
still selected, select I mitate Zoom. The zoom factor and region of the selected image
will be applied to all the images.

Note:  Imitate Zoom only works on images with similar dimensions.

Tiling Windows

If you have more than one image open, the Tile commands on the Window menu
alow you to arrange the images neatly on the screen.

Select Tileto resize all the windows and arrange them on the screen left to right and
top to bottom.

Select Tile Vertical to resize all windows and arrange them side-by-side on the
screen.

Select Tile Horizontal to resize all windows and stack them top-to-bottom on the
screen
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3.2 Density Tools

The density tools on the View > Plot Density submenu and the Density Tools toolbar
are designed to provide a quick measure of the datain a gel image.

Density Tools E

Plat Drenzity Dengity at Cursosr —————— 17— & 2 L3 3

Flot Densi ol 2 O E o
Density in Box N

Show Lanes and Bands : ol i

Hide Dverl F4 Plat Cross-section Chrh+T

Il HEES Plot Dengity Distribution
Plot Wertical Trace

Fig. 3-3. Density tools on the menu and toolbar.
Note:  The density traces will be slightly different than the traces for functions such as
Plot Lane or Plot Band, because the sampling width is only one image pixel.
Density at Cursor
Select Density at Cursor and click on aband or spot to display the intensity of that
point on the image. It aso shows the average intensity for a3 x 3 pixel box centered
on that point.
Density in Box
Select Density in Box and drag a box on the image to display the average and total
intensity within the boxed region.
Plot Density Distribution

Select Plot Density Distribution to display a histogram of the signal intensity
distribution for the part of the image displayed in the image window. The average
intensity is marked in yellow on the histogram.

The histogram will appear along the right side of the image. Magnify the image to
display the datafor a smaller region.
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Plot Cross-section

Select Plot Cross-section and click or drag on the image to display an intensity trace
of across-section of the gel at that point. The horizontal trace is displayed along the
top of the image, and the vertical trace is displayed along the side of the image.

The intensity at the point you clicked on is displayed, asis the maximum intensity

along the lines of the cross-section.

Flot Cross-section|

Click on button, then
click or drag on the image.

Plot Vertical Trace

Select Plot Vertical Trace and click or drag on the image to plot an intensity trace of
avertical cross-section of the image centered on that point.

3.3 Showing and Hiding Overlays

To conceal al plots, traces, info boxes, and overlays on an image, select Hide

Position
33.34,13.37 mm

Cluantity
0.32 0D

hax. Quant.
045 oD

Fig. 3-4. Plot Cross-section tool.

Overlays from the main toolbar or View menu.
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Note:  Click once on Hide Overlays to conceal the overlays. Click twiceto deassign
any function that has been assigned to the mouse.

To redisplay the lane and band overlays, select Show L anes and Bands from the
View menu or main toolbar.

3.4 Multi-Channel Viewer

The Multi-Channel Viewer can display different types and levels of fluorescencein a
gel that has been imaged at different wavelengths. You can merge the data from up to
three different images of the same gel.

Note:  The gel images being compared must be exactly the same size. When changing
image filters, be careful not to move the gel. If the images are not exactly the

same size, you can use the Crop tool (see Section 3.9.a, Cropping Images) to
resize them.

With at least one image open, select Multi-Channel Viewer from the View menu.
The first open image will be displayed in the viewer window using the Red channel,
and the image name will be displayed in the field at the top of the viewer.
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Multi-Channel Yiewer

Channels Dizplay Tranzfarm

Fed |Image -4 (1D SZcan) ﬂ [¥]Red channel [¥] Auta-scale image when assigned
Green |Image .5 (1D Scan) ﬂ [#] Green channel

Blue | ﬂ {"1Blue channel

o Done |§ Frint EHportTIFF|@ Help |

Fig. 3-5. Multi-Channel Viewer.

Note:  The color channel used to display the image in the viewer has no relation to the
filter used to capture the image. The red, green, and blue channels are only used
to distinguish different images.

To add another image to the viewer, make sure the image is open and click on the
pulldown button next to the Green or Blue name field. Select the image name from
the pulldown list. Add athird image using the same procedure.
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versity Database

a Select image to digplay

%3 Multi-Channel Yiewer

Image.4 (1D Scan) [1148=x486]
Channel Image.5 (1D Scan) [1l4Ex488]
Fed |Image_4 {1D Scan) [~ “olears
Green |Image.5 (1D Scan) ﬂ Cancell

Blue | -|

Fig. 3-6. Selecting images to display in the viewer.

To reassign the different images to different channels, use the pulldown buttons to the
right of the name fields. Select <clear> from the pulldown list to remove an image
from that channel of the viewer.

Viewing Options

To remove a particular color channel from the display, click in the checkbox
associated with that channel to deselect it.

Select the Auto-Scale | mage When Assigned checkbox to automatically adjust the
brightness and contrast of each loaded image based on the data range in the image.
This invokes the Auto-scale command from the Transform dial og (see section 3.8,
Transform) when an image isfirst opened in the viewer. Note that this setting affects
only how the image is displayed in the viewer, not the actual data.

Note:  If you deselect this checkbox, any images currently displayed will remain auto-
scaled. Click on the Transfor m button in the viewer and click on the Reset
button in the Transform dial og to undo auto-scaling.

Buttons for various viewing tools are included in the Multi-Channel Viewer. Tools
such asZoom Box and Grab will changethe display of all theimagesinthe viewer at
once.

Click on the Transform button to open the Transform dialog. In the dialog, you can

adjust the display of each channel independently by selecting the appropriate channel
option button. Similarly, the Plot Cross-section command will report the intensity of
each channel separately.
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Exporting and Printing

Click on the Export button to export a 24-bit TIFF image of the merged view. This
will open aversion of the Export to TIFF dialog (see section 11.5, Export to TIFF
Image). Note that you cannot export data from the Multi-Channel Viewer—only the
current view of the image (designated as Publishing M odein the Export dialog). The
colorsin the viewer will be preserved in the exported TIFF image.

To print a copy of the merged view to a color or grayscale printer, click on the Print
button.

3.5 3D Viewer

The 3D Viewer allows you to see a three-dimensional rendering of a portion of your
image. Thisisimportant for such instances as determining whether a selected band is
actually two or more separate bands.

To see a 3D rendering of a portion of your image, select 3D Viewer from the View
menu. Your curser turnsinto a crosshair. Click and drag your curser over the image
areayou would like to view creating a box.

Note:  viewing alarge area of your image may reduce performance.

« Toreposition the box, position your cursor at the center of the box. The cursor
appearance will change to amultidirectional arrow symbol. You can then drag
the box to anew position.

« Toresizethe box, position your cursor on a box corner. The cursor appearance
will change to abi-directional arrow. You can then drag that corner in or out,
resizing the box.

«  Toredraw the box, position your cursor outside the box and click once. The box
disappears, and you can then draw a new box.

To view the selected area, position your cursor inside the box slightly off-center. The
cursor appearance will change to an arrow. Click once to open the 3D Viewer.
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(Ll 3D Yiewer

"Displa}l Optio:

Dizplay Mode: |Texture j Scale Factor: |GRE

4| 1]

Close | -$—F|eset\u"iew| @ Help |

Fig. 3-7. 3D Viewer
3.5.a Positioning the Image

Use your mouse or keyboard to reposition and rotate the image.

Windows
* Rotatetheimage - Left click and drag to rotate the image.
« Reposition theimage - Right click and drag to reposition the image.
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e Zoom in/out - Tozoomin or out, Click the center mouse button or roll the wheel.
If you do not have a three button mouse or a mouse with awheel, hold down the
shift key and left click and drag to zoom in or out.

Macintosh
* Rotatetheimage - Click and drag to rotate the image.
« Reposition theimage - Ctrl>click and drag to reposition the image.
e Zoom in/out - Shift>click and drag to zoom in or out.

3.5.b Display Mode

The 3D Viewer window allows you to view the image in three different modes; wire
frame, lighting, and textured.

«  Wire-frame shows the image in atransparent frame view.

» Lighting shows the image with different areas of light and shadow depending on
theangle of view. Use the dlider bar to adjust the intensity of the lighting.

*  Texture givesthe image texture.

Use the Scale function to scale theimage. Thisisuseful for viewing shallow spotsin
the 3D Viewer.

If you lose the image because you moved it too far past the window border, or rotated
it and disoriented the view, click Reset View to return the image to the original view.

Note:  Reset view does not change the scale factor. To reset the scale factor, close the
3D Viewer and click the box again to re-open the 3D Viewer with the original
scale factor.

3.6 Image Stack Tool

Use the Image Sack Tool to scroll through a series of related gel images. You can
easily compare bands that appear, disappear, or change sizein different gels run under
different conditions.
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Note:  The images should be close to the same size, with bandsin the same relative
positions. You can use the Crop tool to resize images.

With all the images open, select Image Stack Tool from the View menu. The Image
Sack Tool window will open.

£ Image Stack Tool A==

Select gels to display:

Image.l (Raw 1-TIr Tman
wp Inage. 2 (Raw 1-D Ima
Image.3 (Raw 1-TIr Tman

Image.4 (Raw 1-I' Ima

A < >
~Playback ———————

Step ﬂ ﬂ [JAuta
slow I—J— fast

~Image order

Move dizplayed image ﬂﬂ

o Done @ Help

Fig. 3-8. Image Stack Tool.

In the Image Sack Tool window, all open gels are listed in the field to the right of the
display window. To select an image to display, click on agel name. The name will
appear highlighted with an arrow and the image will appear in the window.

Click on another gel name to display that image.

Buttons for various viewing tools are aligned next to the Image Sack Tool window.
These commands will change the display of all the imagesin the stacker at once (e.g.,
magnifying one image will magnify the same relative areain all the images).
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Using the controls below the list of names, you can reorder the images and/or scroll
through them in the stacker.

Reordering Images

To reorder the images in the stacker, first select an image name in the list, and then
click on the M ove displayed image arrow buttons to move it up or downin thelist.

Image Playback
Using the controls under Playback, you can scroll through the images in the stacker.

First, highlight some or all of the gel names using Shift-click or Ctrl-click key
commands. With multiple images selected, the Step arrow buttons become active.
Click on the arrow buttons to scroll through the list of selected gels.

Alternatively, click on the Auto checkbox next to the arrow buttonsto begin
automatically scrolling through the list. You can adjust the auto-scroll speed using the
Slow/Fast slider.

3.7 Colors

Select Colorsfrom the Edit menu to open adialog in which you can adjust the colors
of the image, as well as windows, buttons, overlays, and other features of the display.
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= Color Palette

Colormap Mame | standard

Load | Delete
Colar Group | Light Owerlay Colors

Light Yellow |

White Overla;r|

Light Orange

Light Purple

0k | Fiezet | Cancel | Help

Fig. 3-9. Colors dialog.

Selecting a Color Group

In the Colors dialog, click on the Color Group button to select the colors of a
particular group of objects (e.g., pop-up boxes, image colors, €tc.).

= Quantity Dne

A Select Color Group

Light Owerlay Colors
Dark Owerlay Colors
Matte Colors
Popup Colors

Fixed Colors

Image Colors

Cancel

Fig. 3-10. List of Color Groups.

Click onacolor group in the list to select it.
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Changing a Color

After you have selected the color group to change, click on the specific color button.
In the Color Edit dialog, adjust the RGB values of the color you selected.

& Quantity One

Color Edit

=E O
e ————]
e

Ok | Cancel |

Fig. 3-11. Color Edit dialog.

Saving/Selecting a Defined Set of Colors

After you have changed the col ors within color groups, you can save these settings for
future use on other images. The Colormap Namefield displays the name of adefined
set of colors and color groups. There are several predefined colormaps, or you can
create your own.

To select a predefined colormap, click on the L oad button.
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& Color Palette £ Quantity One | x|
Colormap Marme |CDDHASS a Select Color Preferences
Load | Delete
EEICE
Calor Group | Light\ Overlay Colors
Coomass
EtBr
Falze
Gray
Standard:
Psuedo
Silver
Spectrun
Svbr Green
Sypro Puby
A user-defined set of colors —————p  User-defined:
Eanceq

Fig. 3-12. Selecting a Colormap.

From the list displayed, click on the set of colors you want to apply.

To create your own colormap, adjust the colors within the color groups as described
above and type in a new colormap name. Click on OK to apply the changes.

To remove a colormap, click on the Delete button. Select the colormap to be deleted
from the displayed list. A pop-up box will ask you to confirm the deletion.

To return to the Standard colormap, click on the Reset button. All colorswill reset
to their default values.

3.8 Transform

Usethe Transform dial og to adjust the image brightness and contrast and optimize the
image display. These controls affect the image display only, and will not change the
underlying data.

With an image open, select Transfor m from the Image menu or main toolbar.
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IINEEER Lane Band  Match  olu Ij: @ % | Elj &k Qﬁ? @l a T | EE] |
|

Tranzform... Etel+B

Crop

Fig. 3-13. Transform command.

The Transform dialog contains a Preview Window, a Frequency Distribution
histogram, a Transform Plot, and three main methods of optimizing the image: Auto-
scale, High and L ow dliders, and a Gamma slider. You can use these controls to
adjust the way the software transforms raw image data into the visual display.
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Transform Plot Preview Window
= Transform: Proteins3 (Raw 1-D Image. Modified]
Mote that transform opprations change only
the view of the data, not the data itself.
Tranzform Plot
v i
Frequency Distribution {* Full szale ¢ Low-High [JLog
1 1 y
S — 8
High r J' 200 Image Display
et ,_Jl ’23— Max (253 [ Inwvert display
[JLogHigh/Lpw Sliders  []Caltrated Quantity  |zaw Min |21 [JHighlight saturated pixels
[ &bwaps auto-scale
Gamma r J' 1.00
| 0K | b4 Eancell @ Help | Auto-scale | Reset | M image color... |

Frequency Distribution histogram Auto-scale

Fig. 3-14. Transform dialog.
3.8.a Transform Subwindows

Preview Window

The Preview Window shows asmaller view of the same image that isdisplayed in the
main image window. Changes in the controls are automatically reflected in the
Preview Window. They are only applied to the main image when you click on OK.
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You can use viewing tools such as Zoom Box, Grab and View Entire Image in the
Preview Window just as you can in the main image window, to focus on particular
regions of interest.

Frequency Distribution Histogram

The Frequency Distribution histogram showsthe total datarangein theimage and the
amount of data at each point in the range. In atypical scan, thereisasignal spike at
theleft (“gray”) end of the histogram due to background noise.

Transform Plot

The Transform Plot is alogarithmic representation of how the raw pixel data are
mapped to the pixels of the computer screen.

3.8.b Transform Controls

Auto-scale

Click on the Auto-scale button to optimize the image automatically. The lightest part
of the image will be set to the minimum intensity (e.g., white), and the darkest will be
set to the maximum intensity (e.g., black). This enhances minor variationsin the
image, making fine details easier to see. You can then “fine-tune” the display using
the High, Low, and Gamma sliders described below.

High/Low Sliders

If Auto-scale doesn’t give you the appearance you want, use the High and L ow
sliders to redraw the image manually. Drag the High dider handle to the | eft to make
weak signals appear darker. Drag the L ow slider handle to the right to reduce
background noise.

Asyou drag the dliders, the dider markers on the Frequency Distribution histogram
will move. Everything to the left of the L ow marker will be remapped to minimum
intensity, while everything to the right of the High marker will be remapped to
maximum intensity. Using the histogram, you can position the markers at either end
of the datarange in the image, and use the low slider to cut off the “spike” of
background noise.
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You can also type specific High and L ow values in the text boxes next to the sliders.
Click anywhere on the slider bars to move the diders incrementally.

Log High/L ow Slider s changes the feedback from the slider handles, so that when
you drag them, the slider markers move a shorter distance in the histogram. This
allows for finer adjustments when the dataisin a narrow range.

Frequency Distribution {+ Full scale ¢ Low-High []Log
In this example,
the range of
data in the image
is very limited

[

High '—Dv\ 1965
Loy ’D ]

Low slider remaps background noise to white  High slider remaps weaker signals to black

Low-High magnifies Log scaling enables you to
Can better distinguish background area between sliders better distinguish peaks
noise from real data ¢ ¢
Frequency Distribution { Full scale ¢+ Low-High [%]Log

log

B

High I‘D
Low D

Fig. 3-15. Two views of the Frequency Distribution histogram.
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Gamma Slider

Some images may be more effectively visualized if their data are mapped to the
computer screen in anonlinear fashion. Adjust the Gamma dider handle to expand or
compress the contrast range at the dark or light end of the range. Thisisreflected in
the Transform Plot and Preview Window.

3.8.c Other Features

Full Scale and Low-High

The Full Scale and L ow-High option buttons adjust how the range of datain the
image isdisplayed in the Frequency Distribution histogram and Transform Plot. They
do not change how the data is displayed in the image window.

Select Full Scaleto adjust the displays so that they show the full intensity range of the
image.

Select L ow-High to magnify the range between the L ow and High sliders. This
makes it easier to view the dataif it does not occupy the full intensity range of the
image.

Log
The L og checkbox changes the way the data is displayed in the histogram so you can
better discern subtle changesin signal intensity.

Image Max/Min and Units
Image Max and Min display the range of intensity in the gel image.

The image units are determined by the type of scanner used to create the image. For
images measured in O.D.s, you can display the maximum and minimum O.D values
in the image by selecting the Calibrated Quantity checkbox. If thisbox is
unsel ected, the maximum and minimum numeric pixel values are displayed.
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Image Color

Click on this button to open alist of colormaps, which you can define using the
Colors command on the Edit menu (see section 3.7, Colors). Select a colormap from
thelist to change the image in both the Transform window and the image window.

Invert Display

Select the Invert Display checkbox to change light bands on a dark background to
dark bands on alight background, and visa versa. The image data will not change—
only the display.

Highlight Saturated Pixels

Select the Highlight Satur ated Pixels checkbox to highlight areas of saturationin the
imagein red.

Always Auto-Scale

Select this checkbox to automatically Auto-Scale every new image that you open.
The software will examine the data range in every image and optimize it accordingly.
This setting disables the other image-optimization controlsin the Transform dialog.

Reset

To return to an unmodified view of the image, click on Reset.

3.9 Resizing and Reorienting Images

The Image menu and toolbar contain commands for changing the size and orientation
of images.
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Fig. 3-16. Resizing and reorienting tools.

Note:  Many of these commands will permanently change the image. You will be
prompted to confirm any permanent changes.

3.9.a Cropping Images

Use the Crop tool to eliminate unwanted parts of an image, such as border space
around the gel. You can also use this command to reduce the file size of animage.

Select Crop from the Image menu or toolbar. The cursor will change to a Crop
symbol.

Define the region to be cropped by dragging the cursor across the image, creating a
box. Everything outside the box will be deleted.

The dimensions of the crop area (in millimeters and number of pixels) and thefile
size of theimage inside the crop area are listed at the bottom of the crop box.

1. Toreposition the crop box, position the cursor at the center of the box. The cursor
will change to amultidirectional arrow. Then drag the box to a new position.
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2. Toresizethe box, position the cursor on abox border line or corner. The cursor
will change to abidirectional arrow. You can then drag the border or corner in or
out, resizing the box.

3. Toredraw the box, position the cursor outside the box. The cursor will change
back to the Crop tool, and you can redraw the box.

After you are satisfied with the size of crop box, position the cursor inside the box
slightly off-center. The cursor will change to a scissors symbol. Then click to perform
the crop.

A pop-up box will prompt you to: (1) crop the original image, (2) crop a copy of the
original image, or (3) cancel the operation.

-
95£Kh 475 i
- "

= Quantity One

Ready to crop

a Image. 3 (1D Scan]'

Crop current image, or crop copy of image?

IF you want to crop multiple pieces from the image,
or there is some analyziz you want to prezerve,
create a copy of the image, then crop.

Crop ‘ Copy and Ernpl Cancel

Fig. 3-17. Crop box and pop-up Crop dialog.

If you click on the Copy and Crop button, you will be prompted to enter the name
and version number of the image copy before cropping.
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Advanced Crop Commands

To ensure that your scans are exactly the same size and shape, you can use the tools
on the Image > Advanced Crop submenu to save the crop box from one scan and
apply it to others. These tools also allow you to crop agel of the same scan.

To define and save a crop box and apply it to another scan:

1. Select Define Crop Areafrom the submenu and drag a crop box on an image.
Position the box as described in Cropping Images.

2. Select Place Crosshair from the submenu and click alandmark inside the box that
ispresent in al the gels you want to crop. This could be a spot or some other
image detail. The crosshair will make it easier to position the box in the other
images so that it encloses the same area.

3. Select Save Crop Settings from the submenu, enter a name for the current crop
settings in the pop-up box, and click Apply.

4. Complete the crop action in the current image by positioning your cursor inside
the box dlightly off-center and clicking to perform the crop, as described in
Cropping Images.

5. Open or select the next image you want to crop, select Load Crop Settings from
the submenu, and select the name of the settings you saved. The crop box and
crosshair will appear on the image.

6. Reposition the crop box so that the crosshair is correctly aligned with the
appropriate image object, then complete the crop as described in step 4 above.

To delete any crop settings you have saved, select Delete Crop Settings from the
submenu and choose the settings to be deleted from the list.

3.9.b Flipping and Rotating Images

Use theimage flipping and rotating commands to reorient lanes and bands for proper
analysis.

Notee  These actionswill erase any analysis you have performed on theimage. You will
be prompted to confirm the changes.
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Flipping

To flip the image right-to-left, select Horizontal Flip from the Image menu or
toolbar. To flip the image top-to-bottom, select Vertical Flip.

90° Rotations

Select Rotate 90 L eft, Rotate 90 Right, or Rotate 180 from the Image > Rotate
menu or Image toolbar to perform the specified rotation.

Custom Rotation

Use the Custom Rotation command to rotate the image in increments other than 90°.
Select Custom Rotation from the Image > Rotate submenu or Image toolbar. A
green “plus’ sign will appear next to the cursor. Click on the image and a circular
overlay with an orange arrow will appear. A pop-up box will indicate the angle of
rotation in degrees and radians.
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Rotate Image.1 ¥3 [_E

Angle————————
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]
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Rotate | Cancel |

Fig. 3-18. Custom rotation; the arrow points in the direction of the new top of the image.

To perform the rotation, position the cursor on the arrowhead and drag. As you drag,
the arrow will rotate and the angle in the box will change. Position the arrow so that it
pointsin the direction of the new top of the image.

Note:  To center the arrow on a particular point on the image (e.g., to align along a
particular lane), position the cursor on the point and press the F3 key. The center
of the arrow will shift to the new position.

To complete the rotation, click on the Rotate button in the pop-up box. Another
window will open containing the rotated image, and you will be prompted to save this
image under a new name or version number.

If you are not satisfied with the rotated image, close the window without saving and
start over.
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Note:  Because animageiscomposed of square or rectangular pixels, Custom Rotation
performs some minor smoothing on the image for rotations other than 90°. Also,
any analysis performed on the image will be lost.

3.10 Whole-Image Background Subtraction

Image background due to gel opacity, random signal noise, or other factors can
interfere with quantitation and data analysis. Quantity One has severa tools for
subtracting background intensity from gel images. This section describes whole
image background subtraction. You can aso subtract background from individual
lanes (see section 4.2, Lane-Based Background Subtraction) and bands (see section
7.4, Volume Background Subtraction).

Whole-image background subtraction is useful for reducing background resulting
from the opacity of the carrier medium (film, gel matrix, or blot matrix) or film

fogging.

Note:  Whole-image background subtraction permanently changes the image. You will
be prompted to confirm the change.

Select Subtract Background from the Image menu.
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Fig. 3-19. Subtract Background dialog.

The Subtract Background dialog has a preview window, which contains a smaller
view of theimage. Changesin the subtract background controls are reflected in the
preview window and are only applied to the main image when you click on OK.
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Auto-scale

Click on the Auto-scale button to automatically adjust the Dark Contrast and
Background settings to optimal levels. You can then manually adjust these settings
using the other controls.

Dark Contrast Slider

Usethe Dark Contrast dider to reveal thelevel of background in the image before
subtraction. This slider is similar to the High slider in the Transform dialog. Drag the
slider handleto the left to make faint signals appear stronger. Click on the slider bar to
move the slider incrementally, or type avalue into the field next to the slider.

Note:  The Dark Contrast slider itself does not €iminate background intensity;
therefore, the OK button will not activate if you only adjust this slider. If you
want to adjust the display contrast without subtracting background, use the
Transform command (see section 3.8, Transform).

Before adjustment: the image After adjustment: background levels are
seems clear of background more apparent

& Backgiound for Proboim v2 [10 Sean] £ Backgenwnid Ios Protein v2 (10 Sean)

]

o q Tia Cortiit [i:: ——{}
Bockgeurd [0.00 [] Backgournd [0.00 [}
Bockgound B M Eackground Shpe \_] Bodgoradfior k| Sackgpord Sty K

¢ | e | Concel | ew | | Autarscodn| _Carcel | Hob|

Fig. 3-20. Dark Contrast adjustment reveals true levels of background in the image.

3-31



Quantity One User Guide

Background Slider

To manually adjust the background subtraction levels, drag the Background dlider to
theright. You can also move the slider incrementally by clicking on the slider bar, or
type a specific value into the field next to the bar.

Objects with signal intensities lower than the subtraction level will be eliminated
from the image when you click on OK.

Background Box

Use the Background Box function to define a background areain the gel that is
representative of the background in the entire image. This method of subtractionis
useful for images with uniform backgrounds.

Click on the Background Box button, then drag on a background area of the image.
The average intensity of the pixelsin the box will be used as the background level to
be subtracted from the entire image.

Background Stripe

The Background Sripe function is useful for gelsin which the background changes
from top to bottom (e.g., gradient gels).

Click on the Background Stripe button, then drag on a background region to create a
rectangular box down the length of the image. The average intensity of each
horizontal row of pixelsin the stripe will be subtracted from each pixel in that row
across the entire gel. Thisway, if the image has more background at the bottom than
at the top, more background will be removed from the lower regions of the image.

Notee  Make surethat the background stripe runs the entire length of the lanes down the
gel. The average of the topmost row in the stripe will be subtracted from all rows
above the stripe, and the average of the bottommost row will be subtracted from
all rows below.

The minimum and maximum intensities in the stripe are displayed next to the Min
and Max labelsin the box. Also, the average intensity value for the entire stripe is
displayed next to Avg.
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Completing the Subtraction

When you are satisfied with the background subtraction shown in the preview image,
click on OK. Because whole-image background subtraction isirreversible, you will
be prompted to subtract from the original image, subtract from a copy, or cancel the
operation.

If you choose Copy and Subtract, enter the name and/or version number for the new
copy in the pop-up box and click on OK to complete the command.

3.11 Filtering Images

Filtering is a process that removes small noise features on an image while leaving
larger features (e.g., bands) relatively unaffected. A wide range of filters are available
for removing different types of noise from images. Depending on the nature of your
data, you will probably need to use only one or two of the available filters. However,
you should experiment with severa different filters before selecting the ones that
work best for your images.

The filtering commands are located on the Image menu and toolbar.
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Fig. 3-21. Filtering commands.

Note:  Sincefiltering isan irreversible process, you will be asked if you want to create a
copy of the original image before you filter. If you are experimenting with
variousfilters, you should create copies of the image and compare them side-by-
side. If you filter the original image and save it, you cannot return to the original,
unfiltered state.

3.11.a Filter Wizard

The Filter Wizard is designed to guide you through the filter selection process. First,
you identify the type of noise in the image. Next, select the size of the filter to use on
that noise. Finally, filter the image.

Select Filter Wizard from the Image menu or toolbar to open the dialog.
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Fig. 3-22. Filter Wizard dialog.

The dialog contains settings for identifying the different types of noisein theimage. It

also includes adensity distribution histogram of the noise in theimageto aid in filter
selection.

Step I: Identify Noise Characteristics

Thefirst step istoidentify the type of noisein theimage. Examine both theimage and
the density distribution histogram, then select one, both, or neither of the following
checkboxes:

e Salt. Thistype of noise appears as specks that are lighter than the surrounding
background. The density distribution histogram of this type of noise displays
noise peaks at the high end of the range (right end of the plot). This type of noise
iscommon in electronic cameras with malfunctioning pixels. It can also be
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caused by dust or lint in the imaging optics or scratches on photographic film.
Salt isatype of outlier noise (see below).

Pepper. Thistype of noise appears as specks that are darker than the surrounding
background. The distribution histogram of this type of noise displays noise peaks
at the low end of the range (left end of the plot). Its causes are similar to those of
salt noise. Pepper is atype of outlier noise (see below).

Next, select one of the following option buttons to describe additional features of the
noise.

Gaussian. Thedistribution histogram of thistype of noise hasaGaussian profile,
usually at the bottom of the data range. Thistype of noiseis usually an electronic
artifact created by cameras and sensors, or by a combination of independent
unknown noise sources.

Uniform noise. Thistype of noise appearsin the histogram as auniform layer of
noise across the data range of the image.

Outlier noise. This category of noise includes salt and pepper noise (see above).
The distribution histogram of this type of noise displays noise peaks at the high
and low ends of the range.

After you have identified the type of noise, go to the next step.

Step 2: Select Filter Size

Image noise isfiltered by means of afiltering window (or kernel), which is measured
in pixels. Thisfiltering window slides across the image, processing the pixels within

it.

The available filter dimensions range from 3 x 3t0 9 x 9 pixels. To select an
appropriate size, magnify a background region of the image so that you can see the
individual pixels. Thefilter size you select should be larger than the average noise
feature but smaller than the data features.

Note:

A smaller filter will alter theimage lessthan alarger filter. Largefilters can result
in better suppression of noise, but can also blur desirable featuresin the image.

3-36



Chapter 3. Viewing and Editing Images

Step 3: Begin Filtering

After you have completed the selections, the filter name and size will be displayed at
the bottom of the Filter Wizard dialog.

To being filtering, click onthe OK button. Becausefiltering isan irreversible process,
you will be prompted to filter the original image, filter a copy of the image, or cancel
the operation.

If you choose Copy and Filter, enter aname and/or version number for the new copy
in the pop-up box and click on OK ..

3.11.b Selecting a Filter Directly

If you know the type and size of filter you want, you can select it directly from the
Image > Filter List submenu. The submenu includes al the avail able filters.

The types of filters are:

Weighted Mean. Thisfilter is useful for reducing Gaussian noise. It calculates
the weighted mean of the pixels within the filtering window and usesit to replace
the value of the pixel being processed.

Out of Range Pixel. Thisfilter is useful for suppressing salt-and-pepper noise;
its effect on Gaussian noise is minimal. Thisfilter cal culates the mean of the
pixel valuesin the filtering window, including the pixel being processed. If the
difference between the mean and the individual pixel value is above a certain
threshold, then the individual value is replaced by the mean.

Median. Also useful for suppressing salt-and-pepper noise, this filter calculates
the median value of the pixels within the filtering window and uses it to replace
the value of the pixel being processed. The median filter produces very little
blurring if asmall-sized window is selected.

Maximum. Thisfilter is useful for eliminating pepper noise in an image (it
worsens the effect of salt noise). It replacesthe value of the pixel being processed
with the maximum value of the pixels within the filtering window.

Minimum. This filter replaces the value of the pixel being processed with the
minimum pixel value within the filtering window. Thisfilter is useful for
eliminating salt noise in an image (it worsens the effect of pepper).

MidValue. Thisfilter is useful for suppressing uniform noise within an image;
however, it worsens the effect of pepper and salt. This filter replaces the value of
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the pixel being processed with the mean of the maximum and minimum pixel
values within the filtering window.

* PowerMean. Thisfilter is useful for suppressing salt and Gaussian noise within
animage (it worsens the effect of pepper noise). It replaces the value of the pixel
being processed with the power mean of the pixel values within thefiltering
window.

e ContraMean. Thisfilter is useful for suppressing pepper and Gaussian noise
within an image (it worsens the effect of salt). It replaces the value of the pixel
being processed with the contra-harmonic mean of the pixel values within the
filtering window.

e Adaptive. Thisfilter isuseful for suppressing Gaussian noise and salt and/or
pepper within an image. If theimage containsamix of salt and pepper, select this
filter.

To begin filtering, select afilter type from the pull-down list. A pop-up box will
prompt you to select afilter size.

= Quantity One

A Select filter size.

Select a zize that iz larger than the average noise feature,

%3 By | T | Y | Canc:e||

Fig. 3-23. Selecting a filter size.

Click on a button to select asize. (See, Step 2: Select Filter Sizefor guidance.)
Becausefiltering is an irreversible process, you will be prompted to filter the original
image, filter a copy of the image, or cancel the operation.

If you choose Copy and Filter, enter aname and/or version number for the new copy
in the pop-up box and click on OK.
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3.12 Invert Data

The Invert checkbox in the Transform dialog (see “ Invert Display” on page 23)
inverts the display of the image. However, in some cases you may need to invert the
actual image data.

If theimage haslight bands or spots on a dark background (i.e., the signal intensity of
the background is greater than the signal intensity of the sample), you need to invert
the data before analysis.

Select Invert Data from the Image menu or toolbar. This function isreversible. You
may need to use the Transform controls to adjust the appearance of the inverted
image.

3.13 Text Overlays

To create and display textual notes directly on the image, select Text Overlay Tools
from the Edit menu or main toolbar. This will open the Text Overlay Tools toolbar.

Text Dverlay Tools 3]
Select tool L3 aBc ™ | E = o T #e 5
/ |
Text tool |

Linetool Copy Paste Alignment tools

Fig. 3-24. Text Overlay Tools toolbar.

Creating a Text Overlay

To create atext overlay, click on the Text Tool, then click on the image at the spot
where you want the text to appear. This opens the Text Overlay Properties dialog.
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Fig. 3-25. Text Overlay Properties dialog.

To enter text, type in the main field. Use the buttons in the dialog to select the
properties of the text, including format, alignment, and justification.

Select the font style, font size, color of the text, and color of the background in the
text box using the pull-down lists.

After you have typed the text, click on OK. The text will appear on the image at the
spot where you originally clicked.

Editing a Text Overlay

To edit atext overlay, make sure the Text Tool or Select Tool is selected, and then

double-click on the overlay to open the Text Overlay Properties dialog. The existing
text will be displayed and can be edited.

Line Tool

You can use the Line Tool to draw aline between text and an image feature, or
between any two points of interest on the image.

Click on the Line Tool button, then drag on the image to create the line.

Toresize or adjust aline, make surethe Line Tool or Select Tool is selected, and then
position the cursor on one end of the line (marked by a circle) and drag.
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To add arrowheads to a line, make sure the Line Tool or Select Tool is selected, and
then double-click on the middle of theline. A dialog will pop up with options to add
arrowheads to one or both ends of the line.

Moving and Copying Text and Lines

You can move, copy, or delete a single text overlay or line or agroup of overlays and
lines within an image. You can also copy and paste between images.

First, you must select the object(s). Click on the Select Tool button. To select asingle
overlay or line, click on it. To select multiple objects, either drag a box around them
or hold down the Shift key and click on them individually. When dragging to select a
group of objects, make sure that you completely surround all the objectsto be
selected.

Each selected overlay/line will have a green border.

«  To move the selected object(s), position the cursor over the selection and drag.

*  To copy within an image, hold down the Ctrl key while dragging the selected
object(s). The copy will be created and dragged to the new position.

« To delete the selected object(s), press the Delete key.

«  To copy between images, click on the Copy to Clipboard button, then open or
select the image you want to copy to and click on the Paste from Clipboard
button. The copied object(s) will be pasted into the new image in the same
relative position they were copied from.

Note:  If you are pasting into an image with a different pixel size (i.e., resolution), you
will receive a message that the placement of the copy may not be exact. Click on
OK to complete the paste, then position the pasted objects manually.

Viewing Previously Created Text Overlays/Lines

Previoudly created text overlays and lines will appear on the image when you open
the Text Overlay Tools toolbar.

If you have concealed all overlays using the Hide Overlays command (section 3.3,
Showing and Hiding Overlays), click on any of the buttons on the Text Overlay Tools
toolbar to redisplay the text.
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3.14 Erasing All Analysis from an Image

To delete all analysis and overlays from an image (including any lanes, bands,
volumes, standards, text overlays, etc.), select Clear Analysis from the Edit menu.
Since this processisirreversible, you will be prompted to confirm the selection.

3.15 Sort and Recalculate

To update, renumber, and recal culate all lane and band information, select Sort and
Recalculate from the Edit menu.

3.16 Automation Manager

The Automation Manager allowsyou to save objects such as lanes, automated band
detection, standard bandsets, volume overlays, and text and line overlaysin a
template file. These files can then be automatically applied to images either
individually or in batches. To open the Automation Manager, select
Analysis>Automation Manager.
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Automation Manager #
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Fig. 3-26. Automation Manager dialog

3.16.a Step 1 - Select Template

The Select template field lists all the templates that are currently open. The
Automation Manager remembers the files that were open the last time the application
was open. To create a new template, click New. A new template appearsin the list.
See Section 3.16.b, Step 2 - Edit Selected Template for how to modify a new
template. To open an existing template not currently inthelist, click Open. This opens
the standard Open dialog. To remove atemplate from the list, click Close.

3.16.b Step 2 - Edit Selected Template

Step 2, Edit Selected Template, lists the name of the currently selected template and
thelist of options available to the template. To edit the template, check the option(s)
you would like to include and/or uncheck the option(s) you would like to remove
from the template.
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Use Single Image for Template

The Automation Manager allows you to specify a single image as the source for all
options you select. Checking the Use Single image for template box opens the Select
Source Image for this Script item dialog opens.

£ Quantity One x|

~Select Source Image For This Script [bem——

Proteins-test wz (Raw 1-D !

2 I3

o Done | }{Eance|| (7] Help |

Fig. 3-27. Select an image

Make sure the image you select contains the object(s) you wish to apply to the
destination images.

If you wish to use options from multiple images, then uncheck the box labeled, Use
singleimage for template. Asyou check each option in step two you will be
prompted to select a source image for that option.

Note:  The sourceimage must be open when the option check box is selected. Once you
have finished checking options from a source, the source image can be closed.

When you are satisfied with your changes, click Save, or Save Asto save it asanew
template. If thisisanew template, you must enter anew name for the template when
you click Save. To change the name of atemplate, click Save As and enter anew
name.
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Default Automation

The default automation template is applied to the currently active image when you
select Analysis>Apply Default Automation. To set a new default template, highlight
the desired template in the Automation Manager and click Set as Defaullt.

To run the default automation template on the currently active image, select Apply
Default Automation from the Analysis menu.

Once adefault templateis chosen, The Automation Manager does not need to be open
to be applied, nor do you need to select a default each time Quantity One opens as it
remembers the default from the last open session of the application.

3.16.c Step 3 - Select Images
This portion of the Automation Manager lists the currently open images. Select the
images to which you wish to apply the selected template. Use ctrl>click and

shft>click to select more than oneimage, or click Select All to select all theimagesin
thelist.

3.16.d Step 4 - Apply Selected Template

Click Apply to apply the selected template in step 1 to the selected imagesin step 3.
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4. Lanes

Before you can use many of the analysis functions, you must first define lanes and
bands on the gel image. This chapter describes the tools for defining lanes.

Note:  If youwant to compare bands across lanes (using standards or band matching),
the lane lines should be approximately the same length, with their starting points
aligned across the top of the image. Thisisimportant for calculating the relative
mobility of the bands. If gel wells are visible in the image, you should center the
start points of the lane lines on the wells and position the ends of the lanes
slightly below the last band for best resuilts.

4.1 Defining Lanes

You can define lanes individually or as part of aframe. The functions for doing this
are on the Lane menu and toolbar.

[N Eand  Match Yo

Lane Tools ]
Frame Lanes... e
futa Frame Lanes —— am [ mF <& 45 ‘ e ¢ e b | 2 [J] | M 4
Edit Frame 3
Single Lane k
Lare Width...

Lane Background...

Flot Lane
Compare Lanes...

Lane-bazed Amray  »

Fig. 4-1. Lane menu and toolbar.

In Quantity One, lanes are defined by red lane lines overlaid on agel. Thelanelines
can be created individually (see section 4.1.c, Single Lanes), or they can be created
as part of alaneframe.
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Fig. 4-2. Features of a lane frame.

4.1.a Lane Frames
The fastest way to define all the laneson agel isto create alane frame using the Auto
Frame L anes command. If this command doesn’t work well on your images, you can
create and place alane frame manually.

Auto Frame Lanes

Auto Frame L anes works best on gels with large numbers of clearly defined
lanes and bands. Also, the lanes should be reasonably vertical and contain

approximately the same amount of sample.

Note:

Select Auto Frame L anes from the Lane menu or toolbar. The program will
automatically detect the lanes and place a frame over them.
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The lane frame contains individual lane lines numbered sequentially from left to
right. The border and anchor lines of the frame are marked with dashed white lines,
the lanes are solid red lines, and each anchor point (interior and corner) is marked
with acircle.

The top and bottom of the frame are parallel with the top and bottom of the image.
However, the interior anchor points and lines will “bend” the frame to follow the
actual lanesin the gel, compensating for any curving or distortionin the gel.

If Auto Frame L anes detects too few or too many lanes, you can add or delete lanes
using the single lane commands (see section 4.1.c, Single Lanes).

If Auto Frame L anes does not work on the image, you will be prompted to create a
lane frame manually. To delete the lane frame, select Clear Analysisfrom the Edit
menu.

Manual Frame Lanes

If Auto Frame L anes does not work with your images, you can frame the lanes
manually.

Select Frame L anes from the Lane menu or toolbar. In the dialog, enter the number
of lanesin the gel and click on OK.

= Quantity Dne
A MNumber of lanes to create?
Cance

Fig. 4-3. Frame Lanes dialog.
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Corner
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Fig. 4-4. Lane frame created using the Frame Lanes command.

Thelane frame will be marked by corner anchor points, with no interior anchors. You
can edit the frame as described bel ow.

4.1.b Editing the Frame

If the frameistoo large or small, or does not follow the lanes on the image, you can
adjust it using the frame editing commands.

o I O €2 46 | Je %6 4 | > @ 3B o
Edit Frame 4 Add/Adjust Anchars I
Sindle L " Bemove Anchors
Mg el Move Frame
Lane Width... Ratate Frame
Lane Background... Resize Frame
- Stretch Frame

Fig. 4-5. Edit Frame tools.
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Adjusting the Entire Frame

The following commands are |ocated on the Lane > Edit Frame submenu:

e To stretch the frame in one direction (e.g., to encompass additional bands at the
top or bottom of the image), select Stretch Frame from the submenu or Lane
toolbar and drag an anchor point in or out. The opposite anchor point will remain
fixed while the frame expands or contracts.

« To move the entire frame to a new position, select M ove Frame from the
submenu and drag an anchor point. The entire frame will move.

e Torotate the frame, select Rotate Frame from the submenu and drag an anchor
point. The entire frame will rotate.

* Toresizethe entire frame, select Resize Frame from the submenu and drag an
anchor point in or out. The frame will expand or contract from the center.

Adding and Adjusting Frame Anchors

To adjust a corner anchor point, select Add/Adjust Anchors from the Edit Frame
submenu or toolbar and drag the anchor. Thiswill move the anchor point and attached
frame lines.

If the gel lanes are not straight, you can create additional anchor points along the
frame to change the shape of individual lines.

Still using Add/Adjust Anchors, click anywhere on the frame lines. This creates
interior anchor points both where you clicked and on the other side of the frame,
connected by aframe line. Then drag the anchor points to bend the frame.

Add and adjust as many anchor points as you need to bend the lane lines to follow the
lanesin the gel.
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Fig. 4-6. Adjusting the anchor points of the lane frame.

New anchor lines

\4

Removing/Unadjusting Anchors

To remove an anchor point, select Unadjust Anchor s from the Edit Frame submenu
or toolbar and click on the anchor. The anchor will disappear and the adjusted lanes
will straighten out.

4.1.c Single Lanes

You can define individual lanes using the single lane tools. These are located on the
Lane > Single Lane submenu or on the Lane toolbar.
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Lane Tools =]
o I 07 €3 4R | Je % d k| @ 3E o

Single Lane Lreate Lane
Adust Lane
Unadjust Lane
Bemove Lane

Lane WWidth...
Lane Backaground...

Fig. 4-7. Single Lane tools.

Note:  You can use the single lane commands on any lane within a frame; however, the
lane will be detached from the frame.

To mark an individual lane, select Create L ane and drag aline from the top to the
bottom of the gel lane. The lane line will be marked in red. Repeat this procedure to
manually mark all the lanes you want to analyze in the gel.

Note:  If thelane numbering gets out of sequence, select Sort and Recalculate from the
Edit menu to renumber the lanes.

Adjusting Single Lanes

You can adjust the position of any laneline. Select Adjust L ane from the

Lane > Single Lane submenu or the Lane toolbar and either drag one of the existing
anchor points or click anywhere on the lane to create a new anchor point and drag it
into position.

To undo any lane adjustments, select Unadjust L ane from the submenu or toolbar
and click on an anchor point to remove it. If you remove the anchor points at either
end of the lane ling, you will delete the entire line.

Deleting Lanes
You can delete both single lane lines and lines from a lane frame.

Select Remove L ane from the Single Lane submenu or toolbar and click on the lane.
You will be prompted to confirm the deletion.

Note:  If you delete alane from agroup of lanes or aframe, select Sort and Recalculate
from the Edit menu to renumber the remaining lanes.
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4.1.d Lane Width

Lane width isimportant for band quantition. Only the region of the band within the
lane sampling width is quantitated, so the defined lanes should be dlightly wider than
the actual lanesin the gel.

You can adjust the sampling width of all the lanes using the Detect Bands dialog (see
section 5.2.a, Detection Parameters). See section 5.1, How Bands Are I dentified and
Quantified, for afull discussion of the effect of sampling width on band quantitation.

To adjust the width of asingle lane, select L ane Width from the Lane menu or
toolbar and click on the lane line. The Sample Width dialog will display the current
width of the lane.

= Quantity One

A Erter sample width for lane #E.

Z.02 nmf

(] 8 | Cancel |

Fig. 4-8. Sample Width dialog.

Enter a new width in millimeters and click on the OK button.

4.1.e Lane Profile

After you have defined alane, you can review the intensity profile of the lane. A lane
profile provides a quick visualization of the intensity of your sample data, and is also
useful for determining the level of background in the gel.

Select Plot L ane from the Lane menu or toolbar, then click on alane. A lane profile
graph will be displayed.
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Fig. 4-9. Profile of a defined lane.

In the lane profile, bands are represented by peaks and background intensity is
represented by the baseline region below the peaks. The profile is generated by
calculating the average intensity of each horizontal row of pixels across the specified
width of the lane.

To close the lane profile, click on Hide Overlays on the main toolbar.

4.2 Lane-Based Background Subtraction

After defining lanes, we strongly recommend that you perform lane-based
background subtraction. Thisisthe best method for removing background intensity
from lanes, and is required for Gaussian modeling of bands.

Lane-based background subtraction uses a“rolling disk” method of subtraction,
named for a hypothetical disk that rolls along underneath the lane profile, removing
different intensity levels along the length of the lane.

The size of the disk determines how much background will be subtracted. A large
disk will follow the profile trace less closely, touching fewer points along the trace
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and removing less background. A smaller disk will more closely follow the profile
trace, removing more background.

A disk radiusthat istoo large will result in poor removal of background. A disk radius
that istoo small may subtract actual data.

0.o 1.0 20 0.0 1.0 20
PR T T N NN TN TR TN T NN N N I T T TR AN T TR N N NN SN N 1
0,200 0,200
0,400 0,400
i R -
Ry f
0,600 0,500
Small Radius Large Radius

Fig. 4-10. Examples of the background trace for small and large rolling disks. The small disk
follows the profile trace more closely, resulting in more background subtraction.

Select L ane Background from the Lane menu or toolbar and click on alane. The
lane will be highlighted, the lane profile will be displayed, and the Lane Background
Subtraction dialog will open.
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£ Lane Background Subtraction

File: Proteins_ 18C

r&l Lanes
™ All Lanes Off
& Subtraction Wariez By Lane
™ &ll Lanes On (Same Level)

Roling Disk Size: [50 @ ﬁ

~Selected Lane

Selected Lane: #4 (stem)

(™ Lane Off
(* Lane On
Rcliing Disk Size [s0 ﬂ ﬂ

[15haow lane trace with backaround subtracted

o Done | [ Help

Fig. 4-11. Lane Background Subtraction dialog.

In the dialog, you can set the same subtraction level for all lanes or specify an
individual subtraction level for the selected lane. Any changes you make will be
automatically applied to theimage. To close the dialog, click on Done.

4.2.a Profile Trace

When you make changes in the dialog, note that the profile trace of the lane also
changes. In the standard view, the original “raw” trace of the lineis shown in black,
and the orange line represents the background beneath the peaks of the trace as
defined by the rolling disk.

Asyou change the size of the rolling disk, the orange line changes, following the
contours of the profile more or less closely as shown in Fig. 4-10.

To display the trace with the background removed, select Show lane trace with
background subtracted. The orange line in the trace disappears a ong with the
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background, and you can visually compare the rel ative intensities of the bandsin the
lane.

4.2.b All Lanes Off

To turn off lane-based background subtraction for all the lanesin the image, select the
All Lanes Off button.

4.2.c All Lanes On (Same Level)

Select this option to set the same subtraction level for all lanes. The Rolling Disk Size
field in the All Lanes section of the dialog displays the rolling disk radius in number
of pixels. Enter anew valueinthefield, or use the arrows to change the valuein 10
percent increments.

Typical rolling disk sizes range from 50 to 150. Asyou change the size, study the
level of background subtraction in the lane trace.

4.2.d Subtraction Varies by Lane

You can set adifferent subtraction level for each lane in the gel using the controlsin
the Selected Lane area of the dialog. Any changes you make with these controls will
only be applied to the selected lane; to select adifferent lane, click on it with the Lane
Background command assigned.

Click on the L ane Off button to turn off subtraction for the selected lane. Select L ane
On to turn on subtraction for the lane.

To adjust the subtraction level for the lane, change the value in the Rolling Disk Size
field under Selected Lane. Thisfield displays the rolling disk radius in number of
pixels. Enter anew valuein thefield, or use the arrows to change the value in 10
percent increments.

Typical rolling disk sizes range from 50 to 150. Asyou change the size, study the
level of background subtraction in the lane trace.

When you make changes to the selected lane, the Subtraction Varies by L ane button
is selected. To turn off individual lane subtraction, choose either All L anes Off or All
LanesOn.
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4.3 Compare Lanes

The Compare Lanes graph alows you to superimpose the intensity profiles of any
number of lanes from any number of open images.

Select Compar e L anes from the Lane menu or toolbar, then click on the first lane
you want to display. The Compare Lanes window will open.

Note:  Theimage must have defined lanes for this command to work.

£ Compare Lanes

0.40

oD 1o 10 oD

0.40

Proteitis

@E ﬂ@@ ﬂﬂ j ] Show Gauss Model

Done | Help ||:|A|ign Band Types

Fig. 4-12. The Compare Lanes dialog.

The X axis of the graph isthe Rf value and the Y axisisthe pixel intensity value at
each point along the lane. Compare Lanes automatically “best fits’ lanes within the
display window to maximize the range of intensity valuesincluded in the graph. Rf
values are displayed from 0.0 to 1.0.
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Adding and Removing Lanes from the Graph

To add alane to the graph, click directly on the lane in the image. The plot of the lane
will appear in the graph.

Each lane you add will be displayed in one of eight colors, and will be identified by
color in alegend underneath the graph. If you add more than eight lanes, the colors
will repeat, but each lane will still be identified underneath the trace display. Thereis
no limit to the number of lanes that can be displayed simultaneoudly.

To remove alane profile, click on the Remove L ane button. A pop-up box will
prompt you to select the lane to remove. If you remove alane, the colors of the
remaining lanes will change. Check the lane legend for an updated color code.

Magnifying the Graph

Usethe Zoom In and Zoom Out buttons in the dialog to magnify regions of interest
inthe profiles. Alternatively, drag the cursor horizontally across the graph and release
the mouse button to magnify the defined range.

Note:  The magnifying functionsin Compare L anes only magnify the profilein the
direction of the X axis. Therefore, the profile will appear to “ stretch” without
increasing in height.

The Full View button returns the graph to its default display.
If you have magnified part of the graph, the L eft arrow and Right arrow scroll
buttons can be used to pan left or right along the graph.

Show Gaussian Modeling

The Show Gauss Model checkbox is active if any of the selected lanes includes
Gaussian modeling (see section 5.7, Gauss-Maodeling Bands). If you select this
checkbox, the Gaussian-fitted profiles will be superimposed on the regular lane
profiles. The Gaussian profiles are displayed in white.

Align Band Types

The Align Band Types checkbox is active if any of the selected lanes includes
defined band types (see section 6.2, Band Matching).
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If this checkbox is selected, the profiles of all bands that have been identified as the
same band type will be stretched and superimposed on one another, so their peaks
align. Thisisuseful if the same band appears as peaksin slightly different positionsin
different lanes, and you want to align the peaks to confirm that they are all the same

band type.

Note:  Thiscommand only changes the lane profiles as they are displayed in the
Compare Lanes dialog, and will not affect image datain any way.

£ Compann Lanus ME £ Compae Lanes [ [o[=]

Lane 8

&m gajal =+ ¥

Laned

&m gja) <= 5

o Help | Bl 8cn Band Types

Dione Help | (] Band Ty
Unaligned Aligned

Fig. 4-13. Two band types as they appear in two lanes, before alignment and after.

Note that this function will not align band types from different band sets (e.g., Band
Type 1in Band Set A and Band Type 1 in Band Set B will not be aligned). However,
the same band types from different images will be aligned.

Note:  The Rf valuesin the X axiswill no longer be accurate if Align Band Typesis
selected, since some band profileswill be stretched and their peaks shifted.

Printing and Exporting
Click on the Print button to print a copy of the Compare Lanes display.

Click on the Export button to export the data points in the graph to a spreadshest.
Thiswill open the Compare Lanes Export dial og.
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Compare Lanes Export

Number of data points —— | Fgints [s75

Field Separatars
(™ Commaz [1-2-3 format)
o Tabs [Excel format)

Export Diestination
{+* File
™ Clipboard

QK | Cancel | Help |

Fig. 4-14. Compare Lanes Export dialog.

This Export dialog includes afield for the number of data pointsto be taken along the
length of each lane. The default value in this field is the maximum number of data
points that are available for the lanes you are comparing.

Select the export format (tab or comma delimited) and destination (file or clipboard),
then click on OK.

Note:  The exported data will be different depending on whether you have checked
Align Band Types, Show Gauss Model, or neither. If the Show Gauss M odel
checkbox is selected, each lane that has been Gaussian fitted will have two
columns of data: one for the Gaussian-fitted profile and one for the regular
profile. If the Align Band Types checkbox is selected, the exported values will
reflect the stretched and shifted profiles of those lanes that have been aligned.

4.4 Lane-based Arrays

The lane-based array functions allow you to create a lane frame for the cellsin an
array. You can then specify the cell dimensions and quantitate them using the
Quantity Standar ds function (see section 6.3, Quantity Standards).
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Note:  You can quantitate arrays outside of lanes using volume arrays (see section 7.5,
Volume Arrays).

Thefirst step in defining an array is specifying the number of columns and rows and
creating an array frame.

Got to the Lane menu, open the Lane-based Array submenu, and select Frame
Array.

Lare-bas Frarne Array..
Array Cell Height
Array Cell '/idth

Fig. 4-15. Lane-based Array tools.

Enter the number of columnsin the array and click on OK.

= Quantity One
Haow marny columnz are in the array’?
Faor every colume there will be a lane.

5

kK | Cancel |

Fig. 4-16. Setting number of array columns.

In the next box, enter the number of rows and click on OK.

& Quantity One

How mary rowes are in the arrap?
For eveny rov there will be a cell in each column.

10

Ok | Cancel |

Fig. 4-17. Setting the number of array rows.
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The array matrix will appear on the image. Each column will be marked by ared line,
and each cell will be marked by top and bottom brackets.

Note:  If the cells appear marked by linesinstead of brackets, select Band Attributes
from the Band menu and select Bracketsin the dialog.

When you first create the array matrix, it will probably not be centered on the
columns and cellsin the actual image. In the next step, you will adjust the position of
the matrix.

Adjusting the Array Matrix

The Add/Adjust Anchorstool will be automatically assigned to the mouse after you
create the frame (otherwise, select it from the Lane > Edit Frame submenu). Position
the cursor on the corner points of the frame and drag them into position so that the red
lines run down the middle of the array columns and the top and bottom brackets are
centered on the array cells (see section 4.1.b, Editing the Frame for guidance on
adjusting frames).

If necessary, the Adjust L ane command (see “ Adjusting Single Lanes” on page 7)
and Adjust Band command (see section 5.3.b, Adjusting Bands) can be used to
adjust the placement of columns and cells within the frame.

Reducing Background in the Array

After you have positioned the array, you should reduce lane background using the
L ane Background command (see page 4.2, Lane-Based Background Subtraction).
Lane background will affect quantitation of the cells.

Setting Array Cell Height and Width

Now you should adjust the cell brackets so that they completely enclose the cellsin
the array.

Select Array Cell Height from the Lane > Lane-based Arrays submenu and enter the
height in millimeters of the array cells.
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= Quantity One
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Fig. 4-18. Setting the array cell height.

When you click on OK, the cell brackets will adjust to the specified height. If you
aren’t sure of the exact height, you can experiment with different values.

Select Array Cell Width and enter the width in millimeters of all the cellsin the
array.

= Quantity One

A Enter default sample width.

Z00.7% mmf
0k | Cancell

Fig. 4-19. Setting the array cell width.

When you click on OK, the cell brackets will adjust to the specified width. If you
aren't sure of the exact width, you can experiment with different values.

Analyzing Array Data

When the brackets fully enclose each cell in the array, you are ready to analyze the
data. You can display various measures of cell quantity on the image using the Band
Attributes command on the Band menu. With the Band Attributes dialog open, select
from Peak Density, Aver age Density, Trace Quantity, Relative Quantity, and other
measures. You can also report these values by selecting L ane Reports from the
Reports menu.
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To use known quantitiesto cal culate unknowns, you can use the Quantity Standards
function (see section 6.3, Quantity Standards).

4-20



5. Bands

After you have defined the lanes on the gel image, you can automatically identify and
guantitate bands using a set of adjustable parameters.

Note:  You can quantitate bands, arrays, or other objects outside of lanes using volumes.
See Chapter 7 for details.

The tools for band detection are located on the Band menu and on the Band Tools

toolbar.

|Banl:| Makch Molume  Anakysis  Report: Band Tools E
Detect Bands. .. Shift+F 4 8 m ot | B BE g
Band Attributes. .. Ft :
Create Band Fo
Remove Band i
Adjust Band SRS

Gauss-model Bands. ..
Remove One Gauss-model
Remove All Gauss-models, ..

Band Information. ..
Flot Band
Bands in Lane

Conktour 4

Draw Band 4

Fig. 5-1. Band menu and Band Tools toolbar.

Note:  Before detecting bands, you should subtract background from the lanes using the
L ane Background command (see section 4.2, Lane-Based Background
Subtraction).
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5.1 How Bands Are ldentified and Quantified

You can automatically identify all the bands in an image using the Detect Bands
command (see section 5.2, Band Detection), or you can mark them individually using
the Create Band command (see section 5.3, Identifying and Editing Individual
Bands).

Each identified band is defined by brackets above and below the band. The width of
each set of brackets is determined by the lane sampling width (see section 5.2.a,
Detection Parameters). The height of the brackets is determined automatically, using
a band-finding formula together with parameters that you select.

—LJ—L_]_LJ—L_]—LJ_ Lane Sampling Width

Band
Height

Lane Trace

Average pixel intensity
< across sample width

Average intensity
1

Band Profile

Integrate under curve to baseline

for band quantitation (intensity x mm). E

Fig. 5-2. lllustration of bracket quantitation.
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When aband is quantitated, the average intensity of each horizontal row of pixels
within the bracketsis calculated. Next, the number of pixel rows between the top and
bottom brackets is determined. Taken together, these result in an intensity profile for
the band.

Finally, the areaunder the profile curve to the baseline is integrated, resulting in units
of intensity x millimeters. This is the “trace quantity” of the band.

Note:  Because the profile of an ideal band conforms to the shape of a Gaussian curve,
band profiles can be “fitted” to a Gaussian model. The band quantity can then be
guantitated from the area under the Gaussian curve. Thisis the best to resolve
overlapping or closely spaced bands in images. See section 5.7, Gauss-Modeling
Bands, for details.

5.2 Band Detection

The Detect Bands command automatically detects the bandsin defined lanes, based
on parameters that you select.

Note:  Before detecting bands, you should subtract background from the lanes using the
L ane Background command (see section 4.2, Lane-Based Background
Subtraction).

Select Detect Bands from the Band menu or toolbar. The Detect Bands dialog will
open.
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Click here to toggle format
Fig. 5-3. Detect Bands dialog, short and expanded formats, with default values.

When you first open the Detect Bands dial og, all bandswill be automatically detected
based on the default parameters in the dialog, and the bands will appear marked on
the image. The bands can be marked by either lines or brackets, depending on the
settings in the Band Attributes dialog (see section 5.5, Band Attributes).

Note:  If you have already manually identified bands (using Create Band, Adjust
Band, etc.), the Detect Bands function will overwrite them. You should use

Detect Bandsfirst, and then manually add, adjust, or remove bands as needed.
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The Detect Bands dialog has a short format and an expanded format; toggle between
them by clicking the toggle box in the lower right corner.

To change a parameter in the dialog, you can either type in anew value or use the
arrows to increase or decrease the setting by 10 percent. Experiment with different
settings to find those best suited to your images.

5.2.a Detection Parameters

Lanes to Detect

If the intensities of the bands vary from lane to lane, you may need to use different

detection parameters on different lanes. Specify whether you want to use the detection
parametersfor all the lanes or asingle lane by selecting All or One next to the Lanes
prompt. If you choose One, type the lane number in the field next to the One button.

When to Detect

If you select Auto next to the Detect prompt, band detection will occur immediately
each time you change a detection parameter. You will not need to click on the Detect
button located at the bottom of the form.

To change more than one parameter before detecting, choose Manual. With the
Manual option, you can change parameter settings first, and then apply them by
clicking the Detect button.

Normalization

Normalization is away to compensate for differencesin intensity between lanes. It
does not normalize for band quantitation.

Theintensity of each laneis determined by the darkest band in that lane. For example,
suppose that in all but one of the lanes the darkest band has an intensity of 50,000
counts. In the one light lane, the darkest band is only 25,000 counts. With
normalization, band detection will be twice as sensitive when processing the light
lane, improving the detection of faint bands.
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Select No next to the Normalize prompt to apply the band detection parametersin the
same way to every lanein the gel image. Select Yesto normalize for the intensity of
the lane.

Shadow Rejection

“Shadow bands’ are common gel artifacts. Shadow bands are spaced at tandem repeat
intervals and decrease in intensity as they progress further from areal band. The
Shadows parameter is designed to limit the detection of shadow bands (see also Band
Limit).

Select Reject to turn on the shadows filter. A band will detected only if it is darker
than the one above it or spaced further than one tandem repesat unit from the previous
band. This greatly reduces the number of shadows identified as real bands.

Select Accept to turn off the shadowsfilter.

Band Limit

If you know that all the lanesin agel contain a specific number of bands, you can
click on the Limit button next to the Bands prompt and type in the number of bands
that you know are present. Only that number of bands will be detected in each lane,
reducing the need for later editing.

Sensitivity

The Sensitivity setting determines the minimum signal intensity in the image that will
be defined as a band. The higher the sensitivity value, the more bands will be
detected.

If the sensitivity is set too high, background noise may be detected as bands. If the
setting istoo low, real bands may be missed.

The default sensitivity setting is 10.00. If the gel has faint bands (e.g., O.D. < 0.05,
counts < 2,000), you may want to increase this value to 20.00.
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Lane Width

The Lane Width setting determines the width along the lane lines that are sampled
for band detection and quantitation.

When aband is detected, an average intensity for each horizontal row of pixelswithin
the band bracketsis calculated. The lane width determines the number of pixelsin
each row. Study the band linesin the image while you adjust the width. Select awidth
that is dightly wider than the bandsin the gel.

Lane Width [4_ 57 lum jl:\% ﬂ
|

Adjust the lane

width until the band
lines are slightly
wider than the bands
in the image. id

Fig. 5-4. Adjusting the lane width.
You can also change the widths of individual lanes using the L ane Width command
(see section 4.1.d, Lane Width).
Minimum Density

When Normalizeisturned off, the Min. Density defines the lowest signal intensity
that will be counted as a band.

Before selecting aMin. Density value, use the Plot L ane command on the Lane
menu to plot atrace of alane that includes some faint bands. Then enter avaluethat is
lower than the intensity of the peak of afaint band but is still above the background.

If faint bands are still undetected after adjusting this parameter, you may want to
increase the Sensitivity setting.
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If Normalizeisturned on, Min. Density changes from an absolute value to a
percentage. This percentage is the fraction of the signal intensity of the darkest band
inthe lane that will be detected as a band. For example, if the darkest bandin alaneis
50,000 counts and the Min. Density is set to 25,000 counts, when you turn on
Normalize, the Min. Density will switch to 50% (i.e., aband must be at least half as
dark as the darkest band in the lane).

Noise Filter

The Noise Filter isused to minimize the number of small fluctuationsin the image
(i.e., noise) that are called bands while still recognizing larger features (i.e., rea
bands). This filter becomes especially important at higher Sensitivity levels.

The Noise Filter value refersto the size of thefilter in pixels (e.g., avalue of 2.50
equals afilter size of 2.50 x 2.50 pixels). Features smaller than the filter size will not
be recognized as bands. Entering anoisefilter size of zero turnsit off completely. The
default value is 4.00.

If band detection detects doublets as single bands, decrease the Noise Filter setting
and/or increase the Sensitivity.

You can also try decreasing the Size Scale parameter instead of the Noise Filter to
improve the detection of closely-spaced bands. However, if you decrease both the
Noise Filter and the Size Scale, the fuzziness around bands may be mistakenly
detected as separate bands.

Shoulder Sensitivity

Normally, band detection tries to distinguish shoulders as separate bands. When
looking at alane trace, these bands appear asflat or gently sloping abutments to
darker, better-defined bands (i.e., thereis no dip on the trace between the two bands).

Increasing the Shoulder Sensitivity will result in more shoulders being detected as
bands. Changing this setting to zero will result in no shoulders being recognized as
separate bands.

If band detection calls adoublet asingle band, check the lane trace to seeif thereisa
dip between the peaks of the two bands. If thereis no dip, increasing the Shoulder
Sensitivity value will help resolve the two bands.
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Size Scale

The Size Scale field helps distinguish between trends in signal intensity and random
intensity fluctuations. It is the number of pixelsin avertical column that are taken
together to determine whether a band is present.

The Size Scale parameter is similar to the Noise Filter in that it uses the size of
objects in the image to determine the nature of those objects. The default Size Scale
setting of 5 pixelsis optimal for most gel images. It can be set to any whole number
greater than or equal to 3.

If agel image has high levels of background noise, alarger Size Scale is appropriate.
Atlow noiselevels, asmaller valueis preferable. You can also increase the Size Scale
if the gel only has a small number of thick bands scanned at high resol ution.

5.2.b Parameter Sets

You can save detection parameters for use on similar images. Enter aname for the set
in the Parameter Set Name field, and click on the Save button.

Parameter Set Mame | Gel 12-DF-3

Load | Save | Delete| Heset|

Fig. 5-5. Parameter set controls in the Detect Bands dialog.

To load asaved set of parameters, click on the L oad button and select the set from the
list. To remove a set of parameters, first load it, then click on Delete.

5.2.c Default Parameters

To return all detection parameters to their default values, click on the Reset button at
the top of the form.
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5.3 Identifying and Editing Individual Bands

To manually identify and edit individual bands in an image, use the Create Band,
Adjust Band, and Remove Band commands on the Band menu and toolbar. (These
are also included on the toolbar in the Detect Bands dialog.)

| |
= n.-+| i
Fig. 5-6. Create, Adjust, and Remove Bands buttons.

Note:  When editing individual bands, it is useful to display the band brackets. Select
these in the Band Attributes dialog (see section 5.5, Band Attributes). If your
bands are very closely spaced, defining them in brackets mode gives you greater
control for more precise band definition. It also allows you to define overlapping
bands.

5.3.a Identifying Individual Bands

With the bands displayed as brackets, select Create Band from the menu or toolbar,
then click on either the top or bottom boundary of the band in the gel. An intensity
trace of the lane will pop up next to the band.

Drag the cursor until the area of the band that you want to define—represented by the
peak on the intensity trace—has been completely enclosed. The area of defined band
will be highlighted on the trace.
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Fig. 5-7. Creating a band with brackets displayed.

When you release the mouse button, brackets will enclose the band on the image.

With the bands displayed as lines, select Create Band from the menu or toolbar, then
click on the center of the band of interest. A line will appear in the center of the band.

A%

Fig. 5-8. Creating a band with lines displayed.

Note:  After you haveidentified several bands, renumber the bands by selecting Sort
and Recalculate from the Edit menu.
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5.3.b Adjusting Bands

To reposition a band’s boundaries, select Adjust Band from the menu or toolbar. If
the bands are displayed as brackets, drag the upper or lower bracket of the band. If the
bands are displayed as lines, drag near the upper or lower boundary of the band that
you want to adjust.

When you drag the band boundary, a pop-up lane trace will appear, and the area of
defined band will be highlighted on the trace. Drag the band boundary to the correct
position.

5.3.c Deleting Bands

To undetect a band, select Remove Band from the menu or toolbar and click on the
band. If the bands are displayed as brackets, a trace of the band will be displayed and
a pop-up box will ask you to confirm the action. If the bands are displayed as lines,
the band line will simply be deleted.

If the bands are displayed aslines, you can del ete more than one band at atime. Select
Remove Band, and drag a box around the bands to be removed.

If you undetect aband, it will no longer be counted as aband, but itsintensity will still
contribute to the total lane intensity.

Note:  After you undetect bands, renumber the bandsin the image by selecting Sort and
Recalculate from the Edit menu.

5.4 Plotting Traces of Bands

| =

Fig. 5-9. Plot Band and Bands in Lane buttons.

Plot Band displays an intensity profile of aband. Select the command from the menu
or toolbar and click on the band of interest.
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Bandsin Lane displays an intensity trace of alane with the defined bands
highlighted. Select the command from the menu or toolar and click on the lane of
interest.

Fig. 5-10. Bands in Lane command.

5.5 Band Attributes

You can display different types of information about defined bands. Select Band
Attributes from the Band menu or toolbar to open the dialog.
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Band Attr. for Image.1 [1D Scan) %]
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Fig. 5-11. Band Attributes dialog.

At the bottom of the dialog, select how you want to mark defined bands on the
image—as Brackets or Lines. Lines are usually easier to read than bracketsin gels
with closely packed bands, while brackets are better for displaying and editing the
boundaries of bands.

You can also select the band data to display on the image next to each band:

Note:

None.

Band number—The sequential number of aband in lane, as counted from the
top of the lane.

Relative front—The distance of aband from the top of itslane, divided by the
total length of the lane. The lane length can be determined either by measuring a
vertical line from the top of the lane to bottom or (if the laneis curved) by
measuring along the length of the lane. Set the preferred measuring method in the
Preferences dialog (see section 2.5.e, Application).

Note that normalized Rf isderived from relative front; however, normalized Rf is
calculated only for bands that have been modeled using standards or band sets,
and can change based on the modeling.

Molecular Weight/I soelectric Point/Base Pairs/other units—Thisvalueis
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determined by the type of standards defined for the gel, the band’s position in the
lane, and any modeling performed on the gel (using band matching or multiple
lanes of standards) to compensate for gel distortion or smiling.

Peak density—The intensity value of aband peak.

Aver age density—The total intensity of the rows of pixels used to generate the
profile of aband, divided by the number of rows.

Trace qgty—The quantity of a band as measured by the area under its intensity
profile curve. Units are intensity x mm.

Relative qty—The quantity of a particular band as measured by its intensity,
expressed as a percentage of either the total intensity of all the bandsin the lane
or thetota intensity of the lane (including the areas between bands). The
calculation method (% of Laneor % of Bandsin Lane) isset in the Preferences
dialog (see section 2.5.e, Application).

Gauss Peak Density—The intensity value of a band’s Gaussian peak (after
Gaussian modeling).

Gaussian Trace Quantity—The quantity of a band as measured by the area
under its Gaussian-fitted profile.

Contour gty—The quantity of aband that has been identified using the Contour

or Draw Band tools. It is the sum of the intensities of all the pixels within the

band boundary multiplied by the area of each pixel. Units are intensity x mm?.

Contour area—The area(in mmz) inside the boundary of a band that has been
identified using the Contour or Draw Band tools.

Calibrated gty—The quantity of aband as calculated from the trace quantity
and quantity standards. (Note that thisis different than quantity determined using
volumes.) Units are user-defined.

Normalized qty—The trace quantity of a particular band expressed as a
percentage of the quantity of a selected band type that is present in the same lane.

Band type—The band type number of a band that has been matched and placed
in aband set.

Band model—Displays the modeling lines across the gel that are generated by
band matching, standards, or both. These lines are used to compensate for gel
distortion or smiling.

Tandem repeats—The number of repeated base-pair units in a band that has
been analyzed using the VNTR Calculations function (see section 9.2, Variable
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Number Tandem Repeats).

trendsin increasing or decreasing
its normalized quantity.

Differential Display—If the band types have been normalized, this displays

expression of aband type acrossagel based on

5.6 Band Information

The Band Information dialog displays information about each defined band. Select
Band I nformation from the Band menu and click on a band.

Anintensity profile of the band’s lane will be displayed with the the selected band

highlighted, and the dialog will open.

= Band Information for MADD396 [1D Scan).

Lane (= Band Set

Band |17 Band Type

Rel. Frant 0.808

Mol. Wt. EDa
Peak 45.& CNT

Trace 152 CNT = mm

Gauss Model Peak  40.6 CHT
Gauszs Model Trace 179 CHT = mm

Mame #5

Statuz  Unknowm

Average 31.6 CNT

Contour M. &.
Relative Oty 3_51% Morm. Gty W&
Quantity/Units | ! | Statuz | Unknotm
Calibration Hot Calibrated
QK Help

Fig. 5-12. Band Information dialog.

The lane and band number of the band you clicked on are listed at the top of the
dialog. Enter new numbersin these fields to display information for a different band.

The band set and band type will belisted, if known. Other information includes:
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Note:

Relative front—The distance of the band from the top of its defined lane,
divided by the total length of the lane. The lane length can be determined either
by measuring a vertical line from the top of the lane to bottom or (if the laneis
curved) by measuring along the length of the lane. Set the preferred measuring
method in the Preferences dialog (see section 2.5.e, Application).

Note that normalized Rf isderived from relative front; however, normalized Rf is
calculated only for bands that have been modeled using standards or band sets,
and can change based on the modeling.

Molecular Weight/I soelectric Point/Base Pairs/other units—Thisvalueis
determined by the type of standards defined for the gel, the band’s position in the
lane, and any modeling performed on the gel (using band matching or multiple
lanes of standards) to compensate for gel distortion.

Peak density—The intensity value of the band’s peak.

Aver age density—The total intensity of the rows of pixels used to generate the
profile of the band, divided by the number of rows.

Trace qty—The band quantity as measured by the area under itsintensity profile
curve. Units are intensity x mm.

Gauss Peak Density—The intensity value of the band’s Gaussian peak (after
Gaussian modeling).

Gaussian Trace Quantity—The band quantity as measured by the areaunder its
Gaussian-fitted profile.

Contour gty—The quantity of a band that has been defined using the Contour

or Draw Band tools. It isthe sum of the intensities of all the pixelsinside the

band boundary multiplied by the area of each pixel. Units are intensity x mm?.

Relative gty—The quantity of aband as measured by itsintensity, expressed asa
percentage of either the total intensity of all the bandsin the lane or the total
intensity of the lane (including the areas between bands). The cal culation method
(% of Lane or % of Bandsin Lane) is set in the Preferences dialog (see
section 2.5.e, Application).

Normalized qty—The trace quantity of the band expressed as a percentage of
the quantity of a selected band type that is present in the same lane.

If the quantity of the band is known, you can enter the quantity and units next to the
Quantity/Units prompt.
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To calibrate the band against known quantities, click on the Calibration button and
select the calibration curve. (See section 6.3.a, Creating and Applying a Set of
Quantity Standards, for information on calibration curves.)

5.7 Gauss-Modeling Bands

If the bands are closely spaced or overlapping, Gaussian modeling can provide more
accurate quantitation than regular band detection.

Gaussian modeling “fits” a Gaussian curve to each band profile and calcul ates band
guantity from the area under the curve. Since the profile of awell-resolved, distinct
band conforms to the shape of a Gaussian curve, this creates aband profile that is as
closetoideal as possible.

Before:

After:

Fig. 5-13. Profiles of two overlapping bands, before (top) and after (bottom) Gaussian mod-
eling. Modeling better resolves the band quantities.
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For aband that overlaps with an adjacent band, Gaussian fitting provides the best way
to resolve the area that overlaps. (This quantity would be lost with conventional band
detection.)

Note:  Gaussian modeling requires little or no background in lanes. Subtract lane
background using the L ane Background command (see section 4.2, Lane-Based
Background Subtraction) prior to modeling. Also, high-resolution images require
significantly more time to model. To reduce image resolution, use the Reduce
File Size command (see section 2.2.f, Reduce File Size).

To model bands using Gaussian fitting, first detect the bands, then select Gauss-
model Bands from the Band menu.

Note:  Gaussian modeling will not create bands or eliminate detected bands. It will
simply apply a Gaussian curve to the profiles of detected bands.

In the pop-up box, select All to model al lanes, or One to model asingle lane. If you
select One, type the number of the lanein the field.

£ Gausz-model: ma00196 [1...

Lanes (&l (" One
QK | I:ancell Help |

Fig. 5-14. Gauss-model Bands dialog.

Click on OK. A status box will display the progress of the modeling.

Reviewing the Results

Bands that have been Gauss-modeled will appear as normal bands in the image. To
view the results of Gaussian fitting, magnify afew bands in amodeled lane using the
Zoom Box tool, then select Bandsin Lane or Plot Band from the Band menu and
click on the lane.

Plot Band displays the Gaussian curve superimposed on the profile of the selected
band. Bandsin Lane displays the Gaussian profiles of al the bandsin the lane, as
shownin Fig. 5-13.
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The Band Information dialog displays information about the Gaussian peak and trace
quantity for modeled bands that you click on. In the dialog, you can compare the
Gaussian values to the regular band detection values.

These quantities can also be displayed in the Lane Report and All Lanes Report.

Note:  The quantities determined by Gaussian fitting cannot be used to in conjunction
with Quantity Sandar ds (see section 6.3, Quantity Standards). However, you
can use the original trace quantitiesin calculating Quantity Standar ds after you
have Gauss-modeled the bands.

Adjusting Bands in a Gauss-modeled Lane

If you use any of the individual band commands—Create Band, Delete Band,
Adjust Band—in alane that has been Gauss-model ed, the modeling will be
automatically removed from that lane. The Gaussian modelsin alane are
interdependent, so changing a single band invalidates the modeling. After you have
adjusted the bands, you can remodel the lane.

Incorrect Modeling

The Gauss-model Bands command will try to model all the bands in the selected
lanes. Carefully review the results of modeling using the Plot Band, Bandsin L ane,
and Band | nfor mation commands as described above.

If the Gaussian curve does not adequately conform to the profile of aband, or if the
Gaussian peak and trace quantities differ greatly from the normal peak and trace
quantities in the Band Information dialog, it may be because there is too much lane
background. Use the L ane Background command with asmaller rolling disk sizeto
remove more background, then remodel the lane.

If Gaussian modeling does not work well with the bandsin theimage, smply remove
the modeling. To remove the modeling from a particular lane, select Remove One
Gauss-model from the Band menu and click on the lane. To remove the modeling
from all lanes, select Remove All Gauss-models.

Removing Gaussian modeling will not affect band detection.
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5.8 Irregularly Shaped Bands in Lanes

If some bandsin lanes are irregularly shaped, you can use the contour or drawing
features to define them. These functions give you more control over defining bands
than either Detect Bands or Create Bands.

Note:  Thesetoolsare similar to the Volume Contour Tool and the Volume Freehand
Tool, except that they are lane-dependent. To quantify objects without defining
lanes, see Chapter 7.

Contoured or hand-drawn bands are quantitated based on the signal intensity of al the
pixels within the band boundary, using the following formula:

Quantity = Sum of theintensity of apixel x pixel sizefor all the pixelsin
the boundary.

Theintensity of apixel is multiplied by the area of the pixel. Thisis done for al the
pixels within the contour or drawn boundary. The area of the pixel is determined by

the resolution of the image.

The resulting values have units of intensity x mm2.

Contoured/drawn band showing individual
pixels with different intensities.

0.1 mm

One pixel enlarged to
show dimensions.

0.1 mm

Fig. 5-15. A contoured band scanned at 100 x 100 micrometers.
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The commands for contouring and drawing bands are located on the Contour
submenu and Draw Band submenu of the Band menu, and on the Contour Tools
toolbar.

Before using these commands, magnify the image so that the individual pixelsin the
band are clearly visible. This allows you to position the cursor more accurately.

5.8.a Contouring Bands

Contour Tools

® 2| el g

—

IR - oo

Contaur |nfarmation
Contour to Band

Draw Band

Fig. 5-16. Contour tools.

Creating Contours

Select Create Contour from the Band > Contour submenu or toolbar and click on a
pixel at the edge of the band. This displays a contour that encloses pixels whose
intensity is equal to or greater than that of the pixel at the cursor.

Contour encloses pixels

with intensities greater
than or equal to intensity\>
of pixel at cursor

Fig. 5-17. Creating a Contour

If the contour does not encircle the band, reposition the cursor and click again. A new
contour will be drawn in place of the old.
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Contour Information
To display information for the selected contour, select Contour Information. A pop-
up box will show the area, total intensity, and average intensity.

Converting a Contour into a Band

When you are satisfied with the contour, select Contour to Band from the menu or
toolbar to redefine the contour as a band and assign it to the nearest lane.

Note:  Before you can convert a contour into a band, you must define the lane
containing the band.

The contour boundary will change color from yellow to red, and a band line will
appear on the nearest lane.

Note:  Gaussian modeling and the Plot Band command do not work on contoured
bands.

To list areas and quantities of contoured bandsin reports, select the Contour Area
and Contour Qty report formatting options. Display this information on the image
using the Band Attributes dialog.

5.8.b Drawing Tools

Contour Tools

LContaur k | w7 =

& &t 5

Diraw Band Denszity in Begioh
Dirawe Band Boundary
Edit Band Boundany

Fig. 5-18. Drawing tools.

Density in Region

Density in Region displaysintensity information for any area on an image.
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Select Density in Region from the Band > Draw Band submenu or Contour Tools
toolbar, and use the cursor to draw aline around aregion of interest.

. ®%

Area; 47027 .090 mm” 2
“Yolume: 1585500015, 503 CMNT % mm™2
Ayverage: 23714610 CHT

Fig. 5-19. Density in Region tool.

When you close the border, a pop-up box will display information about the enclosed
area. For very small regions, magnify the region before using this command.

Drawing Band Boundaries

Note:  To usethe drawing tools, at least one lane must be defined on the image. Also,
magnify the region you want to draw in using Zoom Box.

Use Draw Band Boundary to draw the boundary of a band manually. Select the
command from the Band > Draw Band submenu or Contour toolbar, and drag the
cursor around the region that you want to define as aband. A boundary line will

appear.

/

s

Fig. 5-20. Draw Band Boundary tool.

If you make a mistake and need to retrace part of the band boundary, backtrack with
the cursor; the path will be erased and you can redraw it.
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Note:  Be sure to magnify the image before drawing a boundary. If you try to draw a
very small boundary, the software will think that you are backtracking and erase
the boundary.

When the cursor crosses the line, the color of the linewill changeto indicate that itis
a band boundary, and a band line will appear on the nearest lane.

If you keep drawing, each time the line crosses itself a new band will be created,
replacing the old band.

Note:  Gaussian modeling and the Plot Band command do not work on drawn bands.

To list areas and quantities of drawn bands in reports, select the Contour Areaand
Contour Qty report formatting options. Display this information on the image using
the Band Attributes dialog.

Editing Band Boundaries

To change a drawn band boundary, select Edit Band Boundary from the Band >
Draw Band submenu or Contour toolbar and drag the cursor across the previously
defined boundary. A line will appear. When you recross the old boundary, the line will
change colors and the new boundary will be created.
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6. Standards and Band
Matching

After you have defined the lanes and bands in a gel, you can identify the standard
lanes, enter the values of the standards, and determine the val ues of the experimental
bands using those standards. You can also compare sample similarity by matching
bands across lanes.

Finally, you can identify bands of known quantity and use these to generate a
calibration curve for quantitating unknown bands.

These tools are found on the Match menu and Match Tools tool bar.

| batch  Wolume Analpziz  Repoarts Match Tools %]
Standards. . e mmm mme [ (28 51 8
o E N NER i g

Standard Curve

k atch
IInmatzh
Outlier
Mormalize

tatched Band Set...
Show Band Types  Shift+F5
Show Band Modelz  Cil+F&

tdatch Graphs r

Fig. 6-1. Standards and matching tools.

6.1 Standards

If your gel includes lanes of standards, you can enter the values of the standards and
automatically calculate the values of the unknown bands in the gel.
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Note:  Ingeneral, the more standard lanesin a gel, the greater the accuracy of the
calculated band values. We recommend aminimum of two standard lanes per gel.
Also, the modeling algorithm works best with standard lanes spaced evenly
across the gel, as shown in the following figure. Multiple standard lanes also
facilitate comparisons of sample similarity.

Standard Lane Standard Lane Standard Lane

ge.2 (1D Scan)

Unelassitied

Fig. 6-2. Standard lanes as defined on a gel image.

With the image open and lanes and bands defined, select Sandar ds from the Match
menu or toolbar. A dialog will open, listing any saved standards as well as predefined
Bio-Rad standards.
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= Quantity One

a Select Standards

Hew Standard

S Protein

S ~Eio-Pad (DNA) 1 kb Molecular Duler

S ~Eio-Pad (DNA) l00Obp Molecular Puler

S ~Eio-Pad (DNA) l00bp PCR MolecularPuler
S ~Eio-Pad (DNA) Z.5 kb Molecular Duler
S ~Eio-Pad (DNA) Z0bp Molecular Duler

S ~Eio-Pad (DNA) E00bp Molecular Duler

S ~Eio-Pad (DNA) Awplifize Molecular Duler
& ~Bio-Rad (DNA) Lambda HindIII digest

S ~Bio-Bad (Protein) Eroad range

& ~Eio-Pad (Protein) High range

S ~Bio-Pad (Protein) Low range

S ~Bio-Bad (Protein) Polypeptide

Cancel

Fig. 6-3. Selecting a set of standards.

Sets of Bio-Rad molecular weight and base pair standards are installed with the
software.

6.1.a Selecting Predefined Standards
If you are using Bio-Rad or other predefined standards, select them from the pop-up

list. The Sandards dialog will open (see section 6.1.c, Standards Dialog), displaying
the values of the standards.

6.1.b Creating New Standards

To create anew set of standards, select New Standards. A dialog will pop up in
which you can specify the units.
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= Quantity One & Quantity One
Hew Standards A Select Urits
% Malecular Weight - Azcending
Basze Pairs - Ascending
\ ok | Cancel Isoelectric Point - Ascending

Isoelectric Point - Descending
Molecular Weight - Ascending
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E dit Mew
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Fig. 6-4. Specifying units.

Click on the Units button to specify the units. This opens adialog in which you can
select from alist that includes Base Pair s, | soelectric Point, M olecular Weight, and
Normalized Rf.

Note:  Rf (relative front) expresses the distance a band has traveled down alane asa
fraction of either the total length of the lane or the vertical distance from the top
of the lane to the bottom (the calculation method can be specified in the
Preferences dialog). This provides a generic measure of the positions of bandsin
lanes. Normalized Rf is derived from relative front, and includes the results of
modeling across the gel that comes when multiple lanes of standards are defined
on theimage. Such modeling is designed to take into account any distortion or
smiling across agel.

To specify aset of units not on the list, click on the New button and specify the unit’s
parameters in the dialog. To edit a set of units, select them and click on Edit.

6-4



Chapter 6. Standards and Band Matching

£ Quantity One
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ShotName [
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Delete | Dane

Fig. 6-5. Units dialog.

Note:  “Ascending” meansthat bands of higher molecular weight or isoelectric point are
at the top of the gel image, and bands of lower molecular weight or isoelectric
point are at the bottom of the gel image.

To select a set of units, select them from the list and click on Select, then click on
OK. The Sandards dialog will open. Here you can enter values for the standards,
apply them to the bands on the image, and save them as a set for future use.

6.1.c Standards Dialog

The Sandards dialog contains the values of the standards, and includes tools for
applying them to the standard lanes in the image and displaying and adjusting the
standards regression curve.

The dialog opens with a default name for the standards. For new standards, thisisa
generic name (e.g., Standards 1). You can enter anew name in the field.
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Fig. 6-6. Standards dialog.

You can enter additional information next to the Comment prompt. The <category>
buttons and fields can be used to further define the standards.

Entering Standard Values

If you are creating new standards, enter the values of the standard bandsin thetablein
the middle of the dialog. Predefined standards already have these values entered.
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Fig. 6-7. Entering the values of the standards.

The table has three columns, labeled Type, Name, and the units you previously
selected (e.g., KDa, pl, Rf). In the units column, type avalue for the first standard
band and press the Enter key. The cursor will skip to the field below, and you can
enter avalue for the second standard band. Repeat this process until al the standard
values have been entered.

Note:  The values do not need to be entered sequentially. They will automatically sort
themselves in ascending or descending order, depending on how you specified

the units.

You can enter aname for each standard band in the Name column. Thiswill appear in

subsequent reports and printouts.

To remove a standard value, click on the triangle button at the beginning of the row
and select Delete. The remaining standards will be renumbered.

Applying Standard Values to Lanes

To apply the values to the standard lanes on the image, click on the Apply to Lane

button and click on alane.
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Fig. 6-8. Click on the Apply to Lane button and click on the lanes containing standards.

The values will be applied to the bands in the lane you select. Click on any remaining
standard lanes to apply the same values to them.

Note:  Ingeneral, the more evenly spaced the standard lanes, the greater the accuracy of
the calculated band values. We recommend a minimum of two standard lanes per
gel. Modeling lines that connect the standard bands in different lanes are used to
compensate for any smiling or distortion across the gel.

You can also click on the Arrow button next to a standard value to apply that valueto
aparticular band in alane on the image. Click on the button, then click on the
standard band. The remaining bands in the lane will be numbered sequentially based
on theinitial assignment.
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Fig. 6-9. Applying a single standard value.

After you have applied the standard values to alane, the bandsin that lane will
change color to blue, indicating that they are now standards.

You are now ready to select the standards regression curve to use for calculating the
unknowns.
Removing Standard Values from Lanes

The Clear from L ane command removes all the standard values from the lane(s) you
select. Click on the button, then click on the lane or lanes from which you want to
delete the standard values.

Showing the Modeling Lines

Click on the Show M odeling L ines button in the Sandards dialog to display lines
across the gel connecting the same standard bands in different lanes. Unknown bands
that fall along these lines have the same values as the standards.

To redisplay only the band numbers with no modeling lines, click on the Show Band
Types button.

6.1.d Standards Regression Curve
After you have applied the standard values to the image, you are ready to select the

regression model to use to calculate the values of the unknown bands. (Note: You
must apply the values to alane before you can view and adjust the regression curve.)
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Click on the Sandard Curve button in the Sandards dialog, then click on alane. A
graph of the standards regression curveis displayed on the image, and the Sandard
Curve Optionsdialog is displayed as well.

Regression Method: Elder Scuthern Std. Curve Options for Image_1 =]
Cornrelation Coefficient = Hid
& User Sandard Regression Model - Display Options
) Interpolated Weight LOg Mol Wh. . . . .
340 360 80 ™ Point-ta-Point Semi-Log | | [%]Show Standard Paints
=Tk 0.000 . . . f+* Elder-Southern [%]Show Caleulated Poirts
-
¢ Logistic [¥]Perform Log Transform
t " " Linear [#] Show Numerical Data of Points
. ™ Quadratic [%] Dizplay Conelation Coefficient
™ Cubic
e
™ Cubic-5pline
e
I 0.500 Cloge Help
o
—
1

Fig. 6-10. Displaying the standard curve and options dialog.

Asyou click on different lanes, the curveis displayed for each lanein turn. The X
axisisthe standard value and the Y axisisthe Rf value.

Use the Sd Curve Options dialog to change the regression model for the curve, as
well as various display options.

Standards Regression Models

Select different regression modelsin the Sd Curve Options dialog while you study
the standard curve with the standard points displayed. Then choose a curve that best
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fits the data points. (The correlation coefficient provides another measure of curve
fit.)

Note:  Note that point-to-point semi-log is the only method available if you perform
band matching on theimage, because band matching adjusts the positional values
of bandsin localized areas based on your identification. Point-to-point semi-log
is appropriate for thiskind of localized variation, whereas the other methods are
not. Therefore, you should select point-to-point semi-log if you intend to perform
band matching (required for similarity analysis) on the gel.

Point-to-point semi-log. This and the Elder-Southern method are especially useful
for describing band migration in static-field electrophoresis gels. Thisisthe only
method available if you perform band matching on the image (see note above).

Elder-Southern. Thisand the point-to-point semi-log method are especially useful
for describing band migration in static-field electrophoresis gels. At least three
standard points are required to use this method.

Linear. This method of least-squares polynomial fitsis useful for modeling pulsed-
field electrophoresis gels.

Quadratic. At least three standard points are required to use this method of |east-
sguares polynomial fits.

Cubic. At least four standard points are required to use this method of least-squares
polynomial fits.

Logistic. At least five standard points are required to use this method of nonlinear
|east-squares curve fitting.

Cubic-Spline. At least five standard points are required to use this beta-cubic-spline
method.

Display Options
The following options will change how the curve graph is displayed:

Show Standard Points displays the standard data points on the graph. The standard
pointsin that lane will be marked on the graph as triangles. Note that known band
types will appear marked as standards.
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Show Calculated Points displays the calculated points on the graph. The calculated
pointsin the lane will be marked on the graph as circles.

Perform Log Transfor m changes the shape of the curve from linear to log. Thiswill
not change the calcul ated values.

Show Numerical Data of Points displays the value of each band on the graph next to
its corresponding point.

Display Correlation Coefficient displays the correlation coefficient for the linear,
quadratic, and cubic regression models.

Note:  The correlation coefficient is ameasure of how well the regression model fitsthe
data. It isthe square root of the proportion of total variation that can be explained
by the regression model. A correlation coefficient of 1.000 would indicate 100
percent certainty of fit.

6.1.e Displaying Calculated Values

To view the calculated values of al the bandsin the gel image, select Band
Attributes from the Band menu, then select the value to be displayed (molecular
weights, base pairs, etc.). Values can be displayed and printed in report format using
the lane and match reports on the Reports menu.

6.1.f Saving, Opening, and Deleting Standards

Standards are saved with the image; you can also save copies of them in a separate
archive that is available to all images.

To save the standard values with the image, click on the Close button to close the
Standards dial og, then save the image. When you open the image again, the standards
will be available when you select Sandards.

To save these standards for use on other images, click on the Archive button. The
standards will be saved in an archive file separately from the image.

To use a set of archived standards, open any image, then choose Sandar ds from the
menu or toolbar and select the archived standards. They will be imported into the
image.
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To delete a set of standards you have created, open them, then click on the Delete
button at the bottom of the dialog. A pop-up box will ask you to confirm that you
want to proceed with the deletion before completing the action. Thiswill delete the
standards from both the image and the archive.

To modify a set of standards you have created, open them, make your changes, then
save the image and (if desired) archive the new standards.

Read-Only Standards

You can make archived standards read-only. Read-only standards cannot be del eted
from or modified in the archive using the methods described above; they can still be
deleted from or modified in the image.

To make standards read-only, insert atilde character (~) in front of the name of the
standards, then click on the Ar chive button. These standards will always be available
under that namein the list of standards.

All Bio-Rad standards are read-only.

Disabling/Deleting the Archive

To delete the archived standards (including Bio-Rad standards), remove the

onepr efs.dbs database from the fixed.prm folder on your hard drive. Under
Windows, this folder islocated in the Bio-Rad/Program Files/The Discovery Series
directory. On the Macintosh, thisfileislocated in The Discovery Seriesfolder in the
Preferences folder in the System Folder.

After you remove thisfile, anew, empty oneprefs.dbs database will be automatically
created the next time you open an image. You can use thisto begin a new archive.

6.2 Band Matching

To compare the similarity of samplesin agel (using the phylogenetic tree, similarity
matrix, etc.), you must match bands across lanes using the commands on the Match
menu and toolbar.
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Note:  If you have run standards on the gel, you should define them before proceeding
asdescribed in the previous section. Multiple lanes of standards will facilitate the
band matching program; however, they are not required.

Match  “Wolume  Analpziz  Reports Match Tools n H
Standards... " Ny Lt’_'. %

-
Standard Curve

e

b atch
Unrmatch

Outler

Marmalize

Matched Band Set. -
Show Band Types  Shift+F5
Show Band Modelz  Chil+F5

Match Graphs k

Fig. 6-11. Matching tools.

Select Match from the menu or toolbar and click on a representative experimental
lane in the gel image. This may be alane that contains most or all of the bands that
you are interested in, and/or alane in which the bands are particularly well-resolved.
Each band in this lane will be designated as a different “band type.”

Note:  If you have defined standardsin the gel, a pop-up box will warn you that the
regression model for calculating band values will be restricted to point-to-point
semi-log. If you selected a different regression model when defining standards, it
will be changed.

Thefirst time you click on an experimental 1ane with the M atch command, a pop-up
box will prompt you to specify the matching tolerance.
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Fig. 6-12. Query box: Apply matching to the whole lane?

Tolerance is the minimum spacing that the matching model expects to find between
unique bands. It is expressed as a percent of lane height. You can enter avalue
between 0.2 and 10 percent. If the bands are very close together, enter a tolerance of
2.5 percent or less.

After you sdlect atolerance, click on Yes to automatically match all bands across the
lanes. (Click on No to match only the specific band you clicked on.)

When you click on Yes, the bandsin the lane you selected will change to green,
indicating that they are known band types that have been identified by you. A band
type number will appear next to each band.

The automatic matching mechanism will attempt to match the bandsin the other lanes
to the known band types. Matched bands are labeled in red, with the number of the
band type appearing next to each band. These matched bands are connected by
modeling lines.

Yellow bands are bands that the software cannot accurately match. The matching
algorithm is deliberately conservative to avoid incorrect labeling, so a number of
yellow bands may appear on the image.

Your next step will be to identify the yellow bands as either new band types, or
existing band types that could not be automatched.

To summarize:

*  Green bands are known band types.
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* Red bandsare bandsthat have been automatically matched with the known band
types.
* Yellow bands are bands that have not been matched and are unclassified.

Displaying Band Types and Modeling Lines

To display the band type numbers on the image, select Show Band Types from the
Match menu or toolbar.

Band type modeling lines reveal the path along the gel image that the software usesto
match bands of the sametypein different lanes. These lines are based on the positions
of the known (green) bands and any standards you may have defined.

To display the band type modeling lines, select Show Band M odels from the Match
menu or toolbar.

6.2.a Editing the Results of Band Matching

After you have matched bands automatically, you can manually indentify the
remaining unknown bands as new or existing band types. Use the tools on the Match
menu and toolbar to manually identify new bands, unmatch bands, or identify bands
asoutliers from the band set.

Note:  The modeling lines are designed to give you guidance on identifying new bands.

e Toidentify an unknown (yellow) band as a new band type, select Match and
click on the unknown band.

e Tomatch aband to a particular band type, select Match and first click on the
identified red or green band. Then click on the red or yellow band you want to
match. The band will appear green (known) and the modeling line will change to
reflect the match.

* If amatched (red) band in alaneisin fact a new band, select Match, hold down
the Shift key, and click on the red band.

e To change a matched band to unknown (yellow), select Unmatch and click on
that band.

« Toremove agreen band from the modeling, select Outlier and click on that
band. An X will appear through the band, indicating that the software isignoring
it when auto-matching bands across the gel image.
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Manually match bands until all the bands in the image are identified. The gel should
have no yellow (unknown) bands, and the modeling lines should intersect at or near
the middle of the bands across the gel. If the modeling lines are not parallel, the lanes
may be warped or distorted and thus difficult to compare using the automatic analysis
features.

6.2.b Band Set Dialog

The Band Set dialog contains the values of all the experimental bandsin a gel, atool
bar for band matching, and other information about the bands.

To open the dialog, select Matched Band Set from the Match menu or toolbar and
click anywhere on the image.

The dialog will open with a default name for the band set (e.g., Band Set 1). Enter a
new name at the top of the dialog, and add any comments or category/attribute
information you want to associate with the band set.
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Fig. 6-13. Band Set dialog.

List of Band Types

The values of theindividual bands are listed in the dialog. These values are based on
any standards you have defined and the band matching. If you have not defined
standards, normalized Rf units are used.
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If you change any of the valuesin thelist, that will be reflected in the matching on the
image.

Click on the numbered Arrow button next to aband value and click on aband in the
gel to identify that band.

You can enter names for the band types in the Name column. These will appear in
subsequent reports and print-outs.

To remove a band from the set, click on the triangle icon next to the band value.
Confirm the deletion, and the remaining band types will be renumbered.

Band Set Toolbar

The toolbar in the Band Set dialog contains all the commands needed for matching.
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Fig. 6-15. Band set toolbar.

Apply to Lane applies the values in the band set to any lane in the gel. Click on the
button, then click on the lane. The bands in that lane that can be matched will change
to red.

Clear from Laneremoves the identified values from any lanein the gel. Click on the
button, then click on the lane to be cleared. The bands in the lane will change to
yellow.

Create Band and Remove Band are standard band commands that have been
included in the toolbar for convenience (see section 5.3.a, Identifying Individual
Bands).

Match is used to identify anew band. Click on the button, then click on the unknown
(yellow) band to identify it and add it to the set.

Unmatch removes the identification of aband. Click on the button, then click on the
matched band to change it to unknown.

Propagate Band Set appliesall the valuesin the set to the bandsin alane, based on a
few identified bands in the lane. Click on this button, then click on the lane. The
bands in that lane that can be matched will change to green to indicate their known
status.

Outlier excludes a known (green) band from the band set model. However, the band
will still be marked as known.

Show Band Types displays all the red, green, and yellow bands on the image, with
the band type numbers next to the matched bands.

Show Band M odels displays the modeling lines across the gel image.
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Sandard Curve displays the Sandards Regression Curve (see section 6.1.d,
Standards Regression Curve). Click on the button, then click on any lanein theimage.

Other Band Set Functions

The units of the bands are displayed in the top half of the dialog, as is the matching
tolerance used. Tolerance is the minimum spacing between unique bands that you
specified when you created the band set.

The Normalization button allows you to pick a specific identified band that appears
in al the lanes to normalize the relative quantities of the other bands against (see
section 9.1, Differential Display for more information).

Click on the resize button in the lower right corner to reconfigure the dialog to its
smaller, palette version, which displays only the tool buttons and band type buttons.

To delete the band set, click on the Delete button.
To close the band set, click on OK.

Note that the band set is saved when you save the image.

6.2.c Tips for Gels Without Standards

If you are not using standards, we recommend that you load at |east two lanes per gel
with a reference sample containing many if not most of your experimental bands of
interest.

Select the Match command from the menu or toolbar, and click on this reference
sample laneto create a new band set. Then select Matched Band Set from the Match
menu to open the Band Set dialog, and apply that band set to other reference sample
lanes using the Propagate Band Set command.

Propagate Band Set is afeature that not only simplifiesidentifying bands, it allows
the software to do some optimizations that will significantly speed up modeling.
Choose another reference sample lane that you want to apply the band set to. Start by
using the Match command to identify one or two bands in the lane, then click on the
Propagate Band Set button and click on the lane to assign the remaining band types
to the lane.
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Once the reference sampl e lanes have been modeled, identify any unknown bands
using the methods outlined in the previous sections.

6.2.d Normalizing for Quantity

You can normalize the quantities of the bandsin a gel to the quantity of a particular
identified band that appearsin al lanes. Thisis useful if you have loaded different
amounts of sample in each lane.

Note:  Quantity normalization isrequired for calculating Differential Display.

Select Nor malize from the Match menu and click on amatched band that appearsin
every lane. (If the band is not present in alane, the normalized quantity for that lane
will be zero.) The quantity of that band will be set to 100 in each lane, and the
guantities of the other bands will normalized to that band.

You can view the normalized quantities using the Band Attributes dialog or in various
reports.

6.2.e Graphs of Match Data

You can display graphs of different kinds of data associated with the matched bands.
The commands for displaying these are located on the Match > Match Graphs
submenu.

b atch Graphs Average
- Calibrated Quantity
Contaur
Mormalized Quantity
Peak,
Relative Cluantiby
Trace

Fig. 6-16. Match Graphs submenu.

From the Match Graphs submenu, select atype of graph and click on amatched band.
The bands in the matched group will be displayed along with the selected graph.
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Fig. 6-17. Example of a match graph.

Aver age displays a histogram of the average densities of the bandsin aband
type.

Calibrated Quantity displays a histogram of the quantities of the bandsin a
band type as calculated from a calibration curve (see section 6.3, Quantity
Standards).

Contour displays a histogram of the intensity of each contoured band in a band
type. This function only works with contoured bands.
Normalized Quantity displays a histogram of the normalized quantities of the

bands in aband type. See section 6.2.d, Normalizing for Quantity, for
instructions on how to normalize for quantity.

Peak displays a histogram of the peak intensities of the bands in a band type.

Relative Quantity displays ahistogram in which each bar represents the quantity
of the band in alane as a percentage of either (1) the total intensity datain the
band’s lane, or (2) the total intensity of all the bandsin the band’s lane. The
calculation method (% of Laneor % of Bandsin Lane) is set in the Preferences
dialog.

Trace displays a histogram of the trace quantities of the bands in a band type
group.
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Each bar of the histogram is labeled on the X axis with the lane number, and (where
space permits) the band number. The Y axisislabeled with quantitative values. If the
bands in the match group span the entire image window, the histogram will not
include bars for the bands in the |eft-most 1anes because of the space required for
labeling the axis.

To avoid this problem, decrease the size of the image using Zoom Out until thereis
blank space between the | eft side of the window and the first band of the match group.
Redisplay the histogram. If one or more bars are still not included, continue
decreasing the magnification until you can see all the data.

6.3 Quantity Standards

From bands of known quantity, you can generate a calibration curve for determining
the quantities of all the bandsin lanes or cellsin lane-based arrays. (To quantitate
bands outside of lanes, see Chapter 7.)

Using the Quantity Sandards dialog, you plot the quantities of the known bands
against their intensities to generate a calibration curve. You then apply this curve to
unknown bandsin the current gel aswell as other gels.

To create a calibration curve, the quantities of at least two bands must be known. The
greater the number of known bands and the wider the range of their values, the more
accurate the calibration curve will be.

Note:  The band intensities cal culated by Gaussian fitting (see section 5.7, Gauss-
Modeling Bands) cannot be used in conjunction with Quantity Sandards.
However, you can continue to use the trace intensity (i.e., the areaunder aband’s
intensity profile) to calculate Quantity Sandar ds after you have Gauss-
modeled your bands.

6.3.a Creating and Applying a Set of Quantity Standards

Select Quantity Standar ds from the Analysis menu. A pop-up box will prompt you
to create a new curve or load a saved calibration curve.
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Fig. 6-18. Loading a quantity calibration curve.

Select Create New to open a blank Quantity Sandards dialog.
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Fig. 6-19. Quantity Standards dialog.

The dialog will open with a default name for the quantity standards (e.g., Cal 1).
Enter a new name, specify the quantity value units (e.g., 1g), and enter any
descriptive information in the appropriate fields at the top of the dialog.
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The calibration curve is generated by plotting the quantities versus the intensities of
the known bands. The intensities of the bands can be measured in several different
ways. Click on the M easure button to display alist.

£ Quantity One
a Measured Attributes
Trace Density - 0D x mm
Contour Density - 0D x mm™Z
Feak Density - oD
Average Density - 0D
Cancell

Fig. 6-20. Band attributes to measure for relative quantity.

The options in the Measure dialog are:

Trace density—The intensity of a band as measured by the area under its
intensity profile curve. Units are intensity x mm.

Contour density—Theintensity of a band that has been defined using the
Contour or Draw Band tools (see section 5.8, Irregularly Shaped Bandsin
Lanes). It isthe sum of the intensities of all the pixels inside the band boundary

multiplied by the area of each pixel. Units are intensity x mm?2.
Peak density—The intensity value of aband’s peak.

Aver age density—The total intensity of the rows of pixels used to generate the
profile of aband, divided by the number of rows.

Identifying the Known Bands in the Gel

The dialog includes three buttons that can be used to select the known bands in the

gel:

To select bands one at atime, click on the Band button, then click on each band
of known quantity. Each band will be highlighted.

If all of the known bands are the same band type, click onthe M atch button, then
click on one of the bands. The matched group of bands will be highlighted.
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« |f al of the known bands are in one lane, click on the L ane button, then click on
the lane with the known quantities. The entire lane will be highlighted.

Select Band M | Match ke | Lane M |

Fig. 6-21. Buttons for selecting bands of known quantity.

In the lower part of the Quantity Sandards dialog, the lane and band numbers of the
selected bands will appear in the Band column. The intensity of each band will also
be listed.

Entering the Quantities

Enter the quantity of each known band in the Quantity column. When you enter a
guantity, the value of the band in the Satus column will change from Unknown to
Known.
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Fig. 6-22. Entering the known quantities.

0.03

After you have entered a few quantities, the status of the remaining bandsin the list
may change to O.R., meaning that the remaining bands are out of the current range of
values (based on their intensities and what you have already entered).
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Alternatively, the software may automatically calculate an unknown quantity (if itis
between two known quantities) and enter avaluefor it; in this case the Status column
will indicate that the quantity has been calculated (Calc.)

In either case, you can type a quantity directly into the Quantity column and the
status will change to Known.

Relative Deviation of Known Quantities

After three values have been entered, the relative deviations of those bands are
automatically calculated and displayed in the Rel. Dev. column. Therelative
deviation is calculated from the known value that you entered and the back-cal cul ated
value from the calibration curve.

If the deviation value is too high, you can exclude a band from the calibration curve.
Click on the arrow button next to the problem band. In the pop-up box, select
Remove to remove the band from the Quantity Sandards dialog. All the information
about that band will be deleted.

Alternatively, select Outlier from the pop-up list to retain the information about the
band in the calibration file but exclude it from the calibration curve.

6.3.b Calibration Curve

Interpolation and Extrapolation

There are two methods for calculating the calibration curve:

» Point to Point generates a curvein which each data point is connected directly to
the next, regardless of the shape of the resulting curve.

e Linear Regression (using the method of Least Squares) generates a smooth
curve that isthe “best fit” of the values you provided.

Select the preferred option next to I nter polation in the dialog.

Next, indicate whether the curve should be extrapolated beyond the highest and
lowest known values by selecting Yes or No next to the Extrapolation prompt. Note
that values extrapolated from the Point to Point curve may be unreliable.
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Displaying the Calibration Curve

To display the calibration curve, click on the Show Curve button at the bottom of the
Quantity Sandards dialog. A graph of the known quantities versus measured
intensitieswill be displayed in a separate window.

£ Calibration Curve - Cal 1

0500 100 150 200 250 300 350 400 450

Titles | Fririt | Done |

Fig. 6-23. Calibration curve with linear regression and extrapolation.

Known values used to calculate the curve are marked by circles. Valuesidentified as
outliers are marked by squares.

«  To change the status of a point on the graph, click on it. The status will toggle
between Known and Outlier.

» Todisplay alegend at the bottom of the graph, click on Titles.
e To print the graph, click on Print.
e To closethe graph window, click on Done.
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6.3.c Applying the Calibration Curve
After you have generated a calibration curve, you are ready to calcul ate the quantities

of the unknown bands. Select a button next to Calibrate to cal culate the quantity of
an individual band, match, lane, or the entire gel.

Calibrate Band R | Match & | Lane R | Gel

Fig. 6-24. Buttons for calibrating bands of unknown quantity.

If you select Band, Match, or Lane, click on the button and then click on the object
in the gel. Click on Gel to calculate the entire gel. Bands of calculated quantity are
highlighted in the image.

Unapplying the Calibration Curve

To undo the quantity calculation for aband, match, lane, or gel, use the appropriate
button next to Un-Calibrate.

6.3.d Generating Standard Bands via a Dilution Series

One way to generate bands of known quantity is to start with a stock solution and
make several dilutions. Different dilutions can be loaded into different lanes, resulting
in adilution series.

Quantity One will calculate the valuesin adilution seriesif you enter the known
guantity and adilution factor (e.g., for asolution that has been diluted to 10 times the
volume, type /10 or 0.1).

In the Quantity Sandards dialog, next to the band from the undiluted stock solution,
enter the known quantity.

In the Dilution Factor column, type “stock.”

Next to the remaining bands in the series, enter the appropriate dilution factorsin the
Dilution Factor column.
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Trace Quantity Dilution Lel.
Band O ® mm Factor Status Dewr.
§-12  4.042 | 0.80 |Stnck e |Fnowm 3% ﬂ
10-13  3.705 | .48 |_a B [Enom 123
11-13  z.06L | 0.6 |.s [ |Eriomm 153
g- & 158l | 0.zd |_4I b [Emowm 25
lz- &  1.05% | 018 |_3 B |Enowm 1%
g- 7  0.zz04 | o.06 |_1 B [Enom 2

Fig. 6-25. Entering a dilution series.

The quantity of each band will be automatically cal cul ated.

6.3.e Importing a Calibration Curve

A calibration curve created for one gel can be applied to other gels.

Make sure that the new gel you want to quantitate and the gel with the existing
calibration curve are both open.

Click on the new gel to quantitate. Select Quantity Standar ds from the Analysis
menu and click on Create New, as previously described.

In the new Quantity Sandards dialog, click on the Import Curve button, and select
the existing calibration curve from the list. When you make the selection, the values
for the curve will be displayed in the new Quantity Sandards dialog. Each standard
value will be labeled Import in the Band column.

Checking the Imported Curve

If the quantity of one or more bands in the new image is known, you can verify the
accuracy of the imported calibration curve. Go to Select in the Quantity Sandards
dialog, click on Band, then click on aknown band. Itslane number, band number, and
intensity will be displayed in one of the standard values fields.
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Fig. 6-26. Checking an imported calibration curve.

When you enter the band's value, its status will change to Check, indicating that it is
used to verify the accuracy of the calibration curve and is not used in calculating the

curve itself.

Click on the Show Curve button to display the graph, and note that the Check bands
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calibration curve, we recommend that you do not use the imported standards for this

gel.
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7. Volume Tools

You can use the Volume tools to quantitate bands, spots, arrays, and other image data.

What is a Volume?

A volume isthetotal signal intensity inside a defined boundary drawn on an image.
To measure the amount of a particular object (e.g., aband or spot), you draw avolume
rectangle, contour, free hand, or circle around the object and compare the intensity
datainside the boundary with the data of other objects or a standard using the Volume
Analysis Report and Volume Regression Curve (see section 10.6, Volume Analysis
Report).

Volume=  Sum of the intensities of the pixels within the volume

boundary x pixel area
Volume units = intensity units x mm?

Volumes are similar to band contours (see section 5.8.a, Contouring Bands), except
that they are not dependent on lanes and bands.

7.1 Creating a Volume

To create avolume, select Volume Overlay Tools from the main toolbar or the Edit
menu. These commands are aso located on the Volume menu.
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Wolume [ENEIEERNEET (R A Y olume Tools x|
Select Tool [j% | %ﬁ_ G I%Iil o %g% L % % El E -
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Yalurme Contaur Toal ]
Yolume Free hand Toal
Yolume Bect Toal

Yolume Circle Tool

Wolume Array Tool

Array Ungroup Tool
Show/Hide Walume Labels
Copy To Clipboard

Pazte Fram Clipboard

Wolume Analysiz Beport. .

Fig. 7-1. Volume tools.

Note:  When using any of the following tools, be careful to completely surround the
data you want to quantitate. You should also adjust for background intensity (see
section 7.4, Volume Background Subtraction). You may want to experiment with
several different volumes drawn around the same object before selecting the one
that gives you the best quantitation data.

Volume Contour Tool

Use the Volume Contour tool to quickly create a volume boundary that follows the
outer edge of the object you want to quantify. To use thistool, first magnify the
object, then click on the Volume Contour button. Using the tool:

* Clickonapixel at the edge of aband or other object to create a contour that
encloses pixels of equal or greater intensity.

« Dragto create a contour that changes as you move over pixels of different
intensity. Drag from inside the object outward until the contour follows the outer
edge of the object. When you release the mouse button, the volume is created.
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=

Fig. 7-2. Volume contour.

The contour should completely surround the data you want to quantify.

To edit the contour, position the cursor on the border. The cursor will changeto a
pencil tool. Drag across the line; anew white line will appear. When you recross the
old line, anew contour will be created.

Volume Free Hand Tool

Use the Volume Free hand Tool to manually draw avolume boundary. First magnify
the band or other object (you must be able to see the individual pixels). Then click on
the Volume Free hand button and use the cursor to draw aline around the object.
When the line crosses itself, afree hand volume is created.

Fig. 7-3. Volume free hand.

If you make a mistake while drawing, backtrack with the mouse. The line you draw
should completely surround the data you want to quantify.

To edit the volume, position the cursor on the border and drag across the line; a new
white line will appear. When you recross the old line, anew free hand volume will be

created.
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Volume Rect Tool

Use the Volume Rectangle Tool to create a volume box around an object. Click on
the Volume Rect button, then drag a box around the object to be quantified. When
you release the mouse button, the volume is created.

-
g

Fig. 7-4. Volume rectangle.

To resize the box, click on it to select it, then position the cursor on one of the corner
anchor points and drag.

To rotate the box, click on it to select it, then hold down the Shift key while dragging
an anchor point. The volume will pivot around its center. Thisis useful if the object is
lying at an angle—for example, if the gel is smiling.

Volume Circle Tool

Usethe Volume Circle Tool to create acircular boundary around an object (such asa
spot). To use thistool, click on the Volume Circle button, then position the cursor at
the center of the object to be quantified and drag outward. Asyou drag, acircle will
appear. When you release the mouse button, the volume is created.

2r

Fig. 7-5. Volume circle.
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The volume circle should completely surround the data you want to quantify.

Toresizethecircle, click on it to select it, then position the cursor on the circle border
and drag.

Volume Labels

When you first create volumes, they will appear labeled. Click on Show/Hide
Volume L abels on the Volume menu or toolbar to hide the labels.

The volumes will have default labels: U1, U2, U3, etc. The “U” stands for unknown,
as distinguished from standard and background volumes. The number indicates the
sequence in which the volume was created.

Note:  If you change avolume's type (e.g., change an unknown to a standard), any
subsequent volumes of the original type will be renumbered. For example, if you
create volumes U1 and U2, and then designate U1 as a background volume, U2
will be renumbered U1.

Editing Volume Labels

The Edit Volume Labels tool allows you to change the text format of the label of the
currently selected volume. In the Volume Properties dialog, click Edit User Label to
open the Text Overlay Properties dialog. From this dialog you can change the size,
color, orientation, and background of the selected text. Select the font style, font size,
color of the text, and color of the background in the text box using the pull-down lists.

If you wish to change the text of the volume label, enter the new label inthetext field.
A changeto the text of the label will not cause a renumbering of unedited volume
labels. However, if you change the type for a particular volume, this will renumber
the subsequent volumes without changing the text of the edited volume label.

When you are satisfied with your edits, click OK. This returns you to the Volume
Properties dialog.

Note:  Changes made to avolume label will not change the default volume label
formatting.
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Volume Features

Each new volume you create initially has a green border, which indicates that the
volumeis selected. If you click elsewhere on the image, the border will change to
blue, indicating that the volume is desel ected.

To reselect the volume, click on it again. If you move the cursor over the volume—
selected or unselected—the border will change to gold.

After you create a volume, you can view the volume data (area, density, etc.) by
selecting the Volume Analysis Report from the Reports menu.
Tips

The volume you draw should completely surround the data you want to quantitate.
You should also adjust for background intensity

You may want to experiment with several different volumes drawn around the same
object before selecting the one that gives you the best quantitation data.

Displaying Volumes

To display previously created volumes after opening an image, select Volume
Overlay Tools from the Edit menu or main toolbar.

If you have concealed all overlays using Hide Overlays, click on any button in the
Volume toolbar to display the hidden volumes.

7.2 Moving, Copying, and Deleting Volumes

You can move, copy, or delete a single volume or group of volumes within an image.
You can also copy and paste volumes between images.

First, select the volume(s). Click on the Select Tool button on the Volume toolbar. To
select asingle volume, click oniit. To select multiple volumes, either drag a box
around them or hold down the Shift key while you click on them one at atime. When
you drag to select a group of volumes, make sure that you completely surround all the
volumes.
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Each selected volume will have a green border.

Note:

7.3

To move the selected volume or volumes, position the cursor over the selection
and drag.

To copy within an image, hold down the Ctrl key while dragging the selected
volume or volumes. The copy will be created and dragged to the new position.

To delete the selected volume or volumes, press the Delete key.

To copy between images, click on the Copy to Clipboard button on the Volume
toolbar, then open or select the image you want to copy to and click on the Paste
from Clipboard button. The copied volume(s) will be pasted into the new image
in the same relative position it was copied from.

If you are copying to an image with a different pixel size (i.e., resolution), you
will receive a message that the placement of the copy may not be exact. Click on
OK to complete the paste, then position the pasted objects manually.

Volume Standards

You can use volumes of known concentration to calcul ate the concentrations of
unknown volumes.

To classify aparticular volume as a standard, double-click on it. Thiswill open the
\olume Properties dialog.
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= ¥Yolume Properties |
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™ Unknown
{+' Standard
{ Background
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I

Edit Uzer Label...

QK | Cancel |

Fig. 7-6. Volume Properties dialog.

Select the Standar d option button, then enter the concentration in the Concentration
field. (Do not include units.) Click on OK to close the dialog.

Standard volumes have the default names S1, S2, S3, etc., based on their creation
sequence. Display or hide volume names using Show/Hide Volume L abels
command as previously described.

After you have identified two or more standards, you can use the Volume Regression
Curve (see section 10.7, Volume Regression Curve) under the Reports menu to
calculate the concentrations of the unknown volumes.

To change a standard back to an unknown, double-click on it, then select the
Unknown button.

7.4 Volume Background Subtraction

When you draw avolume, you will probably include some background pixelsinside
the volume. These background pixelswill usually have an intensity value that you do
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not want to include in the volume quantitation. There are two ways of calculating this
background intensity: local and global.

The background subtraction method is selected in the Volume Report Options dialog
(see section 10.6.a, Volume Report Options).

Local Background Subtraction

Local background subtraction calculates a separate background intensity for each
unknown and standard volume you create. For each volume, the intensities of the
pixelsin a1-pixel border around the volume are added together and divided by the
total number of border pixels. This gives an average intensity for the background
around each volume, which is then subtracted from the intensity of each pixel inside
the volume.

One-pixel border
around the volume

Fig. 7-7. Local background is calculated from a one-pixel border around the volume

Any pixelsinside the volume that have the same intensity as the background pixels
will be reduced to zero, thereby eliminating them from the quantitation.
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Global Background Subtraction

Note:  If you select Global Background Subtraction in the Volume Report Options
dialog, but do not define a background volume as outlined bel ow, you will
effectively select no background subtraction.

Global background subtraction calcul ates a single background intensity for the entire
gel. This average background intensity is then subtracted from all the volumesin the
gel. The steps for calculating global background subtraction are:

1. Create avolume using one of the volumetoolsin arepresentative background
region of the image (i.e., aregion where there is no data and where the average

pixel intensity appears to be the same as the background intensity surrounding
your data).

2. Double-click on the volume to open the Volume Properties dialog, and select the
Background option button.

- —

£ ¥Yolume Properties ’ x|

t P

e ~Wolume Tupe
l (™ Unknown
™ Standard
s Background

— rConcentration

fe——" Edit Uzer Label ..

ak | Cancel |

Fig. 7-8. Defining a background volume object.

The average intensity of the pixelsin the background volume will be calculated and
subtracted from each pixel in al standard and unknown volumes. Any pixelsinside
the volumes that have the same intensity as the average background will be reduced to
zero, thereby eliminating them from the quantitation.
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If you create more than one background volume, all the pixelsin those background
volumes will be used to calculate the average background.

Background volume(s) will have default names B1, B2, etc., based on their creation
sequence. You can display/hide volume names using the Show/Hide Volume L abels
command.

Note:  If the region you identified as background has a higher average intensity value
than a data object, that object will have anegative adjusted volume in the \olume
Analysis Report. If this happens, select a new background region that has less
intensity than the data object.

Displaying the Results of Background Subtraction

The Volume Analysis Report (see section 10.6, Volume Analysis Report) will display
both the unadjusted volume and the volume with background subtracted (adjusted
volume) of standards and unknowns, so you can see exactly how much intensity was
subtracted.

7.5 Volume Arrays

The Volume Array Tool on the Volume menu and toolbar can be used to quantitate
dot blots, dlot blots, and other arrays.

Note:  You cannot create a volume array in an image with asymmetric pixels (i.e.,
different dimensionsin x and y). If you want to create a volume array in such an
image, select Reduce File Size from the File menu to change the pixel
dimensions of the image (see section 2.2.f, Reduce File Size).

What Is a Volume Array?

A volume array isamatrix of volume circles or rectangles that can be
sized/positioned as a group and overlaid on images of blots, wells, or cells for easy
quantitation. Theindividual cellsin the array have the same functionality as standard
volumes. You can define cells as background volumes, standards, and/or unknowns,
as described in the sections above.
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You report the array data as you would standard volumes, using the Volume Analysis
Report.

Creating a Volume Array

On the Volume menu or toolbar, select the Volume Array Tool. Thiswill open the
Build Volume Array dialog.

Build Volume

FArray Tupe
(% 96 wells
(7 354 well:
(1536 wells

(™ rowes | cols

ToE:
cals:

~wiell Shape

(¥ circular

(™ rectangular

Cancel

Fig. 7-9. Build Volume Array dialog.

In the dialog, you can select a standard microtiter plate dimension (96 wells, 384
wells, or 1536 wells) or select Rows x Cols and enter the number of rows and
columnsin the array in the appropriate fields.

Select the shape of the wells/cells (Circular or Rectangular) and click on OK.

The array overlay will be created and displayed on the image.
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Like regular volumes, array volumes areinitially displayed without labels. To show
the labels of the individual wells/cells, click on the Show/Hide Volume L abels
button on the toolbar. Like regular volumes, array volumes are initialy labeled U1,
U2, U3, etc.

Note:  If large volume arrays are slow to display or edit on your computer and the
volume labels are showing, try hiding the volume labels using the Show/Hide
Volume L abels command. This will increase the processing speed considerably.

When you create an array overlay, it is automatically selected (the cells will be
displayed with green borders) and the Select tool is assigned to the mouse. You can
then move the array overlay so that it is properly centered on the image, resize the
cells so they fit the blots/wellsin the image, and resize the overlay so the four corners
fit over the four corners of the array on the image.

To delete the entire array overlay, select it and click on the Delete key.

Moving an Array

To reposition an array overlay, move the cursor over any individual cell until the
cursor changesto amultidirectional arrow and the cell border turns yellow. Then hold
down the cursor and drag the entire array to a new position.
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Fig. 7-11. Moving an array.

¢
-

Resizing an Array
To resize an array overlay, make sure it is sel ected, then position the cursor over the

dot at the center of one of the corner cells. Green lines will appear connecting the
array frame at the four corners.

LT
T

Fig. 7-12. Resizing an array.

Hold down the mouse button and drag the array frame in or out to compress/expand
the array.

7-14



Chapter 7. Volume Tools

Resizing the Array Cells

Toresizethe individua cellsin the array, magnify any individual cell and move the
cursor over the cell border (or corner anchor point, in the case of rectangles) until it
changes to a cursor with an adjustment symbol. Hold down the mouse button and
drag to move the border in or out. All the cellsin the array will be resized accordingly.

Fig. 7-13. Resizing an array cell.

Copying an Array

To copy an array within the same image, select it, then hold down the Ctrl key while
dragging it. The copy will be created and dragged to the new position.

To copy an array between images, select it, then click on the Copy to Clipboard
button on the Volume toolbar. Open or select the image you want to copy to and click
on the Paste from Clipboard button. The copied array will be pasted into the new
image in the same relative position it was copied from.

Note:  If you are pasting into an image with a different pixel size (i.e., resolution), you
will receive a message that the placement of the copy may not be exact. Click on
OK to complete the paste, then position the pasted array manually.
Ungrouping an Array

You can ungroup the individual cellsin an array, so they behave like normal, stand-
alone volumes.
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With the array selected, select the Array Ungroup command from the menu or
toolbar. This command cannot be undone, and you will be prompted to confirm the
action.

The ungrouped array will appear deselected (i.e., displayed in blue). You can then
move the cellsindividually, and perform all normal volume operations on the
individual cells.
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8. Colony Counting

You can use Quantity One to automatically count the number of white, blue, or plague
coloniesin a Petri dish.

Note:  For best results, when capturing the image of a Petri dish, the dish should fill the
imaging window. Also, images with colonies should not have asymmetric pixels.
(Asymmetric pixels can be generated by densitometers and the Reduce File Size
command.) The colony counting function will not work properly on images with
asymmetric pixels.

Select Colony Counting from the Analysis menu to open the Colony Counting
dialog.

£ Colony Counting: Colony Counting. 1sc

For best results, adiust the Gel Doc zoom lens so that
the image of the Petri dish fills the image windaw.

Step 1: Define Region and Counl

® Define Counting Region.
Drag the cursar fram center to edge of dish image.

m Sensitivity ’F ﬂﬂ

Averaging  (“1 (23 (5 (7 [JPlaque

~Step 2 Adjust Resul
‘white Eluge:

Colony count |0 a

o o

Adjusted count

Court vs.
Peak density
———————
Cutoff r il
White/Ble T {1
Step 3 Tools/option:
@ lgnore region []Show data area
@ [%] Mark white colonies
Make Calony
J [] Mark blue colonies
G| Erase Colony

rStep & Save ToBatchFil

[X]Batch mode...  Mew batch... | Open batch... Save Count | Load Mest... = —
Balch File [paccnoni.xis @ ﬂﬂ ﬂ gﬂ E
Count Nams ‘Cnlnny Counting.lsc / 1993-05-17 ldhr &

B o | Close | Feset || Heb

Fig. 8-1. Colony Counting dialog.
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The dialog has been arranged from top to bottom to guide you through the procedure.

8.1 Defining the Counting Region

First, you must define the region you want to count in the Petri dish image.

Click on the Define Counting Region button in the dialog and position the cursor at
the center of dish image. Drag the cursor outward. As you drag, ablue circle will
expand on the image—this defines the border of the counting region.

%
Drag cursor
/7 ‘out from °

“ center to

« define region )’

Fig. 8-2. Defining a counting region.

If you make amistake in defining the counting region, click on the Reset button at the
bottom of the dialog to start over.

Position the blue border until it isjust inside the interior edge of the Petri dish.
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Note:  If the border disappears when you rel ease the mouse button after dragging, check
to make sure that the Show Data Area checkbox is checked. This checkbox is
located at the bottom of the dialog.

If the circleisdlightly off-center, you can reposition it by positioning the cursor onthe
center “target” of the circle. The cursor will change to amultidirectional arrow, and
you can drag the entire circle.

To resize the counting region circle, position the cursor on the outer edge of the circle.
The cursor will change to a bidirectional arrow and you can drag the border in or out.

8.2 Counting the Colonies

After you have positioned the circle, you are ready to detect colonies.

If you are counting plaques, click on the Plaque checkbox. (Because plagues appear
as clear circles on adarker background, this checkbox must be selected for proper
detection.)

Before counting, you may want to adjust the Sensitivity and Aver aging parameters
described bel ow.

When you are ready to count, click on the Count button.

Sensitivity

The Sensitivity setting determines the minimum signal intensity in the image that will
be counted as a colony. (Thisis based on the slope of the signal’s peak.) The higher
the sensitivity, the more colonies will be detected.

If the sensitivity is set too high, background noise will be erroneously detected as
colonies. If the setting is too low, real colonies may be missed.

The default sensitivity setting is 10.00. If the image has faint colonies (e.g., O.D. <
0.05, counts < 2,000), you may want to increase this value to 20.00.
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Averaging

Averaging is designed to prevent random signal noise (such as salt or pepper) in the
image from being detected as colonies. If the image is noisy, you should select the
highest value that still results in good separation of colonies (default = 3).

A low averaging value may result in noise being detected as colonies. A high
averaging value may result in two closely spaced colonies being counted as one.

8.3 Displaying the Results

When you click on Count, the number of detected colonies will appear in the Results
section of the dialog in the White column.

~Step 20 Adjust Result

wikite Blue /»//”_'__““H\\
Colory count  |1128 1} 1
Adjusted count | 1186 [ / ;

Count ws. / ‘I’ K
Peak denzity i

i} I y \ /
Cuct (] : \\ 7

Whie/Blue T | Sy it i

Fig. 8-3. Example of a dish with white colonies.

The colonies will also appear marked as gold triangles on the image itself.

Note:  If the colonies are not marked on the image, make sure that the Mark White
Colonies checkbox at the bottom of the dialog is checked.

A text box on the image will indicate how many colonies were detected on the image.
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Doing a Recount

To recount using different parameters, change the Sensitivity and/or Averaging
settings. Thiswill erase the old count. Then click on Count again to recount.

Redrawing the counting region circle or clicking on the Reset button will aso erase
the count.

8.4 Making and Erasing Individual Colonies

If automatic colony detection has missed or erroneously detected some colonies, you
can manually mark or unmark them directly on the image using the buttons under
Tools/Options.

~Step 3 Toolz/options —

lgriare regian

@ Make Calany
@ Eraze Calany

Fig. 8-4. Colony counting tools.

To mark acolony, click on the Make Colony button, then click on the spot on the
image that you want to identify as a colony.

To unmark a colony, click on the Erase Colony button, then click on the colony on
the image that you want to unmark.

The colony count will change accordingly.
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8.5 Using the Histogram to Distinguish
Colonies

The histogram in the Colony Counting dialog is a graphical representation of the
signal datain theimage. You can use the histogram and associated diders to reduce
the number of incorrectly identified colonies and/or distinguish between white and
blue coloniesin the image.

Colonies Versus Background Noise

If thereisaclear peak on the left end of the colony counting histogram, it is probably
due to background intensity or noise in theimage. (For information on subtracting
background from entire images, see section 3.10, Whole-Image Background
Subtraction; for information on filtering noise from images, see section 3.11, Filtering
Images.)

If background is being detected as colonies, you can use the histogram and the Cutoff
dlider to correct this.

Drag the Cutoff dlider to the right until it is centered on the right edge of the
background peak.

| Background peak
Count v,
Peal denszity

— Cutoff mark
Cutaoff | D

Fig. 8-5. Using the Cutoff slider.

The yellow portion of the bar beneath the histogram marks the range of image data
has been designated as background noise, and is not being considered for colony
counting purposes. The gold portion of the bar marks white colony data range.
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The colony count displayed in the dialog and on the image should decrease. On the
image, you should also see the incorrectly identified colonies disappear as you drag
the slider.

White and Blue Colonies

If you know you have white and blue colonies in the image, and there are two clear
peaks on the histogram to the right of the background peak, you can use the histogram
to distinguish between these types of colonies.

~Results
White Blue
Colory count |93 |162
Adjusted count |93 |162
White peak\\ || Blue peak
k\k‘ /
FPeak denzity
r
A i
Cutoff . i — 1— White/blue
white/Blue D division mark

Fig. 8-6. Using the White/Blue slider.

Drag the White/Blue slider to the left until it is positioned between the two peaks.
The white colony data range isindicated by gold on the bar beneath the histogram,
and the blue colony data range is marked with blue.

Asyou drag the slider, the numbers of white and blue colonies will change in the
dialog and in the text box on theimage. Also on theimage, you should see the marked
white colonies (gold triangles) change to blue colonies (blue squares).

Note:  If the blue colonies are not marked on the image, check to make sure that the
Mark Blue Colonies checkbox at the bottom of the dialog is checked.
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8.6 Ignoring a Region of the Dish

If aparticular region of your Petri dish is damaged and you do not want to consider
the colonies (if any) that appear there in the final count, you can exclude that region
of the dish from the calculations.

Click on the Ignore Region button, then position the cursor on one edge of the region
you want to ignore. Drag the cursor on the image, defining the full region you want to
ignore.

Totals

wWhite (adj) 1072
Blue (adjy 0O -
Excluded 305%

Fig. 8-7. Marking a region to ignore.

Asyou drag, you will create a“pie slice” marked with red cross-hatching. Any
coloniesin thisregion will not be considered in the final count.

When you have defined the region, release the mouse button. If you want to change
the size of the ignored region, position the cursor on the edge of the pie slice near the
rim of the blue circle. The cursor will change to a bidirectional arrow, and you can
drag the edge of the pie dice.
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Colony Count and Adjusted Count

After you have defined aregion to ignore, two different counts will appear in the
dialog: the colony count and the adjusted count.

The Colony Count isthe number of coloniesthat appear in the defined circle minus
those in the ignored region.

The Adjusted Count is an estimate of the total colony count in the Petri dish; it uses
the known colonies to extrapol ate the number of colonies that might have appeared in
theignored region if it had not been damaged. The adjusted count is calcul ated based
on the area of the ignored region and the density distribution of coloniesin therest of
thecircle.

8.7 Saving/Resetting the Count

A colony count can be saved to the image and/or a separate spreadsheet file.

Saving to the Image

Any count you perform is automatically stored with the image. To save the count with
the image, exit the Colony Counting dialog by clicking on the Close button, and use
the Save commands under the File menu to save the image.

To view the count data again, simply open the image and open the Colony Counting
dialog.

To save a count or multiple counts to a spreadsheet file, see the following section.

Resetting the Count

Click on the Reset button to clear the Colony Counting dialog and any changes you
have made to the image. This command cannot be undone.
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8.8 Saving to a Spreadsheet

The Batch File controls allow you to export colony data from an image or multiple
images to a Microsoft® Excel spreadsheet for review and comparison. To activate
these controls, click on the Batch M ode checkbox.

[¥] Batch mode...  Mew batch... | Open batch... | Save Count | Load Mest...

Batch File |batchEIEIl. xls

Count M ame |Cnlnn§,r Counting.lsc f 1999-05-17 léhr 0O

Count Corment |

Fig. 8-8. Batch Mode controls.

Creating/Opening a Batch File

To create a new batch file, click on the New Batch button. Thiswill open adialogin
which you can specify the name and location of the spreadsheet you want to create.

Wiite counts to file 2 x|

Save jn: Ia‘ID j gl E‘—

|_1 backup

File name: — |batch00| Save |
Save a3 bype: |SpreadsheetFiIe[".xIs] j Cancel |

Fig. 8-9. Creating a batch file.

When you click on Save, the new batch file name will be displayed in the Colony
Counting dialog.
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To open an existing batch file, click on the Open Batch button. Thiswill open a
similar dialog. Select the Excel file you want to open from the appropriate directory.

Naming/Saving a Count

Enter a name for the count you want to save in the Count Name field, or use the
default name (the file name plus a time stamp). Enter any comments in the Count
Comment field. Thisdatawill beincluded in the spreadshest.

To save the currently displayed count to the batch file, click on the Save Count
button. The number of colonies, aswell as associated count settings, will be added to
the spreadsheet. After you have saved the current count, the Save Count button will
become deactivated. If you adjust the count in any way, the button will become active
again and you can add the adjusted count to the spreadsheet.

Loading Another Image

After you have saved the count(s) for the current image, you can open another dish
image by clicking on the L oad Next button. Thiswill open a standard Open dialog
from which you can select the image.

The new image will be loaded into the Colony Counting dialog.

Note:  Theimage will only beloaded into the Colony Counting dialog; it will not open
in a separate image window in Quantity One.

After you have saved the count(s) for the new image to the batch file, you can either
load another image using the L oad Next command or click on Close to close the
Colony Counting dialog.
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9. Differential Display and
VNTRSs

Quantity One has tools for studying gene expression using differential display
analysis and counting VNTRs or other repeated elementsin gels.

These functions are located on the Analysis menu.

9.1 Differential Display

Differential display isa popular technique using mRNA and PCR amplification to
identify genes that are differentially expressed between and among cell types.t The
mMRNA in acell isamplified using RT-PCR and resolved on a DNA sequencing gel,
where it can be compared with mRNA from related cell types to determine
differential gene expression.

The Differential Display tool in Quantity Onefacilitates the side-by-side comparison
of the bands in a sequencing gel by highlighting the up or down regulation of bands
across lanes.

Note:  You must match the bands in the gel image before using this function. See
Chapter 6 for more information.

9.1.a Normalization

Before using the Differential Display function, you must normalize the bandsin the
gel for quantity across all the lanes. With the gel open and matched, select Normalize
from the Match menu and click on adistinct, well-resolved band that appearsin every
lane of the gel. The quantity of that band in each lane will be set to 100, and the
quantities of the other bandsin the lane will be normalized to that band. (If the band is
not present in alane, the normalized quantity for that lane is zero.)

1. Liang, P,, and Pardee, A. (1992) Science 257: 967-970.
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See section 6.2.d, Normalizing for Quantity, for more information on normalization.

9.1.b Differential Display Searches

After you have normalized the gel, select Differential Display from the Analysis
menu. A dialog will open in which you can specify certain parameters.

%% Differential Display

Search for & Outhers ¢ Trends
Differz By

Percentage 20.00 ﬂﬂ
[luantity Z5.00 ﬂﬂ

E";T‘Jmmalized Quantity

Cloze | Help |

Fig. 9-1. The Differential Display dialog box.

You can perform two types of searches on bands across a differential display gel: an
Outliers search or a Trends search. Both are determined by the Per centage and
Quantity values that you specify in the Differs By field.

Outliers

Select the Outlier s button to highlight bands with a normalized quantity that differs
from the mean normalized quantity for that band type by the specified percentage
and/or the specified quantity. An outlier is defined as a band with normalized quantity
(ng) that satisfies one of the following criteria

1. ng>ratiox mean and
Ng > mean + quantity

2. ng<(Uratio) x mean and
Ng < mean — difference

Where: ratio = 1.0 + (percentage/100)
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Trends

Select the Trend button to search for increasing or decreasing levels of gene
expression across samples, represented by trendsin normalized quantity across lanes.
With Trend selected, alinear regression of (ng) versus lane number is computed for
each band type. The leftmost and rightmost lanes containing that band type are
determined. The normalized quantities for these lanes are calculated from the
regression model. If:

abs(leftmost_ng —rightmost_ng) > difference and
Max(leftmost_ng, rightmost_ng) / Min(leftmost_ng, rightmost_ng) > ratio

then the band type is flagged as a trend.

Displaying Results

Bands identified as outliers or belonging to atrend are highlighted with awhite line
in the image.

If alaneis missing a band assigned to a band type that is flagged as an outlier or a
trend, the expected location of the band will be highlighted by awhite box.

Use the Normalized Quantity button in the Differential Display dialog to display a
histogram of the normalized quantities and the mean quantity for aband type. Click
on the button, then click on the band. A graph will display the normalized quantities
of that band across the entire gel.

9.2 Variable Number Tandem Repeats

If your experiments involve the use of microsatellites, VNTRS, or other repeated
elements, you can cal culate the number of times a repeated element occurs in a band.

Note:  You must define the Sandards in the gel before you can use this function (see
section 6.1, Standards).

To calculate the VNTRs in the bandsin agel, select VNTR Calculations from the
Analysis menu. (You can aso select the VNTR Quick Guide from the Help menu for
guidance on analyzing gelswith VNTRS.)
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The Tandem Repeat Calculations dialog box will open.

= Quantity One

Tandem FRepeat Calculations

Band - Flanking Region

Murmber of Repeats =
Repeated Linit

Band Size dernved from band location

Flanking Region Size |10
Fepeated Unit Size |4

Test for ambiguity? ez Mo
Ambiguous if rounded » |0. 25

Flag*ith *  Leave Blank
Done | Help |

Fig. 9-2. Tandem Repeat Calculations dialog box.

At the top of the dialog box is the equation used to cal culate the number of times an
element is repeated in a band.

The band size is determined by the position of the band on the gel image.

In the Flanking Region Size field, enter the size (in base pairs or other repeated
units) of the part of the fragment that does not include any repeated elements. This
would include primer length and the length of any sequencesthat fall between the end
of the primer region and the beginning of the stretch of repeats.
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>

-« ]
N [T TTTTTTTTT

] PCR Primer

] Sequence between primer and VNTR
B VNTR repeat unit

Fig. 9-3. Diagram of components of a DNA fragment.

In the Repeated Unit Size field, enter the size in base pairs of the repeated element
(e.g., if you are working with (CA) repeats, enter “2").

Testing for Ambiguity

The number of repeats calculated by the software may not be awhole number, due to
the limitations of exact band size determination. Since the number of times an
element is repeated must be awhole number, the calculated value is rounded to the
nearest whole number.

In the dialog box, you have the option to “flag” those numbers

Select Yes after Test for ambiguity? to flag values that deviate from the nearest
whole number by a certain fraction. These values may warrant further review. In the
Ambiguousif rounded > field, specify how much the calculated value must deviate
from the nearest whole number for it to be flagged.

Finally, specify how to identify the ambiguous values using the Flag with * button or
the L eave Blank button.

When you have entered all the information in the dialog box, click on the Done
button. The number of tandem repeats will be displayed next to the bands. (Note that
if no standards have been defined on the gel, no numbers will be displayed.)

If the numbers have been concealed (e.g., by the Hide Over lays command), you can
redisplay them by selecting VNTR Display.
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10.Reports

Quantity One can display and print avariety of analysis reports. You can format the
reports to include different kinds of data.

The available reports are listed under the Reports menu.

Reports  Window  Help

Lane Repaort. ..
Al Lanes Report, ..
Band Tvpes Repart. ..

Match Repart. ..
all Matches Report,..

1-D Analysis Repart. .,

Compare Lane Images. ..
Phylogenetic Tree. ..
Sirnilarity Matrix. ..
Comparison Opkions. ..

Yolume Bnalysis Report, .
Yolume Regression CUrve ..,

YMTR Report,..,

Fig. 10-1. Reports Menu.

10.1 Report Window

Many of the reports share the same basic report window.
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Click here to close the report window

= Proteinz - Report

Detail Report by Lane
Proteins
Movember 28, 2001

Lane 3 Mame: cerebellum Band Set: Band Set 3
Band # Band Relative Mol Wyt Peak Average Trace Relative
Type # Fraont KDa oD oD 0D % mm City
3-1 1 0.005 29170x 053 0.47 0.395 1.0
3-2 2 0.014 279.88 0.48 0.26 0.476 1.2
3-3 5 0.058 22752 0.78 0.42 1.060 27
3- 4 B 0.079 205.92 0.58 0.33 0.532 21
3- 4 7 0.103 183.11= 0,14 0.11 0.146 0.4
3-B 8 0.126 163.79 0.33 0.20 0.412 1.1

Moalecular Weight Calculation Method: Point to Faint
= Known x Extrapolated Screen Page 17 of 136

Slg <] v @ e »]m] EJB
A4 v x A4

Print One Page Print All Pages

] Controls for scrolling £ ! ’L ‘
through screen pages xport Reformat

Fig. 10-2. Example of a report window.

The standard report window has buttons for printing the report, scrolling through the
screen pages of the report, and exporting the report to a spreadsheet application. Some
report windows also have a Refor mat button for changing the data display.

To close areport window, click on the Close box in the upper right corner of the

window.
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Scrolling

If areport has multiple pages, the scroll buttons in the report window become active.
Use them to scroll to the next page, previous page, first page, or last page of the
report. You can also enter a specific page number in the field to skip to that page.

Printing

Print the report using the Print One Page or Print All Pages commandsin the report
window.

Click on either of these buttons to open a smaller version of the standard print dialog
(described in the next chapter).

Windows version: Detail Report by Lane

FPages (& A&l (™ First | Last |

Prinker |\\I-[EIGl‘\HP LaserJet E/EM Properties

Orientation {« Portrait (™ Landscape Copies |1

ok | Cancel | Help |

Macintosh version: =—— Quantity One

Detail Report by Lane

Go ] EanceIJ Help J

Fig. 10-3. Print Report dialog.

Print One Page prints only the current screen page. Print All Pages printsall the
pages in the report.
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Note:  If you select Print All Pages, the number of pages printed may be less than the
number of screen pageslisted in the report window. Thisis because the print
command reformats the data to make maximum use of the paper size.

Exporting Report Data

You can export the report data to a spreadsheet application for further computation
and analysis.

Click on the Export button to open the Export Report dialog.

Field Separatars
¢ Commaz [1-2-3 farmat)
{+ Tabs [Excel format)

Export Destination
{+ File
¢ Clipboard

QK | Cancel| Help |

Fig. 10-4. Export Report dialog.

Exported data can be separated by commas or tabs, depending on the regquirements of
your spreadsheet application.

You can save the data to a text file or to the clipboard by selecting the appropriate
option button. If you select File, when you click on OK adialog will open in which

you can save thefile.

Reformatting Report Data

Click on the Refor mat button to open the options dialog for the report and select
different display options. This button is not available in al reports.
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10.2 Lane and Match Reports

There are four different lane and match reports: Lane Report, All Lanes Report,
Match Report, and All Matches Report.

Lane Report generates a report on any you lane you select. First select the report
from the Reports menu, then click on the particular lane.

All Lanes Report generates areport on al the lanesin the current gel image.

Match Report generates a report on a matched band that you select. First select the
report from the menu, then click on a matched band. This report requires band
matching (see section 6.2, Band Matching).

All Matches Report generates areport on all the matched bandsin the gel . This
report requires band matching (see section 6.2, Band Matching).

When you select any of these reports, the Report Options dialog will open, where you
can specify the type and formatting of the data.

Diversity Database - Lane Report

Feport Options

Locations [%] Relative Front [X] Mal. it
Measurements [X] Peak Density [X] &werage Density

[X] Trace Oty [X] Relative Gty

[#] Gauss Peak Density [¥] Gauss Trace Gty

[] Contour &rea [#] Contour Qty

[#] Calibrated Qty [#] Tandem Repeats

[X] Mormalized Gty
Database
Band Set [#]Mame
Band Type  [3] Mumber [] M ame
Sample [=] Mame
Fant Size: |He divm =]
Colurnn Spacing: |Hedium x|
Line Spacing: |ne i, |

Madify FleportSettings| Report | Cancel |

Fig. 10-5. Report Options dialog.
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Select the data to display using the checkboxes.

Select the Font Size, Column Spacing, and L ine Spacing settingsto be used in the
report by clicking on the button next to each field and selecting from the list of
options.

To save the report options, click on the M odify Report Settings button and enter a
name for the report settings in the field.

To load or delete previously saved settings, click on the button next to the Settingsto
Load or Delete field and select from the list of saved settings. Then click on L oad or
Delete.

To display the report, click on the Report button. The report will be displayed ina
standard report window (see section 10.1, Report Window).

10.3 Band Types Report

The Band Types Report shows the presence or absence of specific bands in specific
lanes of agel. The report window displays a schematic representation of all the bands
and lanesin the gel, with the presence or absence of bands shown as specified in the

options dialog.
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= Band Type Report For: Proteins. 15C

Band Type 1
Band Tvpe 2
Band Type 3
Band Type 4
Band Type 5
Band Type &
Band Type 7
Band Type 8
Band Type 8
Band Type 10
Band Type 11
Band Type 12
Band Type 13
Band Type 14
Band Type 15

Matching Tolerance: 3.00%

NV RIS T

Page Setup ILrint Preview

Fig. 10-6. Band Type Report.

Note:  This report requires band matching (see section 6.2, Band Matching).

Select the report from the Reports menu, and select the display optionsin the Band
Types Report Options dialog.

To save thereport options, click on the Settings button in the options dialog and enter
aname for the settings in the field. To load or delete previously saved settings, click
on the button next to the Settingsto L oad or Delete field and select from the list of
saved settings. Then click on Load or Delete.

To display the report, click on the Report button.

This report window includes two additional options: Page Setup and Print Preview.
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Page Setup [ x|

—Paper

Size:

Source; IAulomaticaIIy Select j
i~ Drientation Marging (inches]

& Portrait [Left: |1 Bkt |1

" Landscape Tiap; I'I Bt I'I

oK I Cancel | Frinter... |

Fig. 10-7. Page Setup dialog.

The Page Setup dialog includes controls for selecting the paper size and orientation,
paper tray, page margins, and printer. The Print Preview dialog displaysthe report as
it will be printed.

10.4 1-D Analysis Report

The 1-D Analysis Report displays all the advanced analysis data (including band
types, normalized quantities, amount of sample loaded, etc.) for al the lanesin the
gel. The lanes will aso be ranked in similarity to the lane you initially select to
generate the report.

Note:  Thisreport requires band matching (see section 6.2, Band Matching).

Select 1-D Analysis Report from the Reports menu, then click on any experimental
laneinthe gel. A dialog will pop up, in which you can select the report data to

display.
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= Quantity One

Select Report Features

Display  [®]Analysis Options
Lane  [®]Mame [] Sirnilarity
Category [#] CPM Loaded

Include  [%]Band Data Format {+* Columns ¢ Compact
[¥] Band Frequencies

Repart | Cancel |

Fig. 10-8. 1-D Analysis Report options.

To display the selected data, click on the Report button. The report will be displayed
in astandard report window (see section 10.1, Report Window).

10.5 Similarity Comparison Reports

Quantity One has three reports for comparing the similarity of lane-based samplesin
agel: Compare Lane Images, Phylogenetic Tree, and Similarity Matrix.

Note:  These reports require band matching (see section 6.2, Band Matching).

Comparison Options

Before opening any of these reports, select Comparison Options from the Reports
menu to specify some similarity settings.
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= Quantity One

Analysis Options
Include Al Bandz (" Classified Bandz
Weighted ©+ Tes Mo

Ok

Fig. 10-9. Comparison Options dialog.

In the Comparison Options dialog, select All Bands to include every band in the
sample similarity comparison, or selected Classified Bands to include only matched
bands.

Next to Weighted, select Yesto use both band position and intensity when comparing
sample similarity. Select No to use only band position when comparing samples. The
next section describes how weighting is used in the similarity comparion equation.

Comparison Method

The method for computing similarity in Quantity Oneis the Dice Coefficient. The
formulafor the Dice Coefficient is:

=)

z Min(s;t;)

sim = 200><i:Bl

Z (s+1)
dist = 100—sim

where Sand T are vectors representing two lanes in the same band set that are being
compared.

To compute similarity, avector is constructed that represents the bands identified in
the lane. The vector depends on the comparison options (see above) selected. If the
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search was done on classified (matched) bands only, then the vector S contains B
elements (S=(sl, 2, s3.... sB)), where B is the number of band typesin the lane's
band set. The valuesfor sl, s2, s3 ... sB have the following values:

Weighting Off Search
5 = 1if thei’'th band typeisfound in the lane.
s = 0if it isnot found.
Weighting On Search
If the band set has anormalizing band type, then:
s; = The normalized density of the band assigned to the i’th band type.
s; = 0if the lane does not have a band assigned to thei'th type.
Otherwise:
si = The quantity of the band assigned to the i'th band type.

s; = 0if the lane does not have a band assigned to thei'th type.

10.5.a Compare Lane Images

The Compare Lane I mages report displays the lanes in decreasing order of
similarity to alane that you select.

Select Compare Lane I mages from the Reports menu, then click on areference lane.
Select the report featuresin the pop-up box.
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= Quantity One

Select Repor Features

Display = Images ™ Diagrams
¢ Band Type ™ Band Weighting
[#]Band Type Ruler
[#]Ref. Sample on each page

Cancel

Fig. 10-10. Compare Lane Images options.

If you select the Images option, actual images of the lanes will be displayed in the
report. If you select Diagrams, schematic representations of the lanes will be

displayed.
To display the selected data, click on the Report button.
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£ Pioteins - Compare Images

CODDED P PP

SERTA T U0 — 0 0 e U0 ] S T e

13 12 9
100.0% 883% B856% &7.9% &72% &72% 670% 521% 358% 337%

DOl ] e @iz 2l

Fig. 10-11. Compare Lane Images report.

The Compare Lane Images report is displayed in a standard report window (see
section 10.1, Report Window). Change the report options by clicking on the
Reformat button.

The Print Report dialog for this report contains special fields for entering a report
title.
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10.5.b Phylogenetic Tree

Phylogenetic trees are schematic representations of sample similarity. To compare the
similarity of samplesin aphylogenetic tree format, select Phylogenetic Treefrom the
Reports menu. (You can also select Phylogenetic Tree Quick Guide under the Help
menu to guide you through the process of generating a phylogenetic tree.)

In the pop-up box, select a clustering method for creating the tree. See the following
pages for information about the different methods.

= Proteins - Phylogenetic Tree

) _ . : i
Cluster Method | Heighbor Joining mm i
i cerehellum e
.38
6.32
964 — stem
G.24
0.84 cerebrum
24.05 .
liver
13.47
450 —  large Gl
.68 L1684 stamach
1714 small G
12.88
spleen
9.99 un
533 g
11.41
842 1.74 - thymus
2435
4.57 heart
19.07
13.93 aorta
21.87
Wena cava s
¢ i

Fig. 10-12. Phylogenetic Tree.

Note:  We have found that Ward's method, UPGAMA, and WPGAMA give the most
plausible clusters and are affected the least by samples that are outliers.
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The report window for aphylogenetic treeis slightly different than the standard report
window. The tree appears in a window with scroll bars for moving up and down and
left and right.

To print the tree, click on the Print button.

Click on the Cluster Method button to select adifferent clustering method for

displaying the tree. Thiswill automatically recalculate and redisplay the tree.
Neighbor Joining

This type of phylogenetic treeis computed is based on minimizing the total branch
length at each stage of clustering. The method also finds branch lengths between
nodes. The approximate distance between any two samplesin this tree can be found
by adding the branch lengths that connect the samples.

Other Methods?,?
The following methods are based on the algorithm below:
1. Begin with n clusters—one cluster for each sample.

2. Compute the similarity matrix for the samples.

3. Convert the similarity matrix into a distance matrix d using the appropriate
distance formula.

4. Join the two clusters with the minimum distance into one cluster. Compute the
similarity value for this cluster.

5. Recompute the distance matrix d using the cluster that was formed in Step 4.

Steps 4 and 5 are repeated until there is only one cluster. The difference between the
methods below is based on the definition of minimum distance in Step 4, and on the

1. For a complete explanation of the calculations and assumptions used
to generate these dendrograms, please refer to Sneath and Sokal.
Numerical Taxonomy, San Francisco: W. H. Freeman & Company,
1973.

2. Vogt and Nagel, Clinical Chemistry 38 (2): 182-198, (1992).
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method of computing the new distance matrix in step 5. In the discussion that follows,
let:

p, q be indices indicating two clusters that are to be joined into asingle cluster.

k be the index of the cluster formed by joining clusters p and g.

i bethe index of any remaining clusters other than cluster p, g, or k.

Ny the number of samplesin the p'th cluster.

ng the number of clustersin the g'th cluster.

n the number of clustersin the k'th cluster formed by joining the p'th and q'th cluster.

n=n_+n
p q

dpq the distance between cluster p and cluster g.

Single Linkage

Thisisalso called Nearest Neighbor or Minimum Method.

[ = mi n(dpi,dqi)

Complete Linkage

Thisisalso called the Furthest Neighbor or Maximum Method.
dy

i = max(d,;,dg)

Single and Complete linkage are good algorithms for indicating outlier clusters.

UPGAMA

Unweighted pair group method using arithmetic averages. Thisis also called
Weighted Average Linkage.

_ 'y akn
di = gno Wi + o0 Hai
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WPGAMA

Weighted pair group method using arithmetic averages. Thisis also called Average
Linkage.

dg = 050ty + 05,

WPGAMA isaspecial case of UPGAMA that favorsthe most recent member clusters
in forming new clusters.

Centroid
_ P k' (np thy)
i = O Moi * 00 e ~ 2
pPq
Median

dg = 05ty + 05 [ty —0.25 [t

Centroid and Median are similar to UPGAMA and WPGAMA, respectively, but the
distance formula contains an additional third term. Centroid and Median methods are
not monatomic hierarchical clustering algorithms. In other words, the similarity value
between cluster k and any other cluster may be greater than the similarity between
cluster p and cluster g. This condition occursiif the centroids (or medians) of the
different clusters have approximately the same distance as the distances between the
samples that make up the cluster.

Ward’s

This method attempts to minimize the information by describing a set of N samples
using a fewer number of clusters.

n,+n; n,+n n

_ M q L
dkl n+ n| pi n+ nl dQI n+ nldpq
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Options

Click on the Options button in the Phylogenetic Tree window to open the Options
dialog.

£ Options & Options
{ Align Right % Proportional {»* Align Right ¢ Propartional
[=] Fit Tree in \Windaw [#]Fit Tree in Window
Festore Original Tree Restare Original Tree

[[] Designate Mew Root Clusters |0
Bl All Other Methods
Max. I—D_ 17.8

Neighbor Joining Only

Fig. 10-13. Two forms of the Options dialog.

The box on the left has controls that are specific for the Neighbor Joining method.
The box on the right is applicable to the other tree methods. Both boxes share certain
features.

Each allows you to choose between aligning the tree to the right or proportionally
aligning it. Right alignment uses a fixed branch length for displaying the distance
between nodes; proportiona alignment differs for Neighbor Joining and other tree
modes.

With the Neighbor Joining method, proportional alignment shows branch length sizes
proportional to the min/max values set in the Options dialog. Other methods plot the
nodes at locations determined by their similarity values.

The Fit Treein Window option scales the tree so that the entire tree will fit onto a
single printed page. With this turned off, the entire tree will appear with the correct
distances between nodes preserved, and the printed tree can be tiled across multiple
sheets of paper.

The Neighbor Joining Options dialog, click on the Designate New Root button to

designate a new root node (the node at the very top of the tree), enabling you to look
at the relationships between lanes from a different perspective. Thiswill highlight all
the nodes in the tree. Click on the node that you want to serve as the new root and the
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dendrogram will be recalculated. To return to the original tree, click on Restore
Original Tree.

The Min. and Max. siders are active only for proportionally aligned Neighbor
Joining trees. Use them to adjust the minimum and maximum distances between
nodes on branches to highlight specific regions of data. Distances below the Min. or
above the M ax. values will be collapsed to fit in the window.

For non-Neighbor Joining trees, use the Cluster s option to define the number of
clusters (0 to 18) in the tree. The separate clusters will be identified in the tree by
letters.

10.5.c Similarity Matrix

The Similarity Matrix report compares the similarity of all the lanes to one another.
If there are N lanesin the gel, then the similarity matrix isan N by N matrix that is
computed using the Dice Coefficient as described in section 10.4, 1-D Analysis
Report.

The matrix has the following properties:

e Thediagonal elements always have values of 100. Thisis because alaneis
always 100 percent similar to itself.

*  Thematrix is symmetrical (Mijj = Mjj).

Select Similarity Matrix from the Reports menu to open this report.
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Fig. 10-14. Similarity Matrix report.

The Smilarity Matrix report is displayed in a standard report window (see
section 10.1, Report Window).

10.6 Volume Analysis Report

The Volume Analysis Report displays volume data.

Select Volume Analysis Report from the Reports menu or Volume toolbar. The
Volume Report Options dialog will open, in which you can specify the information

that will appear in the report.
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When you click on OK, the report will be displayed in a standard report window (see
section 10.1, Report Window).

10.6.a Volume Report Options

Yolume Report Options

~Data To Display
[®]Hame [%] Min. Yalue
[X] Type [%] Max. Walue
[*] W olurne ] Density
[3¢] &adj. Wal. [¥] Mean Backad.
[#]% Yolume [#] Mum. Pirels
[JConcentration [ Location
[X]&rea 1 Location

[®]Mean Value  []Width
[®]5td Deviation  []Height

~Image Display Options

[#] Display image in repart
[#] Pririt image: o report
[x] Show overlays in image

[1lmage on 1st page only

~Background Subtraction iethod
{+ Global ¢ Local

~Regression method
(™ Point To Point ¢ Linear

~Wolurne objects ta repart

Font Size: |He dium

Line 5pacing: |He Emm,

™ Cubic " Quadratic
™ Logistic (s Spline
Show Curve
{+* &l objects ¢ Selected objects
&
i
Modify Report Settings| ] | Cancel |

Fig. 10-15. Volume Report Options dialog.

The volume report options are described below:
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Name—The name that is automatically assigned to the volume based on its type
(U=Unknown, Std=Standard, B=Background) and order in which it was created.

Type—Unknown, standard, or background.

Volume—Sum of the intensities of the pixelsinside the volume boundary x area
of asingle pixel (in mm"2).
Adj. Vol.—Volume minus the background volume; if there is no background
volume, thisis simply the volume.



Quantity One User Guide

% Volume—The volume expressed as a percentage of all the volumesin the
image.

Concentration—The quantity as calculated from the standards and the
regression method. If you have not defined standards, thisis not calculated.

Area—Thetotal area of the volume box you have drawn in mm”2.

M ean Value—The mean intensity of the pixelsinside the volume boundary.
Sd. Deviation—The standard deviation from the mean intensity.

Min. Value—The value of the lowest intensity pixel in the volume.

Max. Value—The value of the highest intensity pixel in the volume.

Density—Thetotal intensity of al the pixelsin the volume divided by the area of
the volume.

M ean Background—The mean intensity of the pixels in the background
volume.

Num. Pixels—The number of pixelsinside the volume.

X location—The distance in mm from the left edge of the image to the center of
the volume.

Y location—The distance in mm from the top edge of the image to the center of
the volume.

Width—The width of the volumein mm.
Height—The height of the volume in mm.

Specify the preferred Background Subtraction Method (Global or L ocal).

Note:

If you select Global and have not defined a background volume, no background
subtraction will be performed on the image.

The Image Display Options affect how the image is displayed and/or printed on the
report.

You can choose whether to report on all volume objects (All objects) or only those
objects you have selected (Selected objects)

Select the regression method for calculating the Volume Regression Curve. To
display the curve, click on the Show Curve button.
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Select the Font Size and Line Spacing settings to be used in the report by clicking on
the button next to each field and selecting from the list of options.
Saving the Report Options

To save the report options, click on the M odify Report Settings button at the bottom
of the dialog. In the pop-up dialog, enter a name for the report settingsin the field.

To load or delete previously saved settings, click on the button next to the Settingsto
Load or Delete field and select from the list of saved settings. Then click on Load or
Delete.

10.7 Volume Regression Curve

If you have defined at |east two standard volumes on the image, you can display a
regression curve for calculating the quantities of the unknowns.

Select Volume Regression Curve from the Reports menu.
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Volume Regression Curve Dialog

~Reagression Curve Plot

Gel name : Prateins 15C

Concentration

Dizplay O ptions:

[[]5haw Narne
Regression method
™ Paint To Paint
™ Lingar
™ Cubic
™ Quadratic
i+ Logistic:
™ Spline

Cancel

40.0

Print

Adjusted Volume
4.00 8.00 1z2.0 16.0 20.0

Regression Equation
Conc=(64.5- 236501 + (Vol/12.6)*2.33) + 236

Fig. 10-16. Volume Regression Curve window.

On the curve, each standard volume is marked by ared X and each unknown is
marked by ablue triangle.

The X axisisthe adjusted volume and the Y axisis the concentration, based on the
standards you have marked on the image.

To display the numbers and names of the volumes, click on the Show Name
checkbox.

Select the preferred regression method from the list of option buttons. The regression
equation for the selected method is displayed in the lower left of the window.
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To print the curve, click on the Print button. To close the window, click on the OK
button.

10.8 VNTR Report

The VNTR Report displaysthe calculated VNTR data (see section 9.2, Variable
Number Tandem Repeats).

Select VNTR Report from the Reports menu. A pop-up box will ask if you want to
display the gel image in the report.

£ VNTR Report X
Tandem Repeat Report
DProteins: rat organs
Tune 18, 1598
Mol Wt Raw Rounded  Band Type
Band KDa Repeat#  Repeat# Name
1 239 6733 aT*
o 73 64.40 [N
3 226 5144 1
24 206 46 53 a7
5 164 3538 36
6 148 3202 a2
7 128 2690 27
8 14 2340 3%
8 108 2199 2
210 103 2065 2
11 99 19.63 20
12 95 1865 19
13 37 1682 17
14 3l 1523 15
15 74 1353 14
16 &9 1218 12
17 64 1o 1
18 &0 994 n
19 56 392 9
220 53 333 g
# Rounding changed the repeat mumber more than 0.23
SereenPage 1 of 18
DID| e eeee R

Fig. 10-17. Example of a VNTR Report.
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Thereport is displayed in a standard report window (see section 10.1, Report
Window).

The report displays the molecular weight, the raw repeat number, and the rounded
repeat number for each band in the gel image.

The raw repeat number is the number of repeats cal culated using the information that
you provided in the Tandem Repeat Calculation dialog, and islikely to include
fractional values. The rounded repeat number is the raw repeat number rounded to the
nearest whole number.

An asterisk (*) will appear next to some of the rounded repeat numbersif you selected
Test for Ambiguity and Flag with * in the Tandem Repeat Calculations dialog. The
asterisk will appear next to numbers that vary from the raw repeat number by more
than the selected ambiguity value.
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11.Printing and Exporting

The commands for printing and exporting images are located on the File menu.

Reports are printed from within the individual report windows.

11.1 Print Image and Print Actual Size

The Print Image and Print Actual Size commands on the File > Print submenu
open a standard Windows or Macintosh printer dialog box, in which you can select
the printer, paper size, paper source, page layout, etc.

You can use these print commands to print the plain image, or the image plus overlays
(volumes, text overlays, defined lanes and bands, band data, etc.). To include image
overlaysin the printout, first display the overlays on the image and then select the
appropriate print command.

Select Print Image to fit the selected image to the printed page.

Select Print Actual Sizeto print an actual-size copy of the selected image. If you are
using the Gel Doc, ChemiDoc, ChemiDoc XRS, Fluor-S, Fluor-SMAX, Fluor-S
MAX2, or VersaDoc, you must specify the correct image area size when capturing
images to ensure accurate 1:1 printing. Specify the image area size in the acquisition
window for the instrument. See the chapter on each imaging device for more
information.

11.2 Page Setup

Specify the printer settings using the Page Setup command on the File > Print
submenu. Thiswill open the standard Page Setup dialog box for Windows or
Macintosh, in which you can select the paper size, page orientation, printer, etc.
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Page Setup [ x|

—Paper

Size:

Source; IAulomaticaIIy Select j
i~ Drientation Marging (inches]

& Portrait [Left: |1 Bkt |1

" Landscape Tiap; I'I Bt I'I

oK I Cancel | Frinter... |

Fig. 11-1. Page Setup dialog box.

11.3 Image Report

The Image Report displays the image and basic image information, including the
image dimensions, pixel size, date of scan, type of imager, etc.

To print an image report for aparticular gel, select Image Report from the File >
Print submenu. Thiswill open a smaller version of the standard printer dialog box.

11-2



Chapter 11. Printing and Exporting

£ Image Report For: Proteins [Raw 1-D Image]

Description rat organsO

Directory CProgram Files\Bio-Radiklew Discovery Series\Sample Images\D
Filenarme Prateing 15C

Sean Date 29-Feb-1996 00:00

Scanner PDI 42008 Pixel sizefurn) X 16895, ¥: 169.4

Scan Area(mm) = 107.3, Y 1281 Data Range 30000

Scan Pixels H B33 Y T7EB Mernory Size  469.27 Kb

Sean Parameters
MO SCAM PARAMETERS AVAILABLE
Gel Background

of @5

g ﬂﬂF‘age’l_ufz ﬂﬂ

Fig. 11-2. Image Report.

Note:  TIFF images do not contain all the tagged information that would normally be
included in an image file (for example, imaging device, scan date, image color,
etc.). For thisreason, the | mage Report may list thisinformation as “Unknown”
for imported TIFF files.

11.4 Video Print

Select Video Print from the File > Print submenu to print images and reportsto a
video printer.

Note:  Video printing requiresinstallation of the video board and cable that come with
the Gel Doc and ChemiDoc systems. The video board and cable can also be
ordered separately.
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Settings for the Mitsubishi P9OW/P91W Video Printer

There are three settings for the Mitsubishi POOW/P91W video printer. Set Contrast to
zero, Brightnessto zero, and Gammato 5.

The dip switches should stay in the orientation in which they are shipped: Pin 1isup
(on), and Pins 2-10 are down (off).

11.5 Export to TIFF Image

You can export images in TIFF format for analysis and publishing using other
applications. Select Export to TIFF Image from the File menu to open a dialog box
in which you can specify the export parameters.

= Export 'FX-Etbr [Raw 1-D Image]' As TIFF

~Export Mode

Analygis
(™ export raw data
Publizhing
{+ export view excluding overlays

(™ export view including overlays

~FRiezolution [dpi]

(« 72dpi (" Sameasscan |(253.4)

¢~ 150 dpi
(™ Specify (720
£ 300 dpi
~Transfarm Bit Depth Zoarm
(™ Linear (s 8 hit (™ Entire image
o Current view || £ 16 bit (o Current view
£ 24 bit RGE
rSize
Pixels % 155 Y |184 Image |Z'?.85 Eb

=7 Export | > Canc:e|| (@ Help |

Fig. 11-3. Export to TIFF Image dialog box.
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There are two basic export options:

»  Export the raw image data for further analysis
»  Export the displayed view of the image for publishing.

If you choose to export the displayed view, you can export with or without the image
overlays.

11.5.a Analysis Export Mode

To export a TIFF image for further analysis, select the Export raw data button. The
publishing controlsin the dialog box will become inactive.

11.5.b Publishing Export Mode

To export a TIFF image that looks like the image asit is currently displayed on the
screen, select one of the options under Publishing.

Export View Including Overlays

Select this option to include overlays with the exported image. The other controlsin
the dialog box will become inactive.

Export View Excluding Overlays

Select this option to not include overlays with the exported image. Thisisthe only
mode available if you are exporting images from the Multi-channel Viewer (see
section 3.4, Multi-Channel Viewer).

With this option selected, specify aresolution for the TIFF image by selecting 72 dpi
(typical computer screen resolution), 150 dpi, 300 dpi (standard printing resolution),
Same As Scan, or any resolution that you enter in the Specify field (up to the
resolution of the scan).

Under Transform, you can specify aL inear transform or preserve the Current View
(which is automatically log transformed).

Images with a higher Bit Depth (e.g., 16 bit or 24 bit RGB) can be compressed to a
lower bit depth (e.g., 8 bit) during export.
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Note:  TIFF images are automatically exported from the Multi-channel Viewer in 24 bit
RGB mode to preserve the colors displayed in the viewer.

Finaly, if you are only displaying part of the image due to magnification or
repositioning, you can preserve the Current View or export the Entire I mage.

11.5.c Exporting the Image

The size of the pixelsin the image and the file size of the image are listed at the
bottom of the dialog. When you are ready to export, click on the Export button.

In the Save As dialog box, the default file name will have a .tif extension, and thefile
type will indicate that thisisa TIFF image.
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Appendix A
Gel Doc 2000

Fig. A-1. Gel Doc.

Before you can begin acquiring images, the Gel Doc system must be properly
installed and connected with the host computer. See the Gel Doc hardware manual for
installation, startup, and operating instructions.
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To use the Gel Doc, you will need to have the Bio-Rad-supplied acquisition board
installed in your PC or Macintosh. The drivers for this board will be installed when
you install the main software application.

Make sure that your Gel Doc cameraisturned on. If the camerais not turned on, the
Gel Doc acquisition window will open and an image capture error will be displayed.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simulation mode.”
In this mode, an acquisition window will open and the controls will appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. Thetitle of the acquisition window will indicate that it is
simulated.

A.1 Gel Doc Acquisition Window

To acquire images using the Gel Doc, go to the File menu and select Gel Doc.... The
acquisition window for the instrument will open, displaying a control panel and a
video display window.
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£ Gel Doc
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Fig. A-2. Gel Doc acquisition window

The Gel Doc video display window will openin “live” mode, giving you alive video
display of your sample. If no image is visible, make sure the camerais on, check the
cable connections, make sure the iris on the camerais not closed, and make sure that
the protective cap is off the cameralens. Also check to see that the transilluminator is
on and working.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are six basic steps to acquiring an image using the Gel
Doc:

1. Position and focus the gel or other object to be imaged.

2. Select Mode.

3. Acquire theimage.
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4. Optimize the display.
5. Anaysis.
6. Select the output.

A.2 Step I. Position Gel

The Gel Doc window will openin “live” mode, giving you alive video display of
your sample. In this mode, the Live/Focus button will appear selected, and frames
will be captured and displayed at about 10 frames per second, depending on the speed
of your compuiter.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while
positioning the sample within the area.

Note:  Newer versions of the Gel Doc feature a motorized zoom lens that can be
controlled directly from the acquisition window using the Iris, Zoom, and Focus
arrow buttons. Click on the Up/Down buttons while viewing your samplein the
window to adjust the lens. These buttons will not be visible if you are connected
to older versions of the Gel Doc without the motorized zoom lens.

~5Step | Poghion Gel

‘ @ Live/Focus

IRIS Z00M FOCUS

E I:Ipen| $ Tel= | $ Mear |

+ EIO$E| ¥ ‘wide | ¥ Far |
] 5how &hgnment Grid

Fig. A-3. Newer Gel Docs feature camera control buttons in the acquisition window.

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note:  After positioning your sample, you should check the Imaging Area dimensions
under Options (see section A.9, Options) to make sure that they conform to the
size of the area you are focusing on. To determine the size of the areayou are
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focusing on, you can place aruler in the Gel Doc cabinet sothat itisvisiblein the
image.

A.3 Step Il. Select Image Mode

The Image Mode option buttons allow you to set the type and scale of your data.

uv
Select this mode for fluorescent samples. With this mode selected, the data will be
measured in linear intensity units.

White Light

Select this mode for reflective and transmissive sampl es. With this mode selected, the
datawill be measured in uncalibrated optical density (UOD) units.

A.4 Step Ill. Acquire Image

For many white light applications, you can skip this step and save and print images
directly from Live/Focus mode.

For UV light or faint samples, you can take an automatic exposure based on the
number of saturated pixelsin the image or you can enter a specific exposure time.

Note:  “Exposure” refersto the integration of the image on the camera CCD over a
period of time. The effect is analogous to exposing photographic film to light
over aperiod of time.

Auto Expose

Auto Expose will take an exposure whose time length is determined by the number of
saturated pixelsin theimage. Thisisuseful if you are uncertain of the optimal
exposure length.
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Note:  If you know the approximate exposure time you want (+ 3 seconds), you can skip
this step and go directly to Manual Expose.

Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, theimage is continuously integrated on the camera CCD
until it reaches a certain percentage of saturated pixels. This percentageis set in the
Options dialog box. (Default = 0.15 percent. See section A.9, Options.)

~Step Il Acguire Image

Click on Auto Expose;

5 M |
button appears depressed @ fls @ e

Expoze Expoze

rExposure Time [zec]
Can see Exposure Time o

automatically changing » [0.03 ﬁ ﬁ

[(n ] Freeze ‘

Fig. A-4. Auto Expose.

Once an image has reached the specified percent of saturated pixels, it is captured and
displayed in the video display window, Auto Expose is automatically deactivated, the
exposure time appears active in the Exposure Time field, and Manual Exposeis
activated.

Note: I you are having difficulty auto-exposing your sample, you can use Manual
Expose to adjust your exposure time directly. Most applications only require an
exposure time of afew seconds, which can be quickly adjusted using Manual
Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual
Expose button. Manual Expose is automatically activated after Auto Expose has
deactivated.
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Manual Expose active;
— button appears selected

o7 8]

Q

Freeze

Fig. A-5. Manual Expose.

With Manual Expose activated, you can adjust the exposure time directly by changing
the number of secondsin the Exposure Time field. Typein anumber or use the arrow

buttons next to the field.

When the specified exposure time is reached, the last captured image will be
displayed in the Gel Doc image window. The camera continues to integrate the image
on the CCD, updating the display whenever the specified number of secondsis

reached.

Once you are satisfied with the quality of the displayed image, click on the Freeze
button to stop the exposure process. The last full exposure will be displayed in the

image window.

Click on Freeze to stop
the exposure process
\

~Step . Acquire Image

o Auto
Expoze

@ tanual
Expoze

"Eﬂposure Tirme [sec)

| ] 2]

Freeze

Fig. A-6. Freezing the exposure.
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Note:  Freezeisautomatically activated if you adjust any of the subsegquent controls
(e.g., Video Print, Image Mode, Display controls, etc.).

A.5 Step IV. Optimize Display

The Display controls are useful for quickly adjusting the appearance of your image
for output to a video printer. Adjusting these controls will automatically freeze the
video display and alow you to alter the image within the Gel Doc window.

~Step W, Optimize Dizplay

High [258 —————f
Lo ID— Ji
Gamma W |—J—

[®] Highlight 5 aturated Pixels
[ Irevert Display

Auto-zcale|  Feset

Fig. A-7. Display controls.

These controls are similar to those in the Transform dialog box.

Note:  The Display controlswill only change the appearance of the image. They will not
change the underlying data.

High/Low Sliders

If Auto-scale doesn't give you the appearance you want, you can use the High and
Low sliders to redraw the image yourself. In white light mode, dragging the High
dlider handle to the left will make weak signals appear darker. In UV mode, dragging
the High slider handle to the left will make weak signals appear brighter. Dragging
the Low dlider handle to the right will reduce background noise.

You can also type specific High and Low values in the text boxes next to the sliders.
Clicking anywhere on the slider bars will move the sliders incrementally.
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Gamma Slider

Some images may be more effectively visualized if their data are mapped to the
computer screen in anonlinear fashion. Adjusting the Gamma slider handle changes
thelight and dark contrast nonlinearly.

Highlight Saturated Pixels
When thisbox is checked, any saturated pixelsin theimagewill appear highlighted in

red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

Invert Display

This checkbox will switch light spots on a dark background to dark spotson alight
background, and visaversa. Thiswill only affect how the image is displayed on the
screen, not the actual image data.

Auto-scale

Clicking on Auto-scale will adjust your displayed image automatically. The lightest
part of the image will be set to the minimum intensity (e.g., white), and the darkest
will be set to the maximum intensity (e.g., black). You can then “fine tune” the
display using the High, Low, and Gamma sliders described bel ow.

Reset

Reset will return the image to its original, unmodified appearance.

A.6 Step V. Analysis

The Analysis step of the Gel Doc acquisition window allows you to add annotations
and analyze the newly acquired image.
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Annotate

Clicking on Annotate will open a separate image window displaying the captured
image. The default name for the image will include the date, time, and user (if
known).

The Text Overlay toolbar will also pop up to alow you to annotate your image.

Theimage will not be saved until you select Save or Save As from the File menu.

Analyze

Clicking on Analyze will open a separate image window displaying the captured
image. The default name for the image will include the date, time, and user (if
known).

You can then analyze the image using the other features in the main application.

Theimage will not be saved until you select Save or Save As from the File menu.

A.7 Step VI. Select Output

In Select Output you can select Video Print and Save as your output options.

Step 1. Select Output

= Yiden Print

Save

Fig. A-8. Output options.

Video Print

Clicking on Video Print will automatically send the currently displayed frame (either
live or integrated) to avideo printer. You can add information about your imageto the
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bottom of the printout by selecting the appropriate checkboxes in the Options dialog
box. (See section A.9, Options.)

Save

Clicking on Save will open a separate image window displaying the captured image.
A Save Asdialog box will automatically open displaying the default file name for the
image, which will include the date, time, and user (if known). You can then change
the file name and storage directory.

You can also export your image as a TIFF image for viewing with other applications.

A.8 Exposure Status

The Exposure Status bar shows the progress of your exposure. If your exposure time
isgreater than 1 second, the status bar display will give you agraphical representation
of the remaining time before exposure is complete.

If the exposure time isless than 1 second, the status bar will not refresh itself for each
exposure; it will remain at 100 percent.

A.9 Options

Click on the Options button to open the Options dial og box. Here you can specify
certain settings for your Gel Doc system.
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Gel Doc Options

DAL Settings
in =0 |—J7
Max (120 liJi

~lmaging Area [cm)

Width: |20.00 Height: |l5.DD

~Auto Exposure Threshold
¥ Saturated Pivelz:  |o0. 18

~Reminder
[®] Shiew Light W arhing
i Shiow Filker Wwarming

~Wideo Printing Footer Information
[=] File Mame [#] O ate Time
[®]Exposure Time  [#] Contrast Settings

~Save Optiohs
[IMake Backup Copy

~Mizc Optior
1 Simple Acquisition tMode

Defaults | Cancel | ak. |

Fig. A-9. Available options in the Gel Doc acquisition window.
Click on OK to implement any changes you make in this box. Clicking on Defaults
restores the settings to the factory defaults.
DAC Settings

Note:  The default DAC settings are highly recommended and should be changed with
caution.

These sliders may be used to adjust the minimum and maximum voltage settings of
your video capture board. The minimum dider definesthe pixel value that will appear
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as white in the image, while the maximum slider defines the pixel value that will
appear as black. The slider scaleis 0-255, with the defaults set to 60 minimum and
130 maximum.

Imaging Area

Thesefields are used to specify the size of your imaging areain centimeters, whichin
turns determines the size of the pixelsin your image (i.e., resolution). When you
adjust one imaging area dimension, the other dimension will change to maintain the
aspect ratio of the cameralens.

Note:  Your imaging area settings must be correct if you want to do 1:1 printing. These
are also important if you are comparing the size of objects (e.g., using the
Volume Tools) between images.

Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage
of saturated pixels you want in your image. Thisfield allows you to specify that
percentage.

Typicaly, you will want less than 1 percent of the pixelsin your image saturated.
Consequently, the default value for thisfield is 0.15 percent.

Reminder
When this checkbox is selected, the software will warn you to turn off your
transilluminator light when you exit the Gel Doc acquisition window or when your
systemis“idle” for more than 5 minutes.

Video Printing Footer Information
The checkboxes in this group allow you to specify the information that will appear at
the bottom of your video printer printouts.

Save Options

To automatically create a backup copy of any scan you create, select the Make
Backup Copy checkbox.
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With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup files will have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

Simple Acquisition Mode

The Simple Acquisition mode option allows you to reconfigure the Gel Doc
acquisition window to simple mode. In simple mode, the acquisition window contains
the same steps as the advanced acquisition window with the exception of Step 1V,

Optimize display, and Step V, Analysis. Manual exposureis also disabled in simple
mode.

£ GelDoc

~Step |. Position Gel—————————————

@ Live/Focus

IRIS Z00M FOCUS
+ Dpen| 4+ Tele ‘ 4 Near |
L Cluse| &+ Wwide ‘ ¥ Far |

Step Il Image Mode
" @ white
Step IIl. Acquire Image
o Auto
Expoze
{(n ] Freeze

~Step ¥, Select Output

¥video Print Save
Options... @Helu

Fig.A-10. Simple Acquisition Window
To change the acquisition window to Simple Acquisition Mode, check the box

marked Simple Acquisition Mode. The change will take effect the next time you open
the acquistion window.
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Fig.B-1. ChemiDoc.

Before you can begin acquiring images, the ChemiDoc system must be properly
installed and connected with the host computer. See the ChemiDoc hardware manual
for installation, startup, and operating instructions.
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To use the ChemiDoc, you will need to have the Bio-Rad-supplied acquisition board
installed in your PC or Macintosh. The drivers for this board will be installed when
you install the main software application.

Make sure that your ChemiDoc camera s turned on. If the camerais not turned on,
the ChemiDoc acquisition window will open and an image capture error will be

displayed.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simulation mode.”
In this mode, an acquisition window will open and the controls will appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. Thetitle of the acquisition window will indicate that it is
simulated.

B.1 ChemiDoc Acquisition Window

To acquire images using the ChemiDoc, go to the File menu and select ChemiDoc....
The acquisition window for the instrument will open, displaying acontrol panel and a
video display window.
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& Chemi Doc

~Step |. Position Gel

0 Live/Focus

IRIS 200w FOCUS
4 Open | # Tele | # Near
¥ Close [ & Wide | & Fa

[C15howe Alignment Grid

Step 1l Image Mode
’Vﬁ“u\f " White (™ Chemi

- Step Il Acquire Image

Auta Marwal
o Expose o Expose

0 Live
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Exposurs Time [sec)
’V 0.03 ﬂ ﬂ
9 Freszs

~Step IV, Optimize Display ——————————

High |zs55 riJ

Low [0 F————

Bamma [1.00 | ——— [———
Stepl. Analpsis | Gtep¥l. Gelect Dutpput——————— (E Stab
[¥] Highlight S aturated Pisels & GEIbES & CESEHE EEALAS
[Inwert Display [ek Annotate | = idea Print |
Auloscale|  FReset 3 - |
Analyee | Savs Options... | (2 Help |

Fig.B-2. ChemiDoc acquisition window

The ChemiDoc video display window will open in “live” mode, giving you alive
video display of your sample. If no image is visible, make sure the camerais on,
check the cable connections, make sure theiris on the camerais not closed, and make
sure that the protective cap is off the cameralens. Also check to see that the
transilluminator is on and working.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are six basic steps to acquiring an image using the
ChemiDoc:

1. Position and focus the gel or other object to be imaged.

2. Select Mode.

3. Acquire theimage.
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4. Optimize the display.
5. Anaysis.
6. Select the output.

B.2 Step |. Position Gel

The ChemiDoc window will openin “live’” mode, giving you alive video display of
your sample. In this mode, the Live/Focus button will appear selected, and frames
will be captured and displayed at about 10 frames per second, depending on the speed
of your compuiter.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while
positioning the sample within the area.

Note:  Newer versions of the ChemiDoc feature a motorized zoom lens that can be
controlled directly from the acquisition window using the Iris, Zoom, and Focus
arrow buttons. Click on the Up/Down buttons while viewing your samplein the
window to adjust the lens. These buttons will not be visible if you are connected
to older versions of the ChemiDoc without the motorized zoom lens.

~Step |. Position Gel

‘ @ Live/Focus

IRIS 200 FOCUS

+* Dpen| 4+ Tel= | 4+ Mear |

L Elnse| ¥ "wide | ¥ Far |
] Show &lignment Grid

Fig.B-3. Live/Focus button and camera control buttons.

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note:  After positioning your sample, you should check the Imaging Area dimensions
under Options (see section B.9, Options) to make sure that they conform to the
size of the areayou are focusing on. To determine the size of the areayou are
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focusing on, you can place aruler in the ChemiDoc cabinet so that it isvisiblein
theimage.

B.3 Step Il. Image Mode

The Image Mode option buttons change the type and scale of the data, aswell asthe
behavior of the ChemiDoc when acquiring an image.

uv
Select this mode for fluorescent samples. With this mode selected, the data will be
measured in linear intensity units.

White Light
Select this mode for reflective and transmissive sampl es. With this mode selected, the
datawill be measured in uncalibrated optical density (UOD) units.

Chemi

This mode is designed for chemiluminescent samples. With this mode selected, the
datais measured in linear intensity units; however, the dataisinverted, so that
samples will appear dark on alight background.

Also, Chemi mode changes the behavior of the Auto and Manual Expose functions, as
described above.

B.4 Step lll. Acquire Image

For many white light applications, you can skip this step and save and print images
directly from Live/Focus mode.

For UV light, chemiluminescent applications, or faint samples, the ChemiDoc control
panel has several features for creating image exposures. You can take an automatic
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exposure based on the number of saturated pixels in the image, you can enter a
specific exposure time, or you can take a series of exposures and select the best one.

Note:  “Exposure” refers to the integration of the image on the camera CCD over a
period of time. The effect is analogous to exposing photographic film to light
over aperiod of time.

Auto Expose

Use Auto Expose if you want to take a single exposure but are uncertain of the
optimal exposure time.

Note:  If you know the approximate exposure time you want (x 3 seconds), you can skip
this step and go directly to Manual Expose.

Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, theimage is continuously integrated on the camera CCD
until it reaches a certain percentage of saturated pixels. This percentageis set in the
Options dialog box. (Default = 0.15 percent. See section B.9, Options.)

~Step lll. Acquire Image

Click on Auto Expose; Auto o b arwal

o Live
button appears selected Evpose Expose Acquire

A

~Expozure Time [zec)
Can see Exposure Time o

automatically changing »(0.0z ||

@ Freeze |

Fig.B-4. Selecting Auto Expose.

Once an image has reached the specified percentage of saturated pixels, it is captured
and displayed in the video display window, Auto Exposeisautomatically deactivated,
and the exposure time appears active in the Exposure Time field.
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At this point, if you arein UV or White image mode, Manual Expose will be
automatically activated. If you are in Chemi mode, the Freeze button will be
automatically activated.

Note:  If you are having difficulty auto-exposing your sample, you can use Manual
Expose to adjust your exposure time directly. Most non-chemi applications only
require an exposure time of afew seconds, which can be quickly adjusted using
Manual Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual
Expose button. In UV or White image mode, Manual Expose is automatically
activated after Auto Expose is complete.

Manual Expose active;

Step lll. Acquire Image |__—button appears selected

) ) . Auto t anual "EEWE
Exposure Time field active; @ 0— f
adjust number of seconds Expose Eipose Acquire

Esposure Time [sec]———————————

®E ¢ 3
(n ] Freeze ‘

Fig.B-5. Setting a manual exposure.

With Manual Expose activated, you can adjust the exposure time directly by changing
the number of secondsin the Exposure Time field. Typein anumber or use the arrow
buttons next to the field.

In UV or White image mode, when the specified exposure time is reached, the last
captured image will be displayed in the ChemiDoc image window. The camera will
continue to integrate the image on the CCD, updating the display whenever the
specified number of seconds is reached.
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Once you are satisfied with the quality of the displayed image, click on the Freeze
button to stop the exposure process. The last full exposure will be displayed in the
image window.

~Step . Acguire Image
Auto M anual
0 Expoze 'a Expoze

’—E:-:pusure Time [zec)

T ] 4]

> ‘ @ Freeze

0 Live
Acauire

Click on Freeze to stop
the exposure process
\

Fig.B-6. Freezing the manual exposure.

In Chemi mode, Manual Expose will expose an image over the specified exposure
time and then stop automatically.

Note:  Freezeisautomatically activated if you adjust any of the subsequent controls
(e.g., Video Print, Image Mode, Display controals, etc.).

Live Acquire

Live Acquire mode allows you to specify an interval over which a series of
progressively longer exposures are taken. All exposures are then displayed on the
screen, and you can choose the one with the best image.

Click on the Live Acquire button. A settings dialog box will open in which you can
specify the total exposure time, starting exposure time, and number of exposures.
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Chemi Doc Live Acquire
~Live Acquire Settings

Total Exposure Time [sec] |10.00

Starting Expozure Time [sec] |5 00

Mumber of Exposures 5

[15ave Images

Cancel| OK

Fig.B-7. Live Acquire settings.

Note:  You should specify no more than 10 exposuresin the Live Acquire Settings
dialog, to avoid excessive build-up of image background in later exposures. The
fewer the exposures, the less background will be added to the image. See the
Release Notes for additional instructions on reducing background in images
captured using Live Acquire.

Select the Save Images checkbox if you want to automatically save each exposure as
it istaken.

Click on OK in the settings dialog to begin taking exposures. If you selected Save
Images, a Save dialog box will open in which you can specify the base file name and
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the
starting exposure time and total exposure time. When each exposure is complete, an
image window containing that exposure will open behind the ChemiDoc window.
When the full exposure time has lapsed, all the image windows will movein front of
the ChemiDoc window.

Note that the first exposure will have the base file name (the default base file nameis
the computer user name and a time stamp). Each subsequent exposure will have a
version number (v2, v3, v4, etc.) appended to the base file name. The highest version
number will be the final exposure. If you did not elect to auto-save the exposures as
they were created, then each image will be unsaved.
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To stop the Live Acquire, click on the Freeze button or adjust any of the subsequent
controls (e.g., Video Print, Image Mode, Display controls, etc.).

Note:  Exposures captured before freezing will be displayed in image windows.

Study the different images and select the best exposure(s) to keep. You can then
proceed to the next step.

B.5 Step IV. Optimize Display

The Display controls are useful for quickly adjusting the appearance of your image
for output to avideo printer. Adjusting these controls will automatically freeze the
video display and allow you to alter the image within the ChemiDoc window.

~Step W, Optimize Digplay—————————————
High [zs5 ————|f
Law ID— J—
G amrma W |—J7

[%]Highlight Saturated Fixels
[ Irwert Display

Auto-zcale | Reset |

Fig.B-8. Display controls.
These controls are similar to those in the Transform dialog box.
Note:  The Display controlswill only change the appearance of the image. They will not
change the underlying data.
High/Low Sliders

If Auto-scale doesn't give you the appearance you want, you can use the High and
Low dliders to redraw the image yourself. In white light mode and chemi mode,
dragging the High slider handle to the left will make weak signals appear darker. In
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UV mode, dragging the High slider handle to the left will make weak signals appear
brighter. Dragging the Low dslider handle to the right will reduce background noise.
You can also type specific High and Low values in the text boxes next to the sliders.
Clicking anywhere on the slider bars will move the sliders incrementally.
Gamma Slider

Some images may be more effectively visualized if their data are mapped to the
computer screen in anonlinear fashion. Adjusting the Gamma slider handle changes
thelight and dark contrast nonlinearly.

Highlight Saturated Pixels
When thisbox is checked, any saturated pixelsin theimagewill appear highlighted in

red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

Invert Display

This checkbox will switch light spots on a dark background to dark spotson alight
background, and visaversa. Thiswill only affect how the image is displayed on the
screen, not the actual image data.

Auto-scale

Clicking on Auto-scale will adjust your displayed image automatically. The lightest
part of the image will be set to the minimum intensity (e.g., white), and the darkest
will be set to the maximum intensity (e.g., black). You can then “fine tune” the
display using the High, Low, and Gamma sliders described bel ow.

Reset

Reset will return the image to its original, unmodified appearance.
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B.6 Step V. Analysis

The Analysis step of the ChemiDoc acquisition window allows you to add
annotations and analyze the newly acquired image.

Annotate

Clicking on Annotate will open a separate image window displaying the captured
image. The default name for the image will include the date, time, and user (if

known).
The Text Overlay toolbar will also pop up to allow you to annotate your image.

The image will not be saved until you select Save or Save As from the File menu.

Analyze

Clicking on Analyze will open a separate image window displaying the captured
image. The default name for the image will include the date, time, and user (if
known).

You can then analyze the image using the other features in the main application.

The image will not be saved until you select Save or Save As from the File menu.

B.7 Step VI. Select Output

The ChemiDoc window has several output options.

Step V. Select Output

= Yiden Print

Save

Fig.B-9. Output options.
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Video Print

Clicking on Video Print will automatically send the currently displayed frame (either
live or integrated) to avideo printer. You can add information about your image to the
bottom of the printout by selecting the appropriate checkboxes in the Options dialog

box. (See section B.9, Options.)

Save

Clicking on Save will open a separate image window displaying the captured image.
A Save Asdialog box will automatically open displaying the default file name for the
image, which will include the date, time, and user (if known). You can then change
the file name and storage directory.

You can also export your image as a TIFF image for viewing with other applications.

B.8 Exposure Status

The Exposure Status bar shows the progress of your exposure. If your exposure time
isgreater than 1 second, the status bar display will give you agraphical representation
of the remaining time before exposure is complete.

If the exposure timeislessthan 1 second, the status bar will not refresh itself for each
exposure; it will remain at 100 percent.

B.9 Options

Click on the Options button to open the Options dialog box. Here you can specify
certain settings for your ChemiDoc system.
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Gel Doc Options

~DAC Settings
Min |so |—J7
Max (130 1 J'

rImaging &rea [cm]

whidth: |20_DD Height: |15_DD

At Exposure Threshaold
% Saturated Pixels:  |o0.15

~ Reminder
[*] Shaw Light YW arming
{ "% Show Filker 'Warning

~Wideo Frinting Foater Information
[®] File: Narme: [®] DatedTinme:
[®]Exposure Time  [%]Contrast Settings

rSave Options
[IMake Backup Copy

rMizc Options
[15imple Acquisition Mode

Defaclts | Cancel | ar. |

Fig.B-10. Available options in the ChemiDoc acquisition window.

Click on OK to implement any changes you make in this box. Clicking on Defaults
restores the settings to the factory defaults.

DAC Settings

Note:  The default DAC settings are highly recommended and should be changed with
caution.
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These diders may be used to adjust the minimum and maximum voltage settings of
your video capture board. The minimum slider definesthe pixel value that will appear
as white in the image, while the maximum slider defines the pixel value that will
appear as black. The slider scaleis 0-255, with the defaults set to 60 minimum and
130 maximum.

Imaging Area

Thesefields are used to specify the size of your imaging areain centimeters, whichin
turns determines the size of the pixelsin your image (i.e., resolution). When you
adjust one imaging area dimension, the other dimension will change to maintain the
aspect ratio of the cameralens.

Note:  Your imaging area settings must be correct if you want to do 1:1 printing. These
are also important if you are comparing the size of objects (e.g., using the
Volume Tools) between images.

Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage
of saturated pixels you want in your image. Thisfield allows you to specify that
percentage.

Typicaly, you will want less than 1 percent of the pixelsin your image saturated.
Consequently, the default value for thisfield is 0.15 percent.

Reminder

When this checkbox is selected, the software will warn you to turn off your
transilluminator light when you exit the ChemiDoc acquisition window or when your
systemis“idle” for more than 5 minutes.

Note:  If you are performing experiments that are longer than 5 minutes (e.g.,
chemiluminescence), this should be desel ected.
Video Printing Footer Information

The checkboxes in this group allow you to specify the information that will appear at
the bottom of your video printer printouts.
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Save Options

To automatically create a backup copy of any scan you create, select the Make
Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup files will have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

Simple Acquisition Mode

The Simple Acquisition mode option allows you to reconfigure the ChemiDoc
acquisition window to simple mode. In simple mode, the acquisition window contains
the same steps as the advanced acquisition window with the exception of Step 1V,

Optimize display, and Step V, Analysis. Manual exposureis also disabled in simple
mode.

£ Chemi Doc | ]

Step |. Position Gel

@ Live/Focus

IRIS Z00M FOCUS
+ Dpen| 4+ Tele ‘ 4 Near |
L Cluse| &+ Wwide ‘ ¥ Far |

Step Il Image Mode
" el white ™ Chemi

Step IIl. Acquire Image

o Auto
Expoze

{(n ] Freeze

~Step ¥, Select Output

¥video Print Save
Options... @Helu

Fig.B-11. Simple Acquisition Window
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To change the acquisition window to Simple Acquisition Mode, check the box
marked Simple Acquisition Mode. The change will take effect the next time you open
the acquistion window.
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Fig.C-1. ChemiDoc XRS.

Before you can begin acquiring images, the ChemiDoc X RS system must be properly
installed and connected with the host computer. See the ChemiDoc XRS hardware
manual for installation, startup, and operating instructions.
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To use the ChemiDoc XRS, you will need to have the Bio-Rad-supplied acquisition
board installed in your PC or Macintosh. The drivers for this board will be installed
when you install the main software application.

Make sure that your ChemiDoc XRS camerais turned on. If the camerais not turned
on, the ChemiDoc XRS acquisition window will not open.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simulation mode.”
In this mode, an acquisition window will open and the controls will appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. Thetitle of the acquisition window will indicate that it is
simulated.

C.1 ChemiDoc XRS Acquisition Window

To acquire images using the ChemiDoc XRS, go to the File menu and select
ChemiDoc XRS.... The acquisition window for the instrument will open, displaying a
control panel and a video display window.
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Appendix C. ChemiDoc XRS
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Fig.C-2. ChemiDoc XRS acquisition window

When the ChemiDoc XRS window first opens, no image will be displayed.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are three basic steps to acquiring an image using the

ChemiDoc XRS:

1. Select the application.

2. Position and focus the gel or other object to be imaged.

3. Acquire theimage.
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C.2 Step |. Select Application

To set the appropriate parameters for the type of object you are imaging, click on the
Select button under Select Application. You have the option of selecting aUV, White,
or Chemiluminescence application. You can also select a custom setting. Once you
select an application, the name of the application and its settings appear in the Select
application step.

C.2.a. Custom Applications

The Bio-Rad installed applications have pre-set gain and bin settings. If the settings
for the available applications do not meet your needs, you have the option of creating
a custom application, which allows you to set your own gain and binning settings.

To use a custom application, click Select and choose custom. Next, select a custom
application from the list, or select Create to create a new application. This opensthe
custom dialog.

£ Create a new ChemiDoc R |
Marme: |Cust.0m Application &
Hlurinatior. . |Nnne j
Gain & Binning... |2x, 1x1 j

Cancel| 0K

Fig.3-3. Creating a custom ChemiDoc XRS application.

Enter a name for the application. From the Illumination drop down list, select an
illumination mode. You can select UV, white or no illumination. Next select gain and
binning settings from the drop down list.

A higher Binning setting (2x2, 3x3) provides optimal sensitivity for low-light
applications such as chemiluminescence. In this mode, the pixelsin the cameraare
“binned” (e.g., four pixelsare combined into one) to increase the amount of signal per
pixel without increasing noise. Note that combining the pixelsresultsin areductionin
the resolution of the image.

C-4



Appendix C. ChemiDoc XRS

Selecting a higher Gain setting (2x) provides higher sensitivity without reduced
resolution; however, noise will also increase. Thisis useful for faint signals (bright
spots will saturate).

Click OK to save and add the new custom application to the custom list. The new
application is automatically selected as your application.

C.3 Step Il. Position Gel

Click the Live/Focus button, and frames will be captured and displayed at about 10
frames per second, depending on the speed of your computer.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while
positioning the sample within the area.

Note:  ChemiDoc XRS features a motorized zoom lens that can be controlled directly
from the acquisition window using the Iris, Zoom, and Focus arrow buttons.
Click on the Up/Down buttons while viewing your sample in the window to
adjust the lens.

~Step |. Position Gel

‘ @ Live/Focus

IRIS 200 FOCUS

+* Dpen| 4+ Tel= | 4+ Mear |

L Elnse| ¥ "wide | ¥ Far |
] Show &lignment Grid

Fig.C-4. Live/Focus button and camera control buttons.

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note:  After positioning your sample, you should check the Imaging Area dimensions
under Options (see C.5, Options) to make sure that they conform to the size of
the areayou are focusing on. To determine the size of the areayou are focusing
on, you can place aruler in the ChemiDoc XRS hood so that it isvisible in the
image.
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C.4 Step lll. Acquire Image

The ChemiDoc XRS control panel has severa features for creating image exposures.
You can take an automatic exposure based on the number of saturated pixelsin the
image, you can enter a specific exposure time, or you can take a series of exposures
and select the best one.

Note:  “Exposure” refers to the integration of the image on the camera CCD over a
period of time. The effect is analogous to exposing photographic film to light
over aperiod of time.

Auto Expose

Use Auto Expose if you want to take a single exposure but are uncertain of the
optimal exposure time.

Note:  If you know the approximate exposure time you want (+ 3 seconds), you can skip
this step and go directly to Manual Expose.

Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, the image is continuously integrated on the camera CCD
until it reaches a certain percentage of saturated pixels. This percentage is set in the
Options dialog box. (Default = 0.75 percent. See C.5, Options.)

~5Step Il Acguire Image

Click on Auto Expose; Auto b arwal
button appears selected Expose @ Expose

A

Live
o.-’-‘-.u:quire

~Expozure Time [zec)
Can see Exposure Time %

automatically changing »(0.0z ||

@ Freeze |

Fig.C-5. Selecting Auto Expose.
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Once an image has reached the specified percentage of saturated pixels, it is captured
and displayed in the video display window, Auto Exposeisautomatically deactivated,
and the exposure time appears active in the Exposure Time field.

Note:  If you are having difficulty auto-exposing your sample, you can use Manual
Expose to adjust your exposure time directly. Most non-chemiluminescent
applications only require an exposure time of afew seconds, which can be
quickly adjusted using Manual Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual
Expose button. Manual Expose is automatically activated after Auto Exposeis
complete.

Manual Expose active;

Step lll. Acquire Image |__—button appears selected

) ) . Auto t anual "EEWE
Exposure Time field active; @ 0— f
adjust number of seconds Expose Eipose Acquire
\ Esposure Time [sec]———————————

®E ¢ 3
(n ] Freeze ‘

Fig.C-6. Setting a manual exposure.

With Manual Expose activated, you can adjust the exposure time directly by changing
the number of secondsin the Exposure Time field. Typein anumber or use the arrow
buttons next to the field.

When the specified exposure timeis reached, the last captured image will be
displayed in the ChemiDoc XRS image window.

C-7



Quantity One User Guide

~Step . Acguire Image
Auto bl arual
o Expoze @ Expoze

"E:-cpaswe Time [zec)

T el

T ‘ (] Freeze

o Live
Acquire

Click on Freeze to stop
the exposure process
\

Fig.C-7. Freezing the manual exposure.

Live Acquire

Live Acquire mode allows you to specify an interval over which a series of
progressively longer exposures are taken. All exposures are then displayed on the
screen, and you can choose the one with the best image.

Click on the Live Acquire button. A settings dialog box will open in which you can
specify the total exposure time, starting exposure time, and number of exposures.

£ Optimize Exposure x|

~Settings

Total Exposure Time [zec.]  |1o.0

Starting Exposure Time [zec.] |1.0
Mumber of Exposures

[5ave Images

Cancel| OF

Fig.C-8. Live Acquire settings.

Note:  You should specify no more than 10 exposuresin the Live Acquire Settings
dialog, to avoid excessive build-up of image background in later exposures. The
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fewer the exposures, the less background will be added to the image. See the
Release Notes for additional instructions on reducing background in images
captured using Live Acquire.

Select the Save Images checkbox if you want to automatically save each exposure as
it istaken.

Click on OK in the settings dialog to begin taking exposures. If you selected Save
Images, a Save dialog box will open in which you can specify the base file name and
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the
starting exposure time and total exposure time. When each exposure is complete, an
image window containing that exposure will open in front of the ChemiDoc XRS
window.

Note that the first exposure will have the base file name (the default base file nameis
the computer user name and a time stamp). Each subsequent exposure will have a
version number (v2, v3, v4, etc.) appended to the base file name. The highest version
number will be the final exposure. If you did not elect to auto-save the exposures as
they were created, then each image will be unsaved.

To stop the Live Acquire, click on the Freeze button.
Note:  Exposures captured before freezing will be displayed in image windows.

Study the different images and select the best exposure(s) to keep.

C.4.a. Exposure Status

The Exposure Status bar shows the progress of your exposure. If your exposure time
isgreater than 1 second, the status bar display will give you agraphical representation
of the remaining time before exposure is complete.

lllumination Flat Fielding

For UV or white light transilluminatoin applications, you should use the appropriate
reference plate to ensure a uniform intensity in the image. Thiswill compensate for
normal variations in image pixel intensity that occur with atransilluminating light
source.
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To enable this feature, select the Flat Fielding checkbox.

UV lllumination Flat Fielding: When you first select the Flat fielding checkbox, and
then acquire an image using the UV transilluminator, you will be prompted to remove
your sample and place the fluorescent reference plate on the ChemiDoc XRS sample
stage and turn on the UV transilluminator (see the ChemiDoc XRS User Manual).

= Quantity One x|

A lllumination Flat Fielding

Remove your sample from the ChemiDoc XRS

Continug | > Eancel|

Fig.C-9. lllumination flat fielding reminder

A reference image of the plate will be acquired and saved on your computer hard
drive. The reference image will be applied to the sampleimage to generate aflat field
corrected exposure.

White Light Illumination Flat Fielding: When you first select the checkbox, and then
acquire an image using the white light conversion screen or the white light
transilluminator, you will be prompted to remove your sample, turn on the white light
source, and collect an exposure of the white light screen/transilluminator (see the
ChemiDoc XRS User Manual). A reference image of the screen/transilluminator will
be acquired and saved on your computer hard drive. The reference image will be
applied to the sample image to generate aflat field corrected exposure.

For subsequent UV or white light trans exposures, you will be prompted to either use
the appropriate saved flat field image or acquire a new one.
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£ Quantity Dne i x|

& lllumination Flat Fielding

Do you weant to use the saved reference image for mage Optimization’?

JYES"}(_ ND|

Fig.C-10. Using the saved reference image.

Note:  Flat fielding is unavailable for White EPI illumination and chemiluminescence
applications.

C.5 Options

Click on the Options button to open the Options dia og box. Here you can specify
certain settings for your ChemiDoc XRS system.
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& ChemiDoc XRS5 Options ) ﬂ
rInfamnation———————————  Dark Subtraction
Model ChemiDoc XES {+ Referenced ¢ None
Camera Senal Mumber: Feset Referenced
BR-SIML
rSave
rImaging Ares [EM]————— | [JAuto Save After Scan

Width: 13.00 "t Make Backup Copy
Height; 10.30

~Reminder [#] Auto-scale Transtorm After Acquisition

[¥] 5how Light Warming

~Digplay

~Awto Expozure Thieghold

Show Filter W arniry
e d % Saturated Piwels: |0, a0

Cancel| 0OK

Fig.C-11. Available options in the ChemiDoc XRS acquisition window.

Click on OK to implement any changes you make in this box.

C.5.a. Imaging Area

Thesefields are used to specify the size of your imaging areain centimeters, whichin
turn determines the size of the pixelsin your image (i.e., resolution). When you adjust
one imaging area dimension, the other dimension will change to maintain the aspect
ratio of the cameralens.

Note:  Your imaging area settings must be correct if you want to do 1:1 printing. These
are also important if you are comparing the size of objects (e.g., using the
Volume Tools) between images.

C.5.b. Reminder

Show Light Warning - When this checkbox is selected, the software will warn you
to turn off your transilluminator light when you exit the ChemiDoc XRS acquisition
window or when your system is“idle” for more than 5 minutes.
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Note:  If you are performing experiments that are longer than 5 minutes (e.g.,
chemiluminescence), this should be desel ected.

Show Filter War ning - When this checkbox is selected, the software will warn you
to move thefilter dider either to chemi or the UV/White position.

C.5.c. Dark Subtraction

At thetime of installation areference dark image file was generated and saved to your
hard drive. The purpose of thisfileisto reduce dark current noise generated from the
CCD. Dark current noiseistypica of all CCDsand isaresult of the accumulation of
charge in the absence of light

The default time of the reference dark image isten minutes. The default referencefile
is optimized for ChemiDoc XRS applications. |f you select to change the reference
dark image, ensure that the time of the reference dark image is of equal or greater
duration than your typical sampleimage. When the sample image timeislonger than
the reference dark image time the ability to detect very faint samples may be
compromised.

To reset the reference dark image time, select options in the ChemiDoc XRS
acquisition window. Select Reset Referenced.

£ Quantity One =l

Reset Reference Datk Image

Drark Exposure Time [zec.] |6EIEI .0

Cancel| OK

’—Dptinns

Fig.C-12. Reset Reference Dark pop-up box

Enter the desired time in seconds. Select OK. You will be prompted to close and re-
open the acquisition window. Place the lens cap on the camera and close the door of
the hood (See ChemiDoc XRS instruction manual). Select OK at the prompt and new
reference dark images of the entered time interval will be taken for each of the five
possible combinations of camera gain and bin settings. These will be retained as the
reference dark images until the timeis reset again.
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C.5.d. Save Options

To automatically create a backup copy of any scan you create, select the Make
Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup files will have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

C.5.e. Auto-scale Transform

Auto-scale Transform after Acquisition allows the user the option of having theimage
automatically perform the Auto-Scale transform function upon completion of image
acquisition. This eliminates the need to transform when the acquisition time was too
short or the iris not opened enough.

To enable the auto-scal e transform function, check the box labeled, Auto-Scale
Transform after Acquisition in the Options dial og.

C.5.f. Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage
of saturated pixels you want in your image. Thisfield allows you to specify that
percentage.

Typically, you will want less than 1 percent of the pixelsin your image saturated.
Consequently, the default value for thisfield is 0.75 percent.

C.6 Other Features

[#] Highlight 5 aturated Pisels

Image file size: z.s0 Mb Dptionz [ Help

’—Displa}l Optiohz

Fig.C-13. Other ChemiDoc XRS acquisition window features.
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Highlight Saturated Pixels

When this box is checked, any saturated pixelsin theimage will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

File Size of Images

Image File Size shows the size of the image file you are about to create. Thissizeis
determined by the bin setting used for the selected application.

If you do not have enough computer memory for the specified file size, an error
message will appear when you attempt to acquire an image. (Macintosh users can
increase the application memory partition. See your Macintosh computer
documentation for guidance.)
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Appendix D
GS-700 Imaging Densitometer

Fig. D-1. GS-700 Imaging Densitometer

Before you can begin scanning images with the GS-700 I maging Densitometer®, your
instrument must be properly installed and connected with the host computer. See the
hardware manual for installation, startup, and operating instructions.

PC Only: A Note About SCSI Cards

The GS-700 is connected to your computer by a Small Computer System Interface
(SCSl) cable. To use the GS-700, you must have a SCSI card installed in your PC. If
you have a PC with a Windows 98 or Windows ME operating system, you may also
need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simul ation mode.”
In this mode, an acquisition window will open and the controls will appear active, but
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instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. The title of the acquisition window will indicate that it is
simulated.

Note:  Thereisno simulated calibration for the GS-700 and GS-710 Imaging
Densitometers.

D.1 GS-700 Acquisition Window

To acquire images using the GS-700, go to the File menu and select GS-700.... The
acquisition window for the densitometer will open, displaying a control panel and a
scanning window.
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= Densitometer: G5-700: Uncalibrated Transparency
~Step | - Select Application %
Select...
H-ray film 3
Gray film
a-
Fiter [JRed [®]Green [JBlue [Jwhite
Light ™ Reflective  (+ Transmissive 7- — 1
| )
1 1
~Step |l - Select Scan Area 9- : :
I I
Preview scan... . .
Click and drag in diagram to set scan area. 11- ; ’
I I
Top: |’?.3 Left: ‘5.8 i '
I I
Bottom: |16.4 Right; ‘16.5 s \ |
i i
I I
13- 1 L
~Step Il - Select Resolution 3 3
Hresolution (34.7  Microns TTTTTTCTTTrTTTCTTTrTC1r
Select... 17-
f resolution |24.7  Microns _
L 18-
Image file size: 2. 59 kb
21-
QAcquirel & Slop
23-
Option:
[*]&uta Save After Scan []Hide Grid 25
. L 1
Wl Brhem ey 1 3 5 7 ] 11 1315 17 19
[C1Highlight 5 aturated Pixels
Options... @ Help

Fig. D-2. GS-700 acquisition window.

The scanning window is marked by grid lines that divide the areainto square
centimeters. These are numbered 1-35 top to bottom and 1-21 left to right if the light
source is uncalibrated reflective, and 1-25 top to bottom and 1-20 Ieft to right if the
light sourceis uncalibrated transmissive (see below for details).

To hide the gridlines, click on the Hide Grid checkbox under Options.
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The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are four basic steps to scanning an image using the GS-
700:

1. Select the application.

2. Select the scan area.

3. Select the resolution of the scan.
4

Acquire the image.

D.2 Step I. Select Application

To set the parameters for your particular scan, you can;
1. Select from alist of possible applications, or

2. Choose your own filter and light source settings.

Selecting from the List of Applications

When you select from the list of applications, the software automatically sets the
appropriate filter(s) and other parameters for that particular application.

To select from the list of applications, click on the Select button under Select
Application.

Heray film
Gel
Fhotograph

Coomassie blue
Silver stain

Copper stain
Zinc stain

Blot 5
Stain all

HREP-Substrat

Fig. D-3. Example of the application tree in the GS-700 dialog box.
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The applications are listed in atree that expands from left to right. First you select the
category of your application, then you select your particular application.

To exit the tree without selecting, press the Esc key.

X-ray film 4|£

Gel

Photograph ——

Blot

Gray file
Blue film
Linear

Coomassie Blue
Silver stain
Copper stain
Zinc stain

Stain all

Positive (dark bands, light background)

Negative (light bands, dark background)

Coomassie stain
Colloidal gold stain
Amido black stain
AP-Substrate (BCIP/NBT)
HRP-Substrate (4CN)
HRP-Substrate (DAB)

Fig. D-4. Applications available in the GS-700 acquisition window.

Choosing Your Own Settings

If you know the filter and light source settings you want, or want to experiment with
different settings, you can choose them yourself.

Filter []Red
Light ™ Reflective

[%]Green []Blue

[Jwhite

{+* Transmizsive

Fig. D-5. GS-700 Custom Application controls.
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Next to Filter, click on either the Red, Green, Blue, or White checkbox, or a
combination of two of the first three (Red-Green, Green-Blue, Red-Blue).

Filter Color Wavelength Application Examples
Red 595-750 nm Coomassie G-250, BCIP/NBT, Fast
Green FCF, Methylene Blue
Green 520-570 nm Coomassie R-250, Basic Fuchsin
Blue 400-530 nm Crocein Scarlet
Gray Scale 400-750 nm Silver Stains, Copper Stains, Film

Fig. D-6. Examples of filter colors and applications.

Next to Light, select the appropriate light source.

» Reflective mode is for scanning opaque mediums such as dried gels on filter
paper, arrays, TLC plates, and photographs. The scanning dimensionsin this
mode are 21 cm x 35 cm (uncalibrated).

e Transmissive modeisfor scanning transparent mediums such as films, gels, and
dides. The scanning dimensions in this mode are 20 cm x 25 cm (uncalibrated).

D.3 Step Il. Select Scan Area

Preview Scan

Before selecting the particular area to scan, you can preview the entire scanning area
to determine the exact position of your sample.

Click on Preview Scan. A quick, low-resolution scan of the entire scanning areawill
appear in the scanning window. Your sample should be visible within a portion of this
scan.
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Selecting an Area

Using the preview scan as a guide, select your scan area by dragging your mouse
within the scanning window. The border of the scan areayou are selecting will be
marked by aframe.

Note:  The scan areayou select must be at least 1 cm wide.

When you rel ease the mouse button, the border changes to a dashed blue line,
indicating a selected area.

«  Toreposition the scanning area box you have created, position your cursor inside
the box and drag. The entire box will move.

»  Toresize the box, position your cursor on abox side and drag. The side you have
selected will move.

e To redo the box entirely, position youk cursor outside the box and drag. The old
box will disappear and a new box will be created.

You can also select the scanning area by entering coordinatesin the appropriate fields
(Top, Bottom, Left, Right). Asyou enter a coordinate, the position of the scanning
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with
borders. You can always crop the image later.

D.4 Step lll. Select Resolution

To select from alist of possible scanner resolutions, click on the Select button under
Select Resolution. This will open the Select Scan Resolution dialog box.
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£ Quantity One

A Selact Scan Resolution

(423w 21.2  Highest. For small gels with ting features.

D
(423 w 423 High. For small gels with tiny features.

(B35 « B35 Medium high. For gels with small features. o]
(B35 » 423 Asymmetric medium high. For gels with ting bands.
(847 » 847 Medium. For most gels. M

(T B4T w 423 Asymmetric medium. For most gels with bands.

T 105.8 = 105.8 Medium low. For gels with large features.
(1058 » 423 Asymmetric medium low. For gels with large bands.
(™ 169.3 » 169.3 Low. For gels with very large features.

(1633 % B35 Asymmetric low. For gels with very wide bands.

Fig. D-7. Select Scan Resolution dialog box.

Available resolutions are listed from highest to lowest in terms of the dimensions of
the resulting pixels (in microns). Smaller pixels equal higher resolution. Each
resolution islisted with its typical use.

In general, the size of your pixels should be one-tenth the height of your smallest
object.

Some of the resolutions are asymmetrical, meaning that the resolution is higher in the
vertical dimension (i.e., the pixelsin the resulting image are larger in the horizontal
dimension than in the vertical dimension). Thisis useful for gels with bands, where
you are moreinterested in resolving in the y dimension to determine the size of bands
and the spacing between them.

Specifying Your Own Resolution

If you select Oversample under More Options (see section D.7, Other Options, for
details), you can specify your own resolution within the range of 43-169 microns
(micrometers). With Oversample selected, enter values directly in the fields next to X
resolution and Y resolution in the main acquisition window.
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Step Il - Select Resolution

# rezolution |50.0 Microns
Select...
7 resolution |50, 0] | Micons

Image file zize: 0. 10 b

Fig. D-8. Entering a custom resolution (with Oversample selected).

Image File Size

Image File Size (under Select Resolution) shows the size of the scan file you are
about to create. If you do not have enough computer memory for the specified file
size, an error message will appear when you attempt to scan. If this happens, select a
lower resolution or decrease the size of the area to be scanned. (Macintosh users can
also increase the application memory partition. See your Macintosh computer
documentation for guidance.)

D.5 Acquire the Image

If you want to calibrate your scans, read the following section on calibration before
scanning.

To begin to scan, click on the Acquire button. The scanned image will begin to appear
in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the
interrupt, and then you will be asked if you want to keep the partial scan. This feature
isuseful if you overestimated the size of the area you selected.

After the scan is complete, awindow will open displaying the scan image, at which
point you can analyze and save it.

Note:  Theimage will open with adefault file name that includes the date, time, and (if
applicable) user name. However, unless you have selected Auto Save After Scan,
the file will not be saved until you select Save or Save As from the File menu.
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D.6 Calibration

If you have installed a calibration overlay, you can automatically calibrate your
transmissive and reflective scans. (Calibration overlaysfor the GS-700 can be ordered
from Bio-Rad.)

To set the automatic calibration settings, click on the More Options button in the GS-
700 acquisition window. Thiswill open the Densitometer Options dialog box.

Densitometer Options

- Calibration

[¥] Calibration On On the GS-700 this requires that the calibration overlay
be installed.

[C]Calibrate Before Every Scan

Recalibration ’— The Densitometer will be re-calibrated
Inkeral [minutes) z after thig time hag expired.

S A calibration report will be printed each time the
L[t Densitometer is calibrated.

Calibrate Mow | Edit Step Tablet

~Data Handling
The Densitometer will be told to scan at its maximum resolution
and spatial averaging will be used to produce the desired resolution.
[ (0 =mmee Thiz gives better spatial fidelity and lawer noize, although it takes

lorger to scan.

A modified logarithmic zcaling system will be used ta reduce
[15ave Scaled Data  the size of the data by B0%. It introduces a constant relative
error of less than 3%,

QK | Cancel | Help |

Fig. D-9. More Options in the GS-700 acquisition window.

To enable automatic calibration, click on the Calibration On checkbox.

Note:  Before you can calibrate, you must enter the correct step tablet values for your
transmissive calibration strip into the Step Tablet Values form, as described
below. You do not need to change the values in the reflective step tablet form;
you can use the default values.

With Calibration On selected, the other calibration settings become active.
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Calibration Strip Window

When calibration is turned on, a calibration strip window will appear below the main
scanning window and the length of the main scanning window will be reduced to 29
cm reflective and 23 cm transmissive.

Every time the densitometer calibrates, an image of the calibration strip will appear in
the calibration strip window.

D.6.a Editing the Step Tablet

Before you can calibrate, you must enter the step tablet values for your transmissive
calibration strip into the Step Tablet Values form.

In the package with your calibration strip, you will find a printout of the diffuse
density values for each segment of your transmissive calibration strip. Those exact
density values must be entered into the computer for the software to associate a
correct density value with each step on the step tablet.

Note:  Scanning in transmissive mode with incorrect step tablet values entered into the
form can cause significant errorsin the reported densities of your scans.

To enter the density values for your step tablet, click on the Edit Step Tablet buttonin
the Densitometer Options box. The Step Tablet Values dialog box for the GS-700 will
open.
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Step Tablet Yalues for G5-700 Transmissive

Step
1.

o
- =2

Tablet serial number IW
Quantity Offset ’T ﬂ
Diffuse Specular Step Diffuse Specular
[0.06 [0-07 12 [1.72 [z-43
[0.20 [o.28 13 [1.88 [z 65
[0-36 [o-52 14 [z.03 [z-57
0. 52 [0-72 15, [z.18 [2-0s
[0.66 EEE 16 [z.34 [3.31
[0-81 [1-25 17 [2.49 [2-52
[0.96 [1-35 18 [2.54 [2-72
[1.11 [1.57 13 [z.80 EED
[1.27 [1-20 20 [2.54 [¢-15
[1-41 [1-22 2. [a.08 [4-35
1.5¢6 z.z1
0K | Cancel | Help |

Wwom o~ MmO e )

Fig. D-10. Step Tablet dialog box.

The dialog box will indicate whether the displayed form is for the transmissive or
reflective step tablet, depending on whether you are in transmissive or reflective

mode.

Note:  In transmissive scanning, the scanner is calibrated against a transmissive step
tablet. In reflective scanning, the scanner is calibrated against a reflective step
tablet, unless the reflective calibration strip is uncalibrated. If the reflective
calibration strip does not have step tablet values associated with it, you can use
the default valuesin the form.

Inthe Tablet Serial Number field, you can type in the serial number for the step tabl et
values you are entering. (The reflective step tablet will probably not have a serial

number.)

Your calibration strip will have a clear plastic cover. If the quantity offset value for
the clear cover isincluded in your calibration strip package, you can enter this
number in the Quantity Offset field. Otherwise, use a value of 0.045.
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Finally, enter the values in the appropriate fields under the Diffuse column. After the
step tablet is scanned, the software will associate each density value with its
corresponding segment on the step tablet.

The step tablet density values do not need to be entered each time you calibrate. Once
they have been entered and saved, they will be automatically recalled when the
calibration strip is scanned. You only need to enter new valuesif you use a new step
tablet.

When you finished filling out the Step Tablet Values form, click on OK.

Diffuse Versus Specular O.D.

In the step tablet form, you enter O.D. as diffuse density, and then the software
automatically calculates the specular density.

Specular density is a measure of the light that passes directly through a medium.
Diffuse density includes light that is scattered as it passes through the medium. Step
tablet values are given in diffuse density, but are measured by the scanner in specular
density, and therefore must be converted according to the specular/diffuse O.D. ratio.
This conversion does not affect quantitation.

| -¢— Specular Light (passes directly through medium)

~¢— Medium (gel, film, etc.)

/ \ -— Diffuse Light (is scattered by medium)

Fig. D-11. Specular and diffuse density

Diffuse density values are converted to specular optical density units according to the
following formula:

Specular OD = 1.4 [Diffuse OD
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D.6.b Calibration Settings

After you have entered the step tablet values, you can immediately calibrate by
clicking on the Calibrate Now button (in the Densitometer Options dialog box).

You can also specify how often you want the densitometer to automatically
recalibrate. Either click on the Calibrate Before Every Scan checkbox or enter a
Recalibration Interval (in minutes) in the appropriate field.

Note:  With calibration turned on, the scanner will automatically recalibrate each time
you change your filter or your reflective/transmissive setting. (If you select a
different application with the same filter and light settings, it will not auto
recalibrate.)

Calibration Report

To print out a calibration report each time the densitometer calibrates, click on the
Calibration Report checkbox.

D.7 Other Options

Oversample

Thisfeature allows you to scan at the maximum resol ution of the GS-700 (42.3 x 42.3
microns) and then use spatial averaging to create an image with lower resolution. This
can result in better images at lower resolution—however, it takes longer to scan.

To turn on oversampling, click on the More Options button in the acquisition window
and click on the Oversample checkbox.

With oversampling on, you can specify your own resolution within the range of 43—
169 microns by entering values directly in the fields next to X resolution and Y
resolution in the main acquisition window.

D-14



Appendix D. GS-700

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan
checkbox.

With this checkbox selected, when you click on Acquire, a Save As dialog box will
open asking you to specify afile name and location for the image you are about to
create. The scan will begin when you click on the Save button.

Make Backup Copy

If you have checked Auto Save After Scan, you can also automatically create a
backup copy of any scan you create.

Click on the Make Backup Copy checkbox. With this checkbox selected, when ascan
is created and saved, a backup copy will be placed in the same directory asthe
scanned image. Windows backup fileswill have an “.sbk” extension. Macintosh
backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.

Highlight Saturated Pixels

When thisbox is checked, any saturated pixelsin theimagewill appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.
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GS-710 Imaging Densitometer

Fig. E-1. GS-710 Imaging Densitometer

Before you can begin scanning imageswith the GS-710 Imaging Densitometer®, your
instrument must be properly installed and connected with the host computer. See the
hardware manual for installation, startup, and operating instructions.

PC Only: A Note About SCSI Cards

The GS-710 is connected to your computer by a Small Computer System Interface
(SCSl) cable. To use the GS-710, you must have a SCSI card installed in your PC. If
you have a PC with a Windows 98 or Windows ME operating system, you may also
need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simul ation mode.”
In this mode, an acquisition window will open and the controlswill appear active, but

E-1



Quantity One User Guide

instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. The title of the acquisition window will indicate that it is
simulated.

Note: Thereisno simulated calibration for the GS-700 and GS-710 Imaging
Densitometers.

E.1 GS-710 Acquisition Window

To acquire images using the GS-710, go to the File menu and select GS-710.... The
acquisition window for the densitometer will open, displaying a control panel and a
scanning window.
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£ Densitometer: G5-710: Transmitted Intensity

rStep | - Select Application

Select...
H-ray film
3-
Cray film
» . g
Fiter [JRed [®]Green [JBlue []'hie
Light ™ Reflective  {+ Transmissive
r

Step Il - Select Scan Area

. E
Preview scan

Click and drag in diagram to set scan area
Top:  |EHE Left |00 =
Bottam: (0.0 Right: |o.0 :

13-
~Step Il - Select Rezolution )
15-
#resolution |g4.7  Microns
Select... ) -
 resolution |g4.7  Microns
17-
Image file size: 0.00 Mb =
19-
Oﬁcquue @ Stop
21-
rOption
[%] Auto Save After Scan [IHide Grid B
MR 1 3 5 7 q 7 13 15 17 19

[ Highlight 5 aturated Fixels

Optione @ Help

Fig. E-2. GS-710 acquisition window

The scanning window is marked by grid lines that divide the areainto square
centimeters. These are numbered 1-29 top to bottom and 1-21 left to right if the light
sourceisreflective, and 1-23 top to bottom and 1-20 left to right if the light sourceis
transmissive (see below).

To hide the gridlines, click on the Hide Grid checkbox under Options.

Below the main scanning window is the calibration strip window. Every time the
densitometer calibrates, an image of the calibration strip will appear in this window.

E-3



Quantity One User Guide

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are five basic steps to scanning an image using the GS-
710:

1. Select the application.

2. Select the scan area.

3. Select the resolution of the scan.
4

Cadlibrate the instrument. (Thisis automatic, after you enter the step tablet values
before you first scan after installation.)

5. Acquire theimage.

E.2 Step I. Select Application

To set the parameters for your particular scan, you can;
1. Select from alist of possible applications, or

2. Choose your own filter and light source settings.

Selecting from the List of Applications

When you select from the list of applications, the software automatically sets the
appropriate filter(s) and other parameters for that particular application.

To select from the list of applications, click on the Select button under Select
Application.
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Heray film
Gel
Photograph
Blot

Coomassie blue
Silver stain

Copper stain

Zinc stain

Blot X
Stain all

HEP-Substrat

Fig. E-3. Example of the application tree in the GS-710 dialog box.

The applications are listed in atree that expands from left to right. First you select the
category of your application, then you select your particular application.

To exit the tree without selecting, press the Esc key.

Gray file
X-ray film 4|£ Blue film

Linear
— Coomassie Blue
I Silver stain
Gel —— | Copper stain

— Zinc stain
L Stain all

— Positive (dark bands, light background)
Photograph ———

L— Negative (light bands, dark background)

Coomassie stain
Colloidal gold stain
Amido black stain

Blot AP-Substrate (BCIP/NBT)
HRP-Substrate (4CN)
HRP-Substrate (DAB)

Fig. E-4. Applications available in the GS-710 acquisition window.
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Choosing Your Own Settings

If you know thefilter and light source settings you want, or want to experiment with
different settings, you can choose them yourself.

Filker [JRed [®]Green [[Blus  []'white
Light ™ Reflective (=" Transmissive

Fig. E-5. GS-710 Custom Application controls.

Next to Filter, click on either the Red, Green, Blue, or White checkbox, or a
combination of two of the first three (Red-Green, Green-Blue, Red-Blue).

Filter Color Wavelength Application Examples
Red 595-750 nm Coomassie G-250, BCIP/NBT, Fast Green
FCF, Methylene Blue
Green 520-570 nm Coomassie R-250, Basic Fuchsin
Blue 400-530 nm Crocein Scarlet
Gray Scale 400-750 nm Silver Stains, Copper Stains, Film

Fig. E-6. Examples of filter colors and applications.

Next to Light, select the appropriate light source.

« Reflective mode is for scanning opaque mediums such as dried gels on filter
paper, arrays, or photographs. The scanning dimensionsin this mode are 21 cm x
29 cm.

e Transmissive modeis for scanning transparent mediums such as films, gels, or
dides. The scanning dimensions in this mode are 20 cm x 23 cm.
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E.3 Step Il. Select Scan Area

Preview Scan

Before selecting the particular area to scan, you can preview the entire scanning area
to determine the exact position of your sample.

Click on Preview Scan. A quick, low-resolution scan of the entire scanning area will
appear in the scanning window. Your sample should be visible within a portion of this
scan.

Selecting an Area

Using the preview scan as a guide, select your scan area by dragging your mouse
within the scanning window. The border of the scan areayou are selecting will be
marked by aframe.

Note:  The scan areayou select must be at least 1 cm wide.

When you rel ease the mouse button, the border changes to a dashed blue line,
indicating a selected area.

«  Toreposition the scanning area box you have created, position your cursor inside
the box and drag. The entire box will move.

* Toresizethe box, position your cursor on abox side and drag. The side you have
selected will move.

e Toredo the box entirely, position your cursor outside the box and drag. The old
box will disappear and a new box will be created.

You can also select the scanning area by entering coordinatesin the appropriate fields
(Top, Bottom, Left, Right). Asyou enter a coordinate, the position of the scanning
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with
borders. You can always crop the image later.
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E.4 Step lll. Select Resolution

To select from alist of possible scanner resolutions, click on the Select button under
Select Resolution. This will open the Select Scan Resolution dialog box.

£ Quantity One

A

Select Scan Resolution

(=423 w 212 Highest. For small gels with ting features.

(423 % 423 High. For small gels with ting features.
(B35 % 625 Medium high. For gels with small features. T
(B35 x 423 Aspmmetnic medium high. For gels with ting bands.

Help

(w847 w 847  Medium. For most gels.

(T B47 x 423 Asymmetric medium. For most gels with bands.
(1058 » 1058 Medium low. For gels with large features.
(1058 & 423 Aspmmetric medium low. For gels with large bands.
(1693 » 1693 Low. For gels with very lange features.

(T 169.3 ® B35 Aspmmetric low. For gels with very wide bands.

Fig. E-7. Select Scan Resolution dialog box.

Available resolutions are listed from highest to lowest in terms of the dimensions of
the resulting pixels (in microns). Smaller pixels equal higher resolution. Each

resolution islisted with itstypical use.

In general, the size of your pixels should be one-tenth the height of your smallest

object.

Some of the resolutions are asymmetrical, meaning that the resolution is higher in the
vertical dimension (i.e., the pixelsin the resulting image are larger in the horizontal
dimension than in the vertical dimension). Thisis useful for gels with bands, where
you are moreinterested in resolving in the y dimension to determine the size of bands

and the spacing between them.
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Specifying Your Own Resolution

If you select Oversample under More Options, you can specify your own resolution
within the range of 43-169 microns (micrometers). With Oversample selected, enter
values directly in the fields next to X resolution and Y resolution in the main
acquisition window.

Step Il - Select Resolution

# rezolution |50, 0 Microng
Select...
' iesolution [so.df  Micrane

Image file zize: 0. 10 kb

Fig. E-8. Entering a custom resolution (with Oversample selected).

Image File Size

Image File Size (under Select Resolution) shows the size of the scan file you are
about to create. If you do not have enough computer memory for the specified file
size, an error message will appear when you attempt to scan. If this happens, select a
lower resolution or decrease the size of the area to be scanned. (Macintosh users can
also increase the application memory partition. See your Macintosh computer
documentation for guidance.)

E.5 Calibration

Images scanned using the GS-710 are automatically calibrated. The scanner plate has
abuilt-in calibration overlay for both transmissive and reflective scanning.

e Thetransmissive calibration strip calibrates the densitometer from 0to 3.0 O.D.
« Thereflective calibration strip calibrates the densitometer to 2.0 O.D.

Thefirst time you use the GS-710, you must select some calibration settingsto ensure
that your calibration is accurate.



Quantity One User Guide

To set the automatic calibration settings, click on the More Options button in the GS-
710 acquisition window. Thiswill open the Densitometer Options dialog box.

Densitometer Options

~Calibration

..... 5 On the GS-700 this requires that the calibration overlay
mEEEme be installed.

[C]Calibrate Before Every Scan

Recalibration The Densitomneter will be re-calibrated
Interval [minutes] |- after thiz time has expired.

P A calibration report will be printed each time the
e Densitometer iz calibrated.

Calibrate Mow | Edit Step Tablet

~Data Handling

The Densitometer will be told ta scan at its maximurn resalution
and spatial averaging will be used to produce the desired rezolution.
(W Dsssipls Thiz gives better spatial fidelity and lower noize, although it takes

longer to scan.

A modified logarithmic scaling system will be used to reduce
ithave Scaled Data  the size of the data by 505 It introduces a constant relative
emor of less than 3%,

Ok, | Cancel | Help |

Fig. E-9. Densitometer Options dialog box.

E.5.a Editing the Step Tablet

Before you scan for the first time, you must enter the step tablet values for your
transmissive calibration strip into the Step Tablet Values form.

Note:  Inreflective scanning, the scanner is calibrated against the reflective step tablet.
However, you do not need to enter the values for this step tablet; you can use the
default values in the Step Tablet Values form.

Attached to the outside of your GS-710, you will find a copy of the manufacturer’s
printout of the diffuse density values for each segment of your transmissive step
tablet, as well as a serial number that identifies the step tablet to which those density
values belong. Those exact density values must be entered into the computer for the
software to associate a correct density value with each step on the step tablet.
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Note:  Scanning in transmissive mode with incorrect step tablet values entered into the
computer can cause significant errorsin the reported densities of your scans.

To enter the density values for your step tablet, click on the Edit Step Tablet buttonin
the Densitometer Options box. The Step Tablet Values dialog box for the GS-710 will
open.

Step Tablet Yalues for G5-710 Transmissive
Tablet serial number [7105T364

14.
20
21

o
- =

Cluantity Offsek ’F ﬂ

Step Diffuse Specular Step Diffuse Specular
| [pos ooz | 12 [pa
2 o0 oz 13 [1es e
3 [ose o Mo g
4 [osz ova | 5[5 s
5 [oec o5 | 6 [ e
6 [oer s 7 [ e
7 [oos |pse | 18 [ o
s fu e e o
s [1zr  [eo fo: e

]
-

| Cancel | Help |

Fig. E-10. Step Tablet dialog box.

The dialog box will indicate whether the values are for the transmissive or reflective
step tablet, depending on whether you are in transmissive or reflective mode.

If you arein reflective mode, you do not need to change the default step tablet values.

If you arein transmissive mode, you do need to enter the correct step tablet values
that were shipped with your GS-710. You can type the serial number for these values
into the Tablet Serial Number field.

The Quantity Offset field does not apply in the GS-710. This value should be set to
zero.
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Next, enter the values for the transmissive step tablet in the appropriate fields under
the Diffuse column. After the step tablet is scanned, the software will associate each
density value with its corresponding segment on the step tablet.

The step tablet density values do not need to be entered each time you calibrate. Once
they have been entered and saved, they will be automatically recalled when the
calibration strip is scanned.

When you are finished filling out the Step Tablet Values form, click on OK.

Diffuse Versus Specular O.D.

In the step tablet form, you enter O.D. as diffuse density, and then the software
automatically calculates the specular density.

Specular density is ameasure of the light that passes directly through a medium.
Diffuse density includes light that is scattered as it passes through the medium. Step
tablet values are given in diffuse density, but are measured by the scanner in specular
density, and therefore must be converted according to the specular/diffuse O.D. ratio.
This conversion does not affect quantitation.

| <¢— Specular Light (passes directly through medium)

~¢— Medium (gel, film, etc.)

/ \ -— Diffuse Light (is scattered by medium)

Fig. E-11. Specular and diffuse density

Diffuse density values are converted to specular optical density units according to the
following formula:

Specular OD = 1.4 [Diffuse OD
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E.5.b Calibration Settings

After you have entered the step tablet values, you can immediately calibrate by
clicking on the Calibrate Now button (in the Densitometer Options dialog box).

You can also specify how often you want the GS-710 to automatically recalibrate.
Either click on the Calibrate Before Every Scan checkbox or enter a Recalibration
Interval (in minutes) in the appropriate field.

Note:  The scanner will automatically recalibrate each time you change your filter or
your reflective/transmissive setting. (If you select adifferent application with the
same filter and light settings, it will not auto recalibrate.)

Calibration Report

To print out a calibration report each time the densitometer calibrates, click on the
Calibration Report checkbox.

E.6 Acquire the Image

Note:  Before scanning in transmissive mode, make sure the white balance region of the
scanning areais not covered or obstructed in any way.

To begin to scan, click on the Acquire button. The scanned image will begin to appear
in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the
interrupt, and then you will be asked if you want to keep the partial scan. This feature
isuseful if you overestimated the size of the area you selected.

After the scan is complete, awindow will open displaying the scan image, at which
point you can analyze and save it.

Note:  Theimage will open with adefault file name that includes the date, time, and (if
applicable) user name. However, unless you have selected Auto Save After Scan,
the file will not be saved until you select Save or Save As from the File menu.
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E.7 Other Options

Oversample

Thisfeature allows you to scan at the maximum resol ution of the GS-710 (42.3 x 42.3
microns) and then use spatial averaging to create an image with lower resolution. This
can result in better images at lower resolution—however, it takes longer to scan.

To turn on oversampling, click on the More Options button in the acquisition window
and click on the Oversample checkbox.

With oversampling on, you can specify your own resolution within the range of 43—
169 microns by entering values directly in the fields next to X resolution and Y
resolution in the main acquisition window.

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan
checkbox.

Note:  In PDQuest, this option is preselected and cannot be turned off. All images must
be automatically saved when acquired.

With this checkbox selected, when you click on Acquire, a Save As dialog box will
open asking you to specify afile name and location for the image you are about to
create. The scan will begin when you click on the Save button.

Make Backup Copy

If you have checked Auto Save After Scan, you can also automatically create a
backup copy of any scan you create.

Click on the Make Backup Copy checkbox. With this checkbox selected, when a scan
is created and saved, a backup copy will be placed in the same directory asthe
scanned image. Windows backup fileswill have an “.sbk” extension. Macintosh
backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.
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Highlight Saturated Pixels

When this box is checked, any saturated pixelsin theimage will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.
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Appendix F
GS-800 Imaging Densitometer

Fig.F-1. GS-800 Imaging Densitometer

Before you can begin scanning images with the GS-800 I maging Densitometer®, your
instrument must be properly installed and connected with the host computer. See the
hardware manual for installation, startup, and operating instructions.

PC Only: A Note About SCSI Cards

The GS-800 is connected to your computer by a Small Computer System Interface
(SCSl) cable. To use the GS-800, you must have a SCSI card installed in your PC. If
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you have a PC with a Windows 98 or Windows ME operating system, you may also
need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simul ation mode.”
In this mode, an acquisition window will open and the controlswill appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the Ctrl key and select the name of the device
from the File menu. Thetitle of the GS-800 acquisition window will indicatethat itis

simulated.

Note: Thereisno simulated calibration for densitometers.

F.1 GS-800 Acquisition Window

To begin acquiring images, go to the File menu and select GS-800. The acquisition
window for the densitometer will open, displaying a control panel and a scanning
window.
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£ Densitometer: G5-800: Calibrated Transparency

Step | - Select Application

[]Highlight 5 aturated Pixeks

Options.. @ Help

Select... a5

H-ray film -

5-

Gray film -

7-

Fiter [JRed [X]Green [JBlue [J'white 8-

Light (™ Reflective (" Transmissive 11-
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~Step |l - Select Scan Area 15'

Preview scan... -
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Top: 0.0 Left: 0.0 18-
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Fig. F-2. GS-800 acquisition window

The scanning window is marked by grid lines that divide the areainto square
centimeters. These are numbered 1-40 top to bottom and 1-30 left to right if the light
sourceis reflective, and 1-40 top to bottom and 1-29 |eft to right if the light sourceis

transmissive.

To hide the gridlines, select the Hide Grid checkbox under Options.

Below the main scanning window is the calibration strip window. Every time the
densitometer calibrates, an image of the calibration strip will appear in this window.
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The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are five basic steps to scanning an image using the GS-
800:

1. Select the application.

2. Select the scan area.

3. Select the resolution of the scan.
4

Cadlibrate the instrument. (Thisis automatic, after you enter the step tablet values
before you first scan after installation.)

5. Acquire theimage.

F.2 Step I. Select Application

To set the parameters for your particular scan, you can;
1. Select from alist of possible applications, or

2. Choose your own filter and light source settings.

Selecting from the List of Applications

When you select from the list of applications, the software automatically sets the
appropriate filter(s) and other parameters for that particular application.

To select from the list of applications, click on the Select button under Sep |. Select
Application.
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Heray film
Gel
Photograph
Blot

Coomassie blue
Silver stain

Copper stain

Zinc stain

Blot X
Stain all

HEP-Substrat

Fig. F-3. Example of the application tree in the GS-800 dialog box.

The applications are listed in atree that expands from left to right. First you select the
category of your application, then you select your particular application.

To exit the tree without selecting, press the Esc key.

Gray file
X-ray film 4|£ Blue film

Linear
— Coomassie Blue
I Silver stain
Gel —— | Copper stain

— Zinc stain
L Stain all

— Positive (dark bands, light background)
Photograph ———

L— Negative (light bands, dark background)

Coomassie stain
Colloidal gold stain
Amido black stain

Blot AP-Substrate (BCIP/NBT)
HRP-Substrate (4CN)
HRP-Substrate (DAB)

Fig. F-4. Applications available in the GS-800 acquisition window.
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Choosing Your Own Settings

If you know thefilter and light source settings you want, or want to experiment with
different settings, you can choose them yourself.

Filker [JRed [®]Green [[Blus  []'white

Light ™ Reflective (=" Transmissive

Fig. F-5. GS-800 Custom Application controls.

Next to Filter, click on either the Red, Green, Blue, or White checkbox, or a
combination of two of the first three (Red-Green, Green-Blue, Red-Blue).

Filter Color Wavelength Application Examples
Red 595-750 nm Coomassie G-250, BCIP/NBT, Fast Green
FCF, Methylene Blue
Green 520-570 nm Coomassie R-250, Basic Fuchsin
Blue 400-530 nm Crocein Scarlet
White 400-750 nm Silver Stains, Copper Stains, Film

Fig. F-6. Examples of filter colors and applications.

Next to Light, select the appropriate light source.

»  Select Reflective for scanning opaque mediums such as dried gels on filter paper,
arrays, or photographs. The scanning dimensionsin this mode are 30 cm x 40
cm.

e Select Transmissive for scanning transparent mediums such as films, gels, or
dlides. The scanning dimensions in this mode are 29 cm x 40 cm.
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F.3 Step Il. Select Scan Area

Preview Scan

Before selecting the particular area to scan, you can preview the entire scanning area
to determine the exact position of your sample.

Click on Preview Scan. A quick, low-resolution scan of the entire scanning area will
appear in the scanning window. Your sample should be visible within a portion of this
scan.

Selecting an Area

Using the preview scan as a guide, select your scan area by dragging your mouse
within the scanning window. The border of the scan areayou are selecting will be
marked by aframe.

Note:  The scan areayou select must be at least 1 cm wide.

When you rel ease the mouse button, the border changes to a dashed blue line,
indicating a selected area.

«  Toreposition the scanning area box you have created, position your cursor inside
the box and drag. The entire box will move.

* Toresizethe box, position your cursor on abox side and drag. The side you have
selected will move.

«  Toredo the box entirely, position your cursor outside the box and drag. The old
box will disappear and a new box will be created.

You can also select the scanning area by entering coordinatesin the appropriate fields
(Top, Bottom, Left, Right). Asyou enter a coordinate, the position of the scanning
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with
borders. You can always crop the image later.
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F.4 Step lll. Select Resolution

To select from alist of possible scanning resolutions, click on the Select button under
Step 1. Select Resolution. Thiswill open the Select Scan Resolution dialog box.

Ll PDQUEST

A

Select Scan Resolution

(363 » 363
(423 v 423
(+ 635 » 635
(5953 » 553

(1270 « 127.0 Low. For gels with very large features. @ Help

High. Far small gels with tiny features.

. . ) Daohe
tedium high. For gels with emall features.

tedium. For most gels. Camea]

tedium low, For gelz with large features,

Fig. F-7. Select Scan Resolution dialog box.

Available resolutions are listed from highest to lowest in terms of the dimensions of
the resulting pixels (in microns). Smaller pixels equal higher resolution. Each
resolution islisted with itstypical use.

In general, the size of your pixels should be one-tenth the height of your smallest

object.

Specifying Your Own Resolution

If you select Oversample in the Options dialog box, you can specify your own
resolution within the range of 32—169 micrometers. With Oversample selected, enter
values directly in the fields next to X resolution and Y resolution in the main

acquisition window.
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Step Il - Select Resolution

# rezolution |50, 0 Microng
Select...
' iesolution [so.df  Micrane

Image file zize: 0. 10 kb

Fig. F-8. Entering a custom resolution (with Oversample selected).

Image File Size

The size of the scan file for the selected resolution islisted next to Image File Size. If
you do not have enough computer memory for the specified file size, an error
message will appear when you attempt to scan. If this happens, select alower
resolution or decrease the size of the area to be scanned. (Macintosh users can also
increase the application memory partition. See your Macintosh computer
documentation for guidance.)

F.5 Calibration

The GS-800 automatically calibrates the densities of scanned images to ensure
accuracy and reproducibility of results. The GS-800 has built-in step tablets for both
transmissive and reflective scanning.

e Thetransmissive step tablet calibrates transmissive scans from 0 to 3.0 O.D.
«  Thereflective step tablet targets reflective scans from 0 to 2.0 O.D.

The first time you use the GS-800, you must select some settings to ensure accurate
calibration. Click on the Options button in the main acquisition window. This will
open the Densitometer Options dialog box.
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Densitometer Options

- Calibration

..... ) On the GS-700 this requires that the calibration overlay
e be installed.

[C]Calibrate Before Every Scan
Recalibration ,_ = The Denzitometer will be re-calibrated
Inkeral [minutes) after thig time hag expired.

S A calibration report will be printed each time the
L[t Densitometer is calibrated.

Calibrate Mow | Edit Step Tablet

~Data Handling
The Densitometer will be told to scan at its maximum resolution
and spatial averaging will be used to produce the desired resolution.
[ (0 =mmee Thiz gives better spatial fidelity and lawer noize, although it takes

lorger to scan.

A modified logarithmic zcaling system will be used ta reduce
{ihave Scaled Data the size of the data by B0Z. It introduces a constant relative
error of less than 3%,

QK | Cancel | Help |

Fig. F-9. Densitometer Options dialog box.

Note that calibration is aways on for the GS-800.

F.5.a Step Tablet Values

The built-in transmissive and reflective step tablets on your densitometer have
specific density values. Before scanning for thefirst time, you must enter the values
for your transmissive step tablet into the software. You can use the default valuesin
the software for the reflective step tablet.

Transmissive Step Tablet

Before you scan in transmissive mode for the first time, you must specify the values
for your transmissive step tablet.

First, make sure that the Transmissive checkbox is selected in the main acquisition
window, then click on the Options button. In the Densitometer Options dialog, click
on the Edit Step Tablet button. The Step Tablet Values for GS-800 Transmissive
dialog box will open.
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Fig. F-10. Step Tablet dialog box.

Attached to the outside of your GS-800, you will find a copy of the manufacturer’s
printout of the diffuse density values for each segment of the transmissive step tablet,
aswell as a serial number for the tablet. These exact density values must be entered
into the software to associate a correct density value with each step on the step tabl et.

Note:  Scanning in transmissive mode with incorrect step tablet values can cause
significant errorsin the reported densities of your scans.

First, type the serial number for the tablet into the Tablet Serial Number field.

The Quantity Offset field does not apply in the GS-800 in transmissive mode. This
value should remain at zero.

Next, enter the step tablet valuesinto the appropriate fields under the Diffuse column.
After the step tablet is scanned, the software will associate each density value with its
corresponding segment on the step tablet. The density values do not need to be
reentered each time you cdibrate.

When you are finished entering the transmissive step tablet values, click on OK.
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Reflective Step Tablet

For the reflective step tablet, it is recommended that you use the default target values
in the software. Although you can edit these values based on your own measurements
and testing, the default values have been preset based on careful testing and review.

To view or edit the default reflective values, make sure that the Reflective checkbox
is selected in the main acquisition window, then click on the Options button. In the
Densitometer Options dialog, click on the Edit Sep Tablet button. The Step Tablet
Values for GS-800 Reflective dialog box will open.

When you are finished viewing/editing the reflective step tablet values, click on OK.

Diffuse Versus Specular O.D.

In the step tablet form, you enter O.D. as diffuse density, and then the software
automatically calculates the specular density.

Specular density is ameasure of the light that passes directly through a medium.
Diffuse density includes light that is scattered as it passes through the medium. Step
tablet values are given in diffuse density, but are measured by the scanner in specular
density, and therefore must be converted according to the specular/diffuse O.D. ratio.
This conversion does not affect quantitation.

| -— Specular Light (passes directly through medium)

~¢— Medium (gel, film, etc.)

/ \ -— Diffuse Light (is scattered by medium)

Fig. F-11. Specular and diffuse density

Diffuse density values are converted to specular optical density units according to the
following formula:

Specular OD = 1.4 [Diffuse OD
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F.5.b Other Calibration Settings

After you have entered the step tablet values, you can immediately calibrate by
clicking on the Calibrate Now button (in the Densitometer Options dialog box).

You can also specify how often you want the GS-800 to automatically recalibrate.
Either click on the Calibrate Before Every Scan checkbox or specify aperiod
between automatic recalibrations (in minutes) in the Recalibration Interval field.

Note:  The scanner will automatically recalibrate each time you change your filter or
your reflective/transmissive setting. (If you select adifferent application with the
same filter and light settings, it will not auto recalibrate.)

To print out a calibration report each time the densitometer calibrates, click on the
Calibration Report checkbox.

F.6 Acquire the Image

Note:  Before scanning in transmissive mode, make sure the white balance region of the
scanning areais not covered or obstructed in any way.

To begin to scan, click on the Acquire button. The scanned image will begin to
appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the
interrupt, and then you will be asked if you want to keep the partial scan. This feature
isuseful if you overestimated the size of the area you selected.

After the scan is complete, awindow will open displaying the scan image, at which
point you can analyze and save it.

Note:  Theimage will open with adefault file name that includes the date, time, and (if
applicable) user name. However, unless you have selected Auto Save After
Scan, the file will not be saved until you perform a Save or Save As operation.
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F.7 Other Options

Oversample

Thisfeature allows you to scan at the maximum resol ution of the scanner and then use
spatial averaging to create an image with lower resolution. This can result in better
images at lower resolution—however, it takes longer to scan.

To turn on oversampling, click on the Options button in the acquisition window and
select the Over sample checkbox in the options dialog.

With oversampling on, you can specify your own resolution within the range of the
densitometer by entering values directly in the fields next to X resolution and Y
resolution in the main acquisition window.

Auto Save After Scan

To automatically save any scan you create, select the Auto Save After Scan
checkbox.

Note:  In PDQuest, this option is preselected and cannot be turned off. All images must
be automatically saved when acquired.

With this checkbox selected, when you click on Acquire, a Save As dialog box will
open asking you to specify afile name and location for the image you are about to
create. The scan will begin when you click on the Save button.

Make Backup Copy

If you have selected Auto Save After Scan, you can also automatically create a
backup copy of any scan you create.

Click on the Make Backup Copy checkbox. With this checkbox selected, when a
scan is created and saved, a backup copy will be placed in the same directory as the
scanned image. Windows backup fileswill have an “*.sbk” extension. Macintosh
backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.

F-14



Appendix F. GS-800

Highlight Saturated Pixels
When this box is checked, any saturated pixelsin theimage will appear highlighted in

red in the scan window and in the pop-up image window. To view/hide saturated

pixelsin the pop-up image window, use the Transfor m command on the main tool bar
or Image menu.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.
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Appendix G
Fluor-S Multilmager

Fig.G-1. Fluor-S Multilmager.

Before you can begin acquiring images using the Fluor-S® Multilmager, the imaging
system must be properly installed and connected with the host computer. See the
Fluor-S hardware manual for installation, startup, and operating instructions.

Note: Make sure that the temperature light on the Fluor-S is green before attempting to
capture an image. If you are using a PC, the Fluor-S should be turned on and the
initialization sequence completed before the host computer is turned on. See the
hardware manual for more details.
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PC Only: A Note About SCSI Cards

The Fluor-Sis connected to your computer by a Small Computer System Interface
(SCSl) cable. To use the Fluor-S, you must have a SCSI card installed in your PC. If
you have a PC with a Windows 98 or Windows ME operating system, you may also
need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simul ation mode.”
In this mode, an acquisition window will open and the controlswill appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. The title of the acquisition window will indicate that it is
simulated.

G.1 Fluor-S Acquisition Window

To acquire images using the Fluor-S, go to the File menu and select Fluor-S.... The
acquisition window for the imager will open, displaying acontrol panel and an image
display window.

G-2



Appendix G. Fluor-S

i Fluor-5 Multilmager

~Step | - Select Application

Select..

Silver Stain

(Clear,White, Trens  Hikes)

Scan Dimension:

(& 80mm ¢~ 160mm ¢ 250mm (™ 300mm

rStep Il - Position/Focu:

° Position o Focus

i3} Show Alignment Grid

Step Il - Set Exposure Time [sec]
’V ﬂ ﬂ D Preview

D Acquire | @LweAcuuire‘ @ Stop |

Display Optian;
’V [CJHighlight S aturated Pizels ‘

Image file size: z.e0 Mb Optians... @ Help

"E wposure Statu;
C

Fig.G-2. Fluor-S acquisition window
When the Fluor-S window first opens, no image will be displayed.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are four basic steps to acquiring an image using the
Fluor-S:

1. Select the application.

2. Position and focus the gel or other object to be imaged.
3. Set the exposure time.
4

Acquire the image.
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G.2 Step |. Select Application

To set the appropriate filter and other parameters for the type of object you are
imaging, click on the Select button under Select Application. The available
applications and their associated settings are listed in a tree that expands from left to
right.

Erotein Gels Coomassie Blue
Blotting Caopper Stain

Densitametry

Silver Stain
e Custom
- Hs SYPRO Orange
— SYPRO Red
Coomassie Blue Zine Stain

(Clear, WMhite, Trans, HIsen=sT |

Fig.G-3. The application tree in the Fluor-S acquisition window.

First select your general application, then select the particular stain or medium you
are using. If you select the chemiluminescent application under “Blotting,” you also
have the option of selecting High Resolution or High Sensitivity (see below).

When you select an application, the software automatically sets the appropriate
standard filter (520LP, 530DF60, 610L P, clear, or none), light type (UV, white, or
none), and light source (trans, epi, or neither) in the Fluor-S for that particular
application.

For applications involving trans illumination, you must also specify a scan dimension
(see below).

Your selection will be displayed below the Select button. To exit the tree without
selecting, press the ESC key.

G-4



Appendix G. Fluor-S

Custom Applications

If your application is not listed, if you want to use a user-installed filter, or if you want
to access High Sensitivity mode (see below), you can create and save your own
custom application.

From the application tree, select Custom, then Create. Thiswill open adialog box in
which you can name your application and select your settings.

Mucleic Acid Gels
Protein Gels

QuantiyOne |

Blotting
Create a new Fluor-3 Application.

Densitometry
Ste

Sel

Custarm
te LS Create... M arme: |Gel Type 44xqd

Filter... User Filter 2
\-’ llurnination... | Thite, Epi
Mode... High Sensitiwvityy
Cancel| 0K

Fig.G-4. Creating a new custom application.

To select thefilter (including user-defined), type of illumination, and camera mode,
click on the appropriate buttons and select from the pop-up lists.

Note:  Under IHlumination, thereisalisting for aspare UV light source. This selectsthe
spare UV bulb in the Fluor-S. Select this light source if your main UV bulb fails.

Enter a name for your application in the Name field. Click on OK to implement your
changes.

After you have created an application, you can select it from the application tree by
selecting Custom and the name you created. You can delete the application by
selecting Custom, Delete, and the name of the application.
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Scan Dimension

If an application uses trans illumination, the Scan Dimension buttons become active.
The scan dimension is the distance traveled by the transilluminating light source asiit
scans horizontally across the platen.

Scan Dimengian:

{o* B0mm ¢ 160mm ¢ 250mm ¢ 300rmm

Fig.G-5. Scan dimension settings for trans illumination.

The full scanning range is 300 mm. Select asmaller range if your sampleis small and
you do not want to wait while the light source travels over the maximum scan width.

High Resolution Versus High Sensitivity

High Resolution and High Sensitivity are mutually exclusive options. High
Resolution is the normal operating mode for the Fluor-S. High Sensitivity provides
optimal sensitivity for low-light applications. It is the default selection for the
chemiluminescence application, and may be selected for a custom application.

In High Resolution mode, images are captured at the maximum resolution of the
camera.

In High Sensitivity mode, the pixelsin the cameraare “binned” (i.e., four pixels are
combined into one) to increase the amount of signal per pixel. However, combining
the pixels resultsin areduction in the resolution of the image.

G.3 Step Il. Position/Focus

Note:  When you click on the Position or Focus button, the light inside the Fluor-S box
automatically turns on. To turn the light off while positioning or focusing, hold
down the sHIFT key when clicking on the button.
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Position

After you have selected your application, you are ready to center your gel or other
object within the camera frame. To do so, click on the Position button. The Fluor-S
will begin capturing a“live” image and updating it every second.

With the Position button selected, look at the image in the acquisition window while
you position your object in the center of the platen. If you have azoom lens on the
camera, you can adjust the magnification while you position.

You can select the Show Alignment Grid checkbox to facilitate positioning.

Fig.G-6. Fluor-S alignment grid.

When you are finished positioning, click on the Stop button.

Focus

Note:  Before focusing, you should adjust the f-stop on the camera to the lowest setting
(i.e., the maximum aperture). This reduces the depth of field, allowing you to
more accurately focus the camera. Then, after focusing, increase the f-stop to the
desired setting. (See the following table on recommended f-stops.)

After you have positioned your sample, click on the Focus button and look at the
image in the acquisition window while aligning the two focusing arrows on the
cameralens. While focusing, the camerawill limit its focus to a small portion of the
sample (thiswill not affect any zoom lens adjustments you may have made.)

When you are finished focusing, click on the Stop button.
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G.4 Step lll. Set Exposure Time

When you are ready to capture an image, you will need to select an exposure time.
“Exposure” refers to the integration of image captures on the CCD over a set period
of time. The effect is analogous to exposing photographic film to light.

The exposure time you select should be based on your application and your “best
guess” asto what exposure will give you the best image.

Note:  The minimum exposure timein transilluminated mode is 1 second. The
minimum exposure timein epi illuminated mode is 0.1 second.

You can enter an exposure time (in seconds) directly in thefield, or use the Arrow
buttons to adjust the exposure time in 10 percent increments.

Step Il - Set Expozure Time [zec]
ﬂ ﬂ () Preview

Fig.G-7. Selecting an exposure time.

The following table provides recommended exposure times for various applications.
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Recommended Exposure Times and Lenses

Recommended
Sample Exposurel Lens & Filter? Accessories Used
Fluorescent Stain Gel 3-40 sec. Zoom/IR None
Fluorescence End-Label Gel 30 sec.—3 min. Zoom/IR None
Fluorescent Blot 0.5-5 sec. Zoom/IR None
Chemifluorescent Blot 0.5-5 sec. Zoom/IR None
Colorimetric Gel 1-10 sec. Zoom/IR White Diffusion Plate
Colorimetric Blot 0.5-20 sec. Zoom/IR None
X-ray film 1-10 sec. Zoom/IR White Diffusion Plate
Weak Chemiluminescence® 5-20 min. 50 mm Chemi Tray
(if sample is small)
Strong Chemiluminescence® | 30 sec.—2min. 50 mm Chemi Tray
(if sample is small)
Lincrease exposure time two fold for each step increase in f-stop.
2For sharper focusing, close the f-stop down 1-2 stops from full open while focusing.
3For chemi applications, the 50mm lens is recommended. Always remove the 660 filter.

For most applications, you can select an exposure time, capture an image, study it,
then adjust the exposure time accordingly. Repeat this procedure as many times as
necessary to obtain a good image.

For chemiluminescent samples, which degrade over time and emit low levels of light,
you can select a high exposure timeinitially and use Live Acquire mode to save
intermediate exposures (see following section).

Preview

For shorter exposures, you can use Preview to test different exposure times. Click on
the Preview button create a preview exposure and display it in the acquisition
window.
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A preview scan takes only half aslong to create asareal scan, because the preview
scan does not capture a“dark” image (see the foll owing section on Options). The
progress of the exposure will be displayed in the Exposure Status bar at the bottom of
the dialog box.

You cannot save preview scans.

If you want to stop a preview scan that isin progress, click on the Stop button.

G.5 Acquire the Image

The Fluor-S gives you the option of simply acquiring and displaying afully exposed
image, or preserving intermediate exposures.

Acquire

To acquire and display afully exposed image, click on the Acquire button. An
exposure will be taken based on the time selected in Step 111. Thisis appropriate for
most short exposures.

The progress of the exposure will be displayed in the Exposure Status bar at the
bottom of the acquisition window.

~E=pozure Status
| |

|Acquiring Images

Fig.G-8. Exposure Status bar when acquiring an image.

Depending on which dark subtraction type you have selected, a dark count may be
acquired immediately following image acquisition. See Dark Subtraction Type under
Options, below.

If you want to stop ascan that isin progress, click on the Stop button. The acquisition
will be terminated.
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After an image has been acquired, a separate window will pop up containing the new
image. Thewindow will have adefault file name that includes the date, time, and user
(if known). To save the image, select Save or Save Asfrom the File menu.

You can then analyze the image using the analysis functions.

Live Acquire

Live Acquire allows you to view and preserve intermediate exposures leading up to a
full exposure. Thisisuseful for longer exposure times, such as those required by
chemiluminescent samples, where there is the potential for image saturation.

When you click on the Live Acquire button, the exposure time you selected is divided
by the number of exposure counts set in the Fluor-S Options dial og box (see Options,
below). For example, if you enter an exposure time of 10 minutes and an exposure
count of 20, then 20 intermediate exposures will be produced at 30-second intervals.
Each intermediate exposure will be displayed in the scan window. The final, full
exposure will be displayed in a separate image window.

Note:  Thefirst intermediate exposure will take longer than 30 seconds to display if
dark subtraction is performed.

You can automatically save your intermediate exposures as separate files for later
review using the Auto Save After Scan option. See Options, below.

If you see an intermediate exposure that you like in the scan window, click on the
Stop button. Live Acquire mode will end and the last intermediate exposure to be
completed will open in a separate image window. You can then save it for analysis.

G.6 Options

Click on the Options button to open the Fluor-S Options dialog box.
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Fluor-5 Options

rFluor-5 Information rDark Subtraction Type
Fluar-S Multilmager [simulated) & Mormal ™ Referenced ¢ Mone

Imager Firmware verzion: 1.00 T

Imager Hardware Yersion: 1.01

rLive Exposure Mode
rlmaging Area [cm)
Exposure Count: |&

Width: |13.17 B AR e G
Height: |L10.2& [ ]
~Save

~Mi=rl
Dl [Jéuto Save After Scan
[®]Auto-scale Transform After Acquision | | L.

0K | Cancel

Fig.G-9. Options dialog box.

G.6.a Dark Subtraction Type

All CCD cameras accumul ate electrons that produce asignal that is indistinguishable
from light. This* dark count” adds to the noise in your images. In most cases, you will
want to subtract this dark count from your images.

Normal

The Normal option button selects the default dark subtraction type. In this mode, after
you acquire an image, a“dark” image of the same exposure length will be taken, and
thiswill be subtracted from your image.

The progress of the dark exposure will be displayed in the Exposure Status bar
following the regular image exposure.

Note:  In Normal mode, adark imageisonly acquired the first time you perform a scan
with particular application and exposure settings. If you perform subsequent
scans with the same settings, no dark exposure will be taken.
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Referenced

If you do not want to perform adark exposure with each acquisition, you can take a
“reference” dark exposure that will be saved and subtracted from all subsequent
acquisitions. Click on the Referenced button to activate this feature.

The first time you acquire an image after selecting this option, the Fluor-Swill take a
60-second dark exposure that will be saved and used to subtract the dark count from
all subsequent acquisitions.

For image exposures of greater or less than 60 seconds, the reference dark will be
scaled accordingly and then subtracted. You can change the default reference dark
exposure time using the Reset Reference button (see below).

If you deselect the Referenced button and then reselect it, the old reference dark
exposure will still be available.

Note:  Separate reference dark exposures will be taken for High Resolution mode and
High Sensitivity mode. Once you have created areference dark in each of these
modes, each reference dark will be used according to the mode you arein.

Reset Reference

If you would like areference dark with an exposure time that more closely matches
that of your typical scans, click on the Reset Reference button.

Feset Reference Dark Image

Dark Exposure Time: |20. DDI Seconds

0K | Cancel

"Dptions

Fig.G-10. Reset Reference Dark pop-up box.
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A pop-up box will prompt you to enter a new reference dark exposure time in
seconds. Click on OK to implement your change. The new reference dark will be
created when you acquire your next image.

Note:

Because of the high sensitivity of the CCD, fluctuations in background radiation
and/or temperature in the room can affect the level of dark count. If you feel that
radiati on/temperature conditions have changed in the room since your last
reference dark was created, use the Reset Reference button to delete your old
reference and create a new one under current conditions.

None

If you do not want to perform dark subtraction, select None. No dark exposure will be
acquired or subtracted.

G.6.b Live Exposure Mode

Exposure Count

If you are using the Live Acquire function (see previous section), you need to specify
how many intermediate exposures you want to view/save during acquisition. Enter
this number in the Exposure Count field.

The total exposure time will be divided by the number you enter in the Exposure
Count field. If you enter an exposure time of 10 minutes and a count of 10, you will
create 10 intermediate exposures at 1 minute intervals.

Note:

Do not enter a count that will result in an intermediate exposure time that is less
than the minimum exposure time for the mode you are in. The minimum
exposure time in trans illuminated mode is 1 second, and the minimum exposure
timein epi illuminated mode is 0.1 second. (Example: For atransilluminated
application, an exposure time of 20 seconds and an exposure count of 21 would
result in an error.)

Save All Intermediate Images

If Auto Save After Scan is selected (see following section), the Save All Intermediate
Images checkbox will become active. If you select this checkbox, all your
intermediate exposures will be saved as separate files. These fileswill have the same
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root name appended by a number indicating the exposure sequence. The final, full
exposure will have the root name only, with no exposure number.

G.6.c Save

Auto Save After Scan

To automatically save any image you create, click on the Auto Save After Scan
checkbox.

Note:  In PDQuest, this option is preselected and cannot be turned off. All images must
be automatically saved when acquired.

With this checkbox selected, when you click on Acquire or Live Acquire, a Save As
dialog box will open asking you to specify afile name and location for theimage you
are about to create. The scan will begin when you click on the Save button.

Note that in Live Acquire mode you can save your intermediate exposures by
selecting Auto Save After Scan and then Save All Intermediate |mages.

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first
select Auto Save After Scan (see above), then select the Make Backup Copy
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup fileswill have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.

G.6.d Imaging Area Size
Theimaging areais the area of the sample that is captured by the camera and

displayed in the scan window. To specify the size of thisarea, enter adimension in the
appropriate field under Imaging Area.
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When you change one imaging area dimension, the other will change to maintain the
aspect ratio of the cameralens.

Theimaging areawill change depending on your zoom factor. For example, if you
have zoomed in on a areathat is 4.5 x 3.5 cm, then you would enter 4.5 for the width
(3.5 for the height would be calculated automatically).

Note:  Your imaging area settings must be correct if you want to do 1:1 printing. They
must also be correct if you want to compare the quantities of objects (e.g., using
the Volume Tools) in different images.

Theimaging area dimensions also determine the size of the pixelsin your image (i.e.,
resolution). A smaller imaging areawill result in a higher resolution.

G.6.e Auto-scale Transform

Auto-scale Transform after Acquisition allows the user the option of having theimage
automatically perform the Auto-Scal e transform function upon completion of image
acquisition. This eliminates the need to transform an image or re-scan an image when
the acquisition time was too short or the iris not opened enough.

To enable the auto-scal e transform function, check the box labeled, Auto-Scale
Transform after Acquisition in the Options dial og.

G.7 Other Features

[#] Highlight 5 aturated Pisels

Image file size: z.s0 Mb Dptionz [ Help

’—Displa}l Optiohz

Fig.G-11. Other Fluor-S acquisition window features.
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Highlight Saturated Pixels

When this box is checked, any saturated pixelsin theimage will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

File Size of Images

Image File Size shows the size of the image file you are about to create. Thissizeis
determined by whether the image was created in High Resolution or High Sensitivity
mode.

If you do not have enough computer memory for the specified file size, an error
message will appear when you attempt to acquire an image. (Macintosh users can
increase the application memory partition. See your Macintosh computer
documentation for guidance.)
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Fig.H-1. Fluor-S MAX Multiimager.

Before you can begin acquiring images using the Fluor-S® MAX Multilmager, the
imaging system must be properly installed and connected with the host computer. See
the Fluor-S MAX hardware manual for installation, startup, and operating
instructions.

Note:  Make sure that the temperature light on the Fluor-S MAX is green before
attempting to capture an image. If you are using a PC, the Fluor-S MAX should
be turned on and the initialization sequence completed before the host computer
isturned on. See the hardware manual for more details.
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PC Only: A Note About SCSI Cards

The Fluor-S MAX is connected to your computer by a Small Computer System
Interface (SCSI) cable. To use the Fluor-S MAX, you must have aSCS| card installed
in your PC. If you have a PC with a Windows 98 or Windows ME operating system,
you may also need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simul ation mode.”
In this mode, an acquisition window will open and the controlswill appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. The title of the acquisition window will indicate that it is
simulated.

H.1 Fluor-S MAX Acquisition Window

To acquire images using the Fluor-S MA X, go to the File menu and select Fluor-S
MAX.... The acquisition window for the imager will open, displaying a control panel
and an image display window.
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£ Fluor-5 MAX Multilmager

Step | - Select Application

Select...

Coomassie Blue
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Camera Temperature —20.0

Fig.H-2. Fluor-S MAX acquisition window.

When the Fluor-S MAX window first opens, no image will be displayed.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are four basic steps to acquiring an image using the
Fluor-SMAX:

1. Select the application.

2. Position and focus the gel or other object to be imaged.
3. Set the exposure time.
4

Acquire the image.
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H.2 Step I. Select Application

To set the appropriate filter and other parameters for the type of object you are
imaging, click on the Select button under Select Application. The available
applications and their associated settings are listed in a tree that expands from left to
right.

Erotein Gels Coomassie Blue
Blotting Copper San 1t

Densitometry

Silver Stain
SU!wf:usturn SYPRO Orange
e SYPRO Red
Cocmassie Elue Zinc Stain

(Clear, hite, Trans, HIZEn=]

Fig.H-3. The application tree in the Fluor-S MAX acquisition window.

First select your general application, then select the particular stain or medium you
are using. If you select the chemiluminescent application under “Blotting,” you also
have the option of selecting High Sensitivity or Ultra Sensitivity (see below).

When you select an application, the software automatically sets the appropriate
standard filter (520L P, 530DF60, 610L P, clear, or none), light type (UV, white, or
none), and light source (trans, epi, or neither) in the Fluor-S MAX for that particular
application.

For applicationsinvolving trans illumination, you must also specify ascan dimension
(see below).

Your selection will be displayed below the Select button. To exit the tree without
selecting, press the ESC key.
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Custom Applications

If your application is not listed, if you want to use a user-installed filter, or if you want
to access Ultra Sensitivity mode (see below), you can create and save your own
custom application.

From the application tree, select Custom, then Create. Thiswill open adialog box in
which you can name your application and select your settings.

Mucleic Acid Gels
FProtein Gels

QuantiyOne |

Create a new Fluor-S Application.

Blotting

Densitometny
Ste

Sel

Custam
== Create... M ame: |Gel Type 44xc[

Filter... User Filter 2
\> lllurnination... | Thite, Epi
WMode. .. High Sensitiwvity
Cancel| 0Ok

Fig.H-4. Creating a new custom application.

To select thefilter (including user-defined), type of illumination, and camera mode,
click on the appropriate buttons.

Note:  Under lllumination, thereisalisting for aspare UV light source. This selectsthe
spare UV bulb inthe Fluor-SMAX. Select thislight sourceif your main UV bulb

fails.

Enter a name for your application in the Namefield. Click on OK to implement your
changes.

After you have created an application, you can select it from the application tree by
selecting Custom and the name you created. You can delete the application by
selecting Custom, Delete, and the name of the application.

H-5



Quantity One User Guide

Scan Dimension

If an application uses trans illumination, the Scan Dimension buttons become active.
The scan dimension is the distance traveled by the transilluminating light source asiit
scans horizontally across the platen.

Scan Dimengian:

{o* B0mm ¢ 160mm ¢ 250mm ¢ 300rmm

Fig.H-5. Scan dimension settings for trans illumination.

The full scanning range is 300 mm. Select asmaller range if your sampleis small and
you do not want to wait while the light source travels over the maximum scan width.

High Sensitivity and Ultra Sensitivity

High Sensitivity and Ultra Sensitivity are different cameramodes. In Ultra Sensitivity
mode, the Fluor-S MAX camerais cooled to —35.0 degrees C. In High Sensitivity
mode, the camerais cooled to —20.0 degrees C. The current camera temperatureis
displayed at the bottom of the acquisition window.

Camera Temperature —-Z0.0

Fig.H-6. Camera Temperature display.

High Sensitivity isthe normal operating mode of the Fluor-S MAX. Ultra Sensitivity
provides optimal sensitivity for low-light applications. It is the default selection for
the chemiluminescence application, and may be selected for a custom application.

Note:  When you change from High to Ultra Sensitivity or visaversa, there will be a
delay of several minutes while the Fluor-S MAX camera cools down or warms
up. If you attempt to acquire an image during this period, you will be notified of
the changing temperature. If you do not want to wait, you can cancel the mode
change.
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H.3 Step Il. Position/Focus

Note:  When you click on the Position or Focus button, the light inside the Fluor-S
MAX box automatically turns off. Thisisbecauseif you focus with the camera at
maximum aperture (see note below), leaving the light on would make it difficult
to view the image. To turn the light on while positioning or focusing, hold down
the sHIFT key when clicking on the button.

Position

The next step in acquiring an image is centering your gel or other object within the
camera frame. To do this, click on the Position button. The Fluor-S MAX will begin

capturing a“live” image and updating it every second.

With the Position button selected, look at the image in the acquisition window while
you position your object in the center of the platen. If you have azoom lens on the
camera, you can adjust the magnification while you position.

You can select the Show Alignment Grid checkbox to facilitate positioning.

Fig.H-7. Fluor-S MAX alignment grid.

When you are finished positioning, click on the Stop button.
Focus

Note:  Before focusing, you should adjust the f-stop on the camera to the lowest setting
(i.e., the maximum aperture). This reduces the depth of field, allowing you to
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more accurately focus the camera. Then, after focusing, increase the f-stop to the
desired setting.

After you have positioned your sample, click on the Focus button and look at the
image in the acquisition window while aligning the two focusing arrows on the
cameralens. While focusing, the camerawill limit its focus to a small portion of the
sample (thiswill not affect any zoom lens adjustments you may have made.)

When you are finished focusing, click on the Stop button.

H.4 Step lll. Set Exposure Time

When you are ready to capture an image, you will need to select an exposure time.
“Exposure” refers to the integration of image captures on the CCD over a set period
of time. The effect is analogous to exposing photographic film to light.

The exposure time you select should be based on your application and your “best
guess’ asto what exposure will give you the best image.

Note:  The minimum exposure timein transilluminated mode is 1 second. The
minimum exposure timein epi illuminated modeis 0.1 second.

You can enter an exposure time (in seconds) directly in the field, or use the Arrow
buttons to adjust the exposure time in 10 percent increments.

Step Il - Set Expozure Time [zec)——

BE 4|3 Oreie

Fig.H-8. Selecting an exposure time.

The following table provides recommended exposure times for various applications.
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Recommended Exposure Times and Lenses

Recommended
Sample Exposure Lens & Filter! Accessories Used
Fluorescent Stain Gel 1-20 sec. Zoom/IR None
Fluorescence End-Label Gel 10 sec.—2 min. Zoom/IR None
Fluorescent Blot 0.1-3 sec. Zoom/IR None
Chemifluorescent Blot 0.1-3 sec. Zoom/IR None
Colorimetric Gel 1-5 sec. Zoom/IR White Diffusion Plate
Colorimetric Blot 0.2-10 sec. Zoom/IR None
X-ray film 0.1-5 sec. Zoom/IR White Diffusion Plate
Weak Chemiluminescence? 2-10 min. 50 mm Chemi Tray
(if sample is small)
Strong Chemiluminescence? 5 sec.—1 min. 50 mm Chemi Tray
(if sample is small)
1For sharper focusing, close the f-stop down 1-2 stops from full open while focusing.
2For chemi applications, the 50mm lens is recommended. Always remove the 660 filter.

For most applications, you can select an exposure time, capture an image, study it,
then adjust the exposure time accordingly. Repeat this procedure as many times as
necessary to obtain a good image.

For chemiluminescent samples, which degrade over time and emit low levels of light,
you can select a high exposure time initially and use Live Acquire mode to save
intermediate exposures (see following section).

Preview

For shorter exposures, you can use Preview to test different exposure times. Click on
the Preview button create a preview exposure and display it in the acquisition
window.
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A preview scan takes only half aslong to create asareal scan, because the preview
scan does not capture a“dark” image (see below). The progress of the exposure will
be displayed in the Exposure Status bar at the bottom of the dialog box.

You cannot save preview scans.

If you want to stop a preview scan that isin progress, click on the Stop button.

H.5 Acquire the Image

The Fluor-S MAX gives you the option of smply acquiring and displaying afully
exposed image, or preserving intermediate exposures.

Acquire

To acquire and display afully exposed image, click on the Acquire button. An
exposure will be taken based on the time selected in Step 111. Thisis appropriate for
most short exposures.

The progress of each exposure will be displayed in the Exposure Status bar at the
bottom of the acquisition window.

Expozure Status
| ]

Aoquiring Image

Fig.H-9. Exposure Status bar when acquiring an image.

Depending on which dark subtraction type you have selected, a dark count may be
acquired immediately following image acquisition. See Dark Subtraction Type under
Options, below.

If you want to stop a scan that isin progress, click on the Stop button. The acquisition
will be terminated.
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After an image has been acquired, a separate window will pop up containing the new
image. Thewindow will have adefault file name that includes the date, time, and user
(if known). To save the image, select Save or Save Asfrom the File menu.

You can then analyze the image using the standard analysis functions.

Live Acquire

Live Acquire allows you to view and preserve intermediate exposures leading up to a
full exposure. Thisisuseful for longer exposure times, such as those required by
chemiluminescent samples, where there is the potential for image saturation.

When you click on the Live Acquire button, the exposure time you selected is divided
by the number of exposure counts set in the Options dialog box (see Options, below).
For example, if you enter an Exposure Time of 10 minutes and an Exposure Count of
20, then 20 intermediate exposures will be produced at 30-second intervals. Each
intermediate exposure will be displayed in the scan window. Thefinal, full exposure
will be displayed in a separate image window.

Note:  Thefirst intermediate exposure will take longer than 30 seconds to display if
dark subtraction is performed.

You can automatically save your intermediate exposures as separate files for later
review using the Auto Save After Scan option. See Options, below.

If you see an intermediate exposure that you like in the scan window, click on the
Stop button. Live Acquire will end and the last i ntermediate exposure to be compl eted
will open in a separate image window. You can then saveit for analysis.

H.6 Options

Click on the Options button to open the Options dialog box.
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Fluor-5 Options

rFluor-5 Information rDark Subtraction Type

Fluar-5 MaX Multilmager (simulated) f# Momal ™ Referenced (™ Mone

Imager Firmware verzion: 1.01 T

Imager Hardware Yersion: 1.01

rLive Exposure Mode

Imaging Area [om) Exposure Court: (5
R - L to {“#Save all intermediate Images
Height: |%.10 M

rSave

rDizplay i [J4uto Save After Sean

[(JAuta-scale Transform After Acquistion 1 ake Backup Copy

0K | Cancel

Fig.H-10. Options dialog box.

H.6.a Dark Subtraction Type

All CCD cameras accumulate electrons that produce a“signal” that is
indistinguishable from light. This “dark count” addsto the noisein your images. In
most cases, you will want to subtract this dark count from your images.

Normal

The Normal option button selects the default dark subtraction type. In this mode, after
you acquire an image, a“dark” image of the same exposure length will be taken, and
thiswill be subtracted from your image.

The progress of the dark exposure will be displayed in the Exposure Status bar
following the regular image exposure.

Note:  In Normal mode, adark imageisonly acquired the first time you perform a scan
with particular application and exposure settings. If you perform subsequent
scans with the same settings, no dark exposure will be taken.
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Referenced

If you do not want to perform adark exposure with each acquisition, you can take a
“reference” dark exposure that will be saved and subtracted from all subsequent
acquisitions. Click on the Referenced button to activate this feature.

Thefirst time you acquire an image after selecting this option, the Fluor-S MAX will
take a 300-second dark exposure that will be saved and used to subtract the dark count
from all subsequent acquisitions.

For image exposures of greater or |ess than 300 seconds, the reference dark will be
scaled accordingly and then subtracted. You can change the default reference dark
exposure time using the Reset Reference button (see below).

If you deselect the Referenced button and then reselect it, the old reference dark
exposure will still be available.

Note:  Separate reference dark exposures will be taken for High Sensitivity mode and
Ultra Sensitivity mode. Once you have created a reference dark in each of these
modes, each reference dark will be used according to the mode you arein.

Reset Reference Button

If you would like areference dark with an exposure time that more closely matches
that of your typical scans, click on the Reset Reference button.

Feset Reference Dark Image

Dark Exposure Time: |20. DDI Seconds

0K | Cancel

"Dptions

Fig.H-11. Reset Reference Dark pop-up box.
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A pop-up box will prompt you to enter a new reference dark exposure time in
seconds. Click on OK to implement your change. The new reference dark will be
created when you acquire your next image.

Note:

Because of the high sensitivity of the CCD, fluctuations in background radiation
and/or temperature in the room can affect the level of dark count. If you feel that
radiati on/temperature conditions have changed in the room since your last
reference dark was created, use the Reset Reference button to delete your old
reference and create a new one under current conditions.

None

If you do not want to perform dark subtraction, select None. No dark exposure will be
acquired or subtracted.

H.6.b Live Exposure Mode

Exposure Count

If you are using the Live Acquire function (see previous section), you need to specify
how many intermediate exposures you want to view/save during acquisition. Enter
this number in the Exposure Count field.

The total exposure time will be divided by the number you enter in the Exposure
Count field. If you enter an exposure time of 10 minutes and a count of 10, you will
create 10 intermediate exposures at 1 minute intervals.

Note:

Do not enter a count that will result in an intermediate exposure time that is less
than the minimum exposure time for the mode you are in. The minimum
exposure time in trans illuminated mode is 1 second, and the minimum exposure
timein epi illuminated mode is 0.1 second. (Example: For atransilluminated
application, an exposure time of 20 seconds and an exposure count of 21 would
result in an error.)

Save All Intermediate Images

If Auto Save After Scan is selected (see following section), the Save All Intermediate
Images checkbox will become active. If you select this checkbox, all your
intermediate exposures will be saved as separate files. These fileswill have the same
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root name appended by a number indicating the exposure sequence. The final, full
exposure will have the root name only, with no exposure number.

H.6.c Save

Auto Save After Scan

To automatically save any image you create, click on the Auto Save After Scan
checkbox.

Note:  In PDQuest, this option is preselected and cannot be turned off. All images must
be automatically saved when acquired.

With this checkbox selected, when you click on Acquire or Live Acquire, a Save As
dialog box will open asking you to specify afile name and location for theimage you
are about to create. The scan will begin when you click on the Save button.

Note that in Live Acquire mode you can save your intermediate exposures by
selecting Auto Save After Scan and then Save All Intermediate |mages.

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first
select Auto Save After Scan (see above), then select the Make Backup Copy
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup fileswill have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.

H.6.d Imaging Area Size

Theimaging areais the area of the sample that is captured by the camera and
displayed in the scan window. To specify the size of your imaging area, enter a
dimension in the appropriate field. When you change one imaging area dimension,
the other will change to maintain the aspect ratio of the cameralens.
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The imaging areawill change depending on your zoom factor. For example, if you
have zoomed in on aareathat is 4.5 x 3.5 cm, then you would enter 4.5 for the width
(3.5 for the height would be calculated automatically).

Note:  Your imaging area settings must be correct if you want to do actual-size printing.
They must also be correct if you want to compare the quantities of objects (e.g.,
using the Volume Tools) in different images.

Theimaging area dimensions also determine the size of the pixelsin your image (i.e.,
resolution). A smaller imaging areawill result in a higher resolution.

H.6.e Auto-scale Transform

Auto-scale Transform after Acquisition allows the user the option of having theimage
automatically perform the Auto-Scale transform function upon completion of image
acquisition. This eliminates the need to transform an image or re-scan an image when
the acquisition time was too short or the iris not opened enough.

To enable the auto-scal e transform function, check the box |abeled, Auto-Scale
Transform after Acquisition in the Options dialog.

H.7 Other Features

[*] Highlight 5 aturated Fixels

Image file size: 2. 60 Mhb Optianz | Help

"D izplay Optionz

Fig.H-12. Other Fluor-S MAX acquisition window features.

Highlight Saturated Pixels

When thisbox is checked, any saturated pixelsin theimagewill appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.
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File Size of Images

Image File Size (below Options) shows the size of the image file you are about to
create. This size is determined by whether the image was created in High Sensitivity
or Ultra Sensitivity mode.

If you do not have enough computer memory for the specified file size, an error
message will appear when you attempt to acquire an image. (Macintosh users can
increase the application memory partition. See your Macintosh computer
documentation for guidance.)
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Appendix |
Personal Molecular Imager FX

Fig.lI-1. Personal Molecular Imager FX

Before you can begin acquiring images using the Personal Molecular Imager® FX,
theinstrument must be properly installed and connected with the host computer. See
the Personal FX hardware manual for installation, startup, and operating instructions.

Note:  The Persona FX should be turned on and the initialization sequence completed
before the host computer is turned on (except in the case of certain Power
Macintosh configurations). See the hardware manual for more details.
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PC Only: A Note About SCSI Cards

The Personal FX is connected to your computer by a Small Computer System
Interface (SCSI) cable. To use the Personal FX, you must have a SCSI card installed
in your PC. If you have a PC with a Windows 98 or Windows ME operating system,
you may also need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simul ation mode.”
In this mode, an acquisition window will open and the controlswill appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. The title of the acquisition window will indicate that it is
simulated.

.1 Personal FX Acquisition Window

To acquire images using the Personal FX, go to the File menu and select Personal
FX.... The acquisition window for the imager will open, displaying a control panel
and the scanning area window.
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£ Personal FX [ ]

Step | - Select Scan Area

I
.

Click and drag in diagram to zet scan area,
Top g Left: 4
Bottom: [0 Right: |11

[2] Quadiant Mode

Step |l - Select Resolution

™ 50 micrometer
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™ 200 micrometer
™ 800 micrometer

Image file size: &.70 b
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[J&uta Save After Scan (] Highlight S aturated Fixels
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1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Fig.I-2. Personal FX acquisition window

The default scanning window is marked by grid lines that divide the areainto
quadrants. Thereis also an outer box and inner box marked by thicker lines. The
quadrants are numbered 1-16 left to right and lettered A—U top to bottom.

If you prefer a scanning window measured in centimeters, deselect the Quadrant
Mode checkbox in the control panel by clicking onit. To hide the gridlines, click on
the Hide Grid checkbox under Options.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are three basic steps to scanning an image using the
Persona FX:

1. Select the scan area
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2. Select theresolution

3. Acquiretheimage

.2 Step |. Select Scan Area

To select a scan area, drag your mouse within the scanning window. (In the scanning
window, your cursor appearance will change to a cross.) The border of the scan area
you are selecting is marked by aframe.

1

Drag cursor t
define scan
ea

Fig.l-3. Selecting a scan area.

If you are in quadrant mode, note that the frame “locks” onto the next quadrant as you
drag. When you release the mouse button, the border changes to a dashed blue line,
indicating a selected area.

»  Toreposition the scanning box you have selected, position your cursor inside the
box and drag. The entire box will move.

* Toresize the box, position your cursor on abox side and drag. The side you have
selected will move.

e Toredo the box entirely, position your cursor outside the box and drag. The old
box will disappear and a new box will be created.
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You can also select the scanning area by entering coordinatesin the appropriate fields
(Top, Bottom, Left, Right). After you enter a coordinate, the position of the scanning
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with
borders. You can always crop the image later.

1.3 Step Il. Select Resolution

The Personal FX acquisition window allows you to scan at 50, 100, 200, or 800
micrometers. These resolutions are listed as option buttonsin the control panel.

~Step |l - Select Reszalution
™ B0 micrameter
{100 micrameter
{200 micrameter
" BOO micrameter

Irmage file zsize: & 09 b
Fig.I-4. Resolution option buttons.

The resolution you select should be based on the size of the objects (e.g., bands,
spots) you are interested in. For example:

» 50 micrometer resolution should be reserved for images requiring the highest
level of detail, e.g., high density in situ samples, 1,536-well microplates, high
density arrays, samples with very closely spaced bands. Files scanned at 50
micrometers can be very large.

« 100 micrometer resolution should be used for typical gels and arrays.
e 200 micrometer resolution is useful for gels with large bands and dot blots.

» 800 micrometer resolution should be reserved for very large objects, such as CAT
assay’s.
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File Size of Images

Image File Size (below Select Resolution) shows the size of the scan file you are
about to create. If you do not have enough computer memory for the specified file
size, an error message will appear when you attempt to scan. If this happens, select a
lower resolution or decrease the size of the area to be scanned. (Macintosh users can
also increase the application memory partition. See your Macintosh computer
documentation for guidance.)

.4 Acquire the Image

Once you have selected your scan area and resolution, you ready to acquire an image.

Click on the Acquire button. There may be a short delay while the image laser warms
up; then the scanned image will begin to appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the
interrupt, and then you will be asked if you want to keep the partial scan. This feature
isuseful if you overestimated the size of the areayou selected.

Note: If theimage you are scanning has more than 10 saturated pixels, you will receive
awarning message.
Saving the Image

After the scan is complete, a message will appear asking you if you want to keep the
scan. If you select Yes, a separate window will pop up containing the new image.

You can then save and analyze the image using the standard menu and tool bar
functions.
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.5 Options

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan
checkbox.

Note: InPDQuest, this option is preselected and cannot be turned off. All images must
be automatically saved when acquired.

With this checkbox selected, when you click on Acquire, a Save As dialog box will
open asking you to specify afile name and location for the image you are about to
create. The scan will begin when you click on the Save button.

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first
select Auto Save After Scan (see above), then select the Make Backup Copy
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup files will have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.

Highlight Saturated Pixels

When this box is checked, any saturated pixelsin theimage will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.
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Disable Default Filter

To disable the default filter in the FX, click the Disable Default Filter checkbox.

Warn on Saturated Pixels

The Warn on Saturated Pixels option is checked by default. Uncheck this box to
disable thiswarning.
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Molecular Imager FX
Family (FX Pro, FX Pro
Plus and Molecular FX)

Fig. J-1. Molecular Imager FX

Before you can begin acquiring images using any of the Molecular Imager FX family
of products, the particular instrument must be properly installed and connected with
the host computer. See the corresponding FX hardware manual for installation,

startup, and operating instructions.

J-1



Quantity One User Guide

Note:  The FX should be turned on and the initialization sequence completed before the
host computer is turned on (except in the case of certain Power Macintosh
configurations). See the hardware manual for more details.

PC Only: A Note About SCSI Cards

The FX is connected to your computer by a Small Computer System Interface (SCSI)
cable. To use the FX, you must have a SCSI card installed in your PC. If you have a

PC with a Windows 98 or Windows ME operating system, you may aso need to load
the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “ simulation mode.”
In this mode, an acquisition window will open and the controls will appear active, but
instead of capturing real images, the window will create “dummy” images of
manufactured data.

You do not need to be connected to an imaging device to open asimulated acquisition
window. Thisis useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device
from the File menu. Thetitle of the acquisition window will indicate that it is
simulated.

J.1 FX Acquisition Window

To acquire images using the FX, go to the File menu and select FX.... The acquisition
window for the imager will open, displaying the control panel for the imager and the
scanning area window.
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Fig. J-2. FX acquisition window

The default scanning window is marked by grid lines that divide the areainto
quadrants. Thereis also an outer box and inner box marked by thicker lines. The
quadrants are numbered 1-16 l€ft to right and lettered A-U top to bottom.

If you prefer a scanning window measured in centimeters, deselect the Quadrant
Mode checkbox in the control panel by clicking onit. To hide the gridlines, click on
the Hide Grid checkbox under Options.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are four basic stepsto scanning an image using the FX:

1. Select the application(s).
2. Select the scan area.
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3. Select the resolution.

4. Acquiretheimage.

J.2 Step I. Select Application

In Step 1, you select the appropriate filters and other scanning parameters for the type
of gel, blot, plate, or other object that you are imaging. Each set of parameters you
select iscalled an “application.”

The FX now supports multi-channel sequential scanning. Thisalowsyou to
automatically scan the same object using up to four different applications (e.g., to
detect different types of stains on the same gel).

First you select a channel, then you select the application under that channel.

J.2.a Selecting a Channel

The four channels are accessed using the tabs under Step 1. Channel 1 isaways
enabled—that is, the FX will always scan using the application settings selected
under Channel 1 first.

To enable any of the remaining channels, click on a channel tab, then select the
Enable Channel checkbox and select the application for that channel as described in
the following section.
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Click on the tab to ~Step | - Select Application

select the channel —WPH Channel 2 H Charnel 3 H Channel 4

Select the checkbox
to enable the channel %3 Enable Channel

Click on the Select —— Select..

button to select the
application

Densitometry
Coomassie Blue Gel/Blot (Medium)

(E3E/106dnm EX) (Elank) (E55nm LP) (10&4nm BL)

Fig. J-3. Enabling Channel 2.

Enabled channels have a green check mark on their tabs.

You do not need to enable Channels 2—4 in sequence. For example, you can set up
your four most common applications using the different channels, but only enable
Channel 4 for aparticular gel. Channel 1 would be scanned first, Channel 4 second.

Enabled channels are scanned sequentially. The separate scans are displayed and
saved as separate images. The total scanning time depends on the number and type of
enabled applications.

If you have selected Auto Save After Scan, the image created using Channel 1 will
have the base file name, and images created using subsequent channels will have the
base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image version
number does not necessarily correspond to the channel number. For example, if you
scanned an image using only Channels 1 and 4, the image created using Channel 4
will be saved asversion 2 (v. 2).

J.2.b Selecting an Application

To select an application (i.e., the appropriatefilter and other parameters for the type of
object you are imaging), click on the Select button under a channel tab.
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Radinisotopes
Chemiluminescence
Chemifluorescence
DA Stain Gel
Protein Stain Gel

Sypro Orange

Fluorophores

Sypro Red ) .
Microtiter Plate A High Sample Intensity

Mile Red . .
Censitometry Medium Sample Intensity

Sypro Ruby .
Custom Low Sample Intensity

I e e

Fig. J-4. Example of an application tree: Ethidium Bromide gel.

Standard Applications

The standard applications and associated settings are listed in atree that expands from
left to right. When you select a standard application, the software automatically
selects the appropriate filter(s) in the FX for that particular application. Some
applications are inactive in the FX Pro and FX Pro Plus systems.

Standard FX Applications

Category Application
CS- or BI-Screen (Bio-Rad)*
Radioisotopes K-Screen (Kodak)
Fuji-Screen
Chemiluminescence Chemi-Screen (Bio-Rad)*
. ECL-Plus
Chemifluorescence Attophos
Ethidium Bromide
DNA Stain Gel Sybr Green | & 11
Sybr Gold
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Standard FX Applications

Sypro Orange
Sypro Red
Nile Red
Sypro Ruby

Protein Stain Gel

Alexa 488
Alexa 532
Alexa 546
FITC
Fluorophores FAM
CY3
HEX
R6G
Texas Red

DNA (Sybr Green I)
Protein (Nano Orange)
ssDNA (Oligreen)
DNA (Picogreen)
B-Gal (FDG)
GUS (FDG)

Microtiter Plate

Coomassie Blue Gel/Blot
Copper Stain Gel/Blot
Silver Stain Gel/Blot
X-Ray Film (Grey Type)

Densitometry

INot supported in the FX Pro and FX Pro Plus systems.

First select your general application, next select the particular stain or medium you
areusing, and finally (if appropriate) select the intensity of your samples.

Note:  Some applications require an external laser. If you choose one of these without
having an external laser attached, you will receive awarning.

To exit the tree without selecting, press the ESC key.

Your selection and settings will be displayed below the Select button.
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Sample Intensity

Many FX applications require that you select a sample intensity (High, Medium, or
Low) from the application tree. Thisis simply arough estimate of how much sample
isvisiblein your gel or other object.

If you are unsure of the level of intensity of your sample, you can always select a
level, capture an image, then adjust the level and capture another image.

For example, if you select Low Sample Intensity and the resulting image has too
many saturated pixels, you will receive awarning message. Simply change the setting
to Medium Sample Intensity and rescan. If you select High Sample Intensity and the
resulting image is too faint, select Medium or Low and rescan.

Custom Applications

If your application isnot listed, if you want to use user-installed filters, or if you want
to use an external laser, you can create and save your own custom application.

From the application tree, select Custom, then Create. Thiswill open adialog box in
which you can name your application and select your settings.

Radioisotopes
Chemiluminescence
Chemifluorescence
DMA Stain Gel
Frotein Stain Gel
Fluoraphores
Microtiter Plate
Densitometry
Custom

Create a new Imager FX Application.

Mame: |Custom hpplication 1

Create..—

Ste
[S |

Filter ... Blank
Filter B.... Eio-Pad Padioizotope
Filter ... E3zrnm Blocking
Lazer... E32/1064nm
PHT Yoltage... | Low Sample Intensity

Fig. J-5. Creating a custom application.
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To select afilter (including user-defined) or filter combination, click on the buttons
for Filters A, B, and C, and make your choice from each pop-up list.

Note:  Filter wheel Cisnot available in the FX Pro or the FX Pro Plus systems.

Note:  Theuser-defined filters (Userl, User2, etc.) cannot be renamed in the pop-up list,
S0 be sure to remember which filter you insert into each position in the FX (i.e.
690 nm filter, 605 nm BFfilter).

To use an external laser, click on the Laser button and select it from the pop-up list
(i.e. 488 nm or 635 nm laser). Otherwise, use the default internal laser (532/1064nm).

Note:  The dual laser (532/1064 nm) is not available in the FX Pro or the FX Pro Plus
systems.

Click on the PMT Voltage button to select a standard voltage for your custom
application or create acustom PMT voltage.

To select a custom voltage, click on the Custom option. In the dialog box, adjust the
slider to select aPMT voltage as a percentage of the maximum.

rian semele ey g

1 Medium Sample Intensity
Low Sarmple Intensity Selecta custom PMT voltage.
" | Choose later
_ | cCustom.. _— ) PMT Voltage: =] X
High Sample Intensity ,—Di Lowy Sample Intensity
Lowy PWT *oltage High PMT “oltage
Cancel| OK

Fig. J-6. Selecting a custom PMT voltage.

Note:  For voltages above 80% of maximum, you will receive a warning message that
the high voltage could damage the PMT.

If you select Choose Later from the list of PMT voltages, the choices of sample
intensity will be displayed when you select your custom application.
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Finally, enter aname for your application in the Name field and click on OK to
implement your changes.

After you have created an application, you can select it from the application tree by
selecting Custom and the name you created. You can del ete the application by
selecting Custom, Delete, and the name of the application.

Radicisotopes
Chermilurninescence

Chemifluorescence
DA Stain Gel
Protein Stain Gel

Fluorophores
Micratiter Plate

Densitormetry

Custom

Create... A I

Delete I
=)

Custom Apnlication 1

Custow Application 2 Custorn Applicatian 2

Custon

High Sarmple Intensity

Medium Sample Intensity

Step Il - Select Scan Area Low Sample Intensity
Click and draq in diagram to set scan ares |

Fig. J-7. Selecting a custom application.

You can edit a custom application by selecting Custom, Edit, and the name of
the application. You can also use this feature to create a new custom
application from an existing one.

~Step | - Select Application
JEhanneHH Channel 2 || Channel 3 || Chanmel 4

Select...

Densitometry
Coomassie Blue Gelf/Blot (Medium)

(532/1064nm EX) (Blank) (555nm LP) (1064nm BL)

Fig. J-8. Application selection and settings.
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Once you select an application, the application name and settings appear
below the Select button.

J.3 Step Il. Select Scan Area

To select a scan area, drag your mouse within the scanning window. (In the scanning
window, your cursor appearance will change to a cross.) The border of the scan area
you are selecting is marked by aframe.

1

Drag|cursor to
define scan
area

Fig. J-9. Selecting a scan area.

If you are in quadrant mode, note that the frame “locks” onto the next quadrant as you
drag. When you release the mouse button, the border changes to a dashed blue line,
indicating a selected area.

«  Toreposition the scanning box you have selected, position your cursor inside the
box and drag. The entire box will move.

« Toresize the box, position your cursor on abox side and drag. The side you have
selected will move.

« Toredo the box entirely, position your cursor outside the box and drag. The old
box will disappear and a new box will be created.
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You can also select the scanning area by entering coordinatesin the appropriate fields
(Top, Bottom, Left, Right). After you enter a coordinate, the position of the scanning
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with
borders. You can always crop the image later.

J.4 Step lll. Select Resolution

The FX acquisition window allows you to scan at 50, 100, 200, or 800 micrometers.
These resolutions are listed as option buttons in the control panel.

Step I - Select Resolution
{ 50 micrometer
{+* 100 ricrometer
{200 ricrometer
{800 micrometer

Image file size; 3.12 Mb
Fig. J-10. Resolution option buttons.

The resolution you select should be based on the size of the objects (e.g., bands,
spots) you are interested in. For example;

« 50 micrometer resolution should be reserved for images requiring the highest
level of detail, e.g., high density in situ samples, 1,536-well microplates, high
density arrays, samples with very closely spaced bands. Files scanned at 50
micrometers can be very large.

e 100 micrometer resolution is useful for typical gels and arrays.
e 200 micrometer resolution is useful for gels with large bands and dot blots.

e 800 micrometer resolution should be reserved for very large objects, such as CAT
assays.
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File Size of Images

Image File Size (below Select Resolution) shows the size of the scan file you are
about to create. If you do not have enough computer memory for the specified file
size, an error message will appear when you attempt to scan. If this happens, select a
lower resolution or decrease the size of the area to be scanned. (Macintosh users can
also increase the application memory partition. See your Macintosh computer
documentation for guidance.)

J.5 Acquire the Image

Once you have selected your application, scan area, and resolution, you are ready to
acquire an image.

Click on the Acquire button. There may be a short delay while the image laser warms
up; then the scanned image will begin to appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the
interrupt, and then you will be asked if you want to keep the partial scan. This feature
isuseful if you overestimated the size of the areayou selected.

Note:  If theimage you are scanning has more than 10 saturated pixels, you will receive
awarning message. If this happens, you can go back and select a higher sample
intensity in the application tree.

Saving the Image

After the scan is complete, a message will appear asking you if you want to keep the
scan. If you select Yes, a separate window will pop up containing the new image.

You can then save and analyze the image using the standard menu and tool bar
functions.
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J.6 Options

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan
checkbox.

With this checkbox selected, when you click on Acquire, a Save As dialog box will
open asking you to specify afile name and location for the image you are about to
create. The scan will begin when you click on the Save button.

If you are scanning using multiple channels, the image created using Channel 1 will
be saved using the base file name, and images created using subsequent channels will
have the base file name plus a version number. (v. 2, v. 3, v. 4). Note that theimage
version number does not necessarily correspond to the channel number. For example,
if you scanned an image using only Channels 1 and 4, the image created using
Channel 4 will till be saved asversion 2 (v. 2).

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first
select Auto Save After Scan (see above), then select the Make Backup Copy
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup files will have an “.sbk”
extension. Macintosh backup files will have the word “backup” after the file name.

This backup copy will be read-only, which means that you cannot make changesto it.
You can open it like anormal file, but you must save it under a different file name
before editing the image or performing analysis.

Highlight Saturated Pixels

When this box is checked, any saturated pixelsin theimage will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Image > Transform command.
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Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.

Disable Default Filter
To disable the default filter in the FX, click the Disable Default Filter checkbox.

Warn on Saturated Pixels

The Warn on Saturated Pixels option is checked by default. Uncheck this box to
disable thiswarning.
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Appendix K
VersaDoc

Fig.K-1. VersaDoc.

Before you can acquire images using the VersaDoc Imaging System, you heed to
install the Roper Scientific interface adapter and its associated device driversin your
computer. The driver installation procedures for Windows operating systems inlcude
pre-installation and use of the Windows Hardware Wizards.

Note:  Important! Please read and follow the driver installation procedures contained in
the README documents before you install the VersaDoc camerainterface
adapter. You can find the README documentsin the VersaDoc Drivers folders
on The Discovery Series (TDS) CD.
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The CD also contains Roper Scientific camerainterface driver installation
instructions for Macintosh computers.

See the VersaDoc hardware manual for further installation, startup, and operating
instructions for the VersaDoc Imaging System.

K.1 VersaDoc Acquisition Window

To acquire images using the VersaDoc, go to the File menu and select VersaDoc....
The acquisition window for the instrument will open, The acquisition window opens,
displaying a control panel and an image display window.

& VersaDoc

~Step | - Select Application
o Channel 1| Chamnel 2 || Chamnel3 || Channel 4
4% Enable Channel
Select...
SYPRO Orange
S20LP UV TRAMS
A Gain 1x1 Bin
~Step Il - Position/Focu
Positian Focus
{1 Show Alignment Grid 32 Lights ON
Step Il - Set Exposure Time (sec)
’V 1.0 +| & @ Preview
[¥Flat Fielding

@ Acauite| ) Optivize Expasure| {3 Sion |

Display Option:
{ [JHighlight Saturated Piksls |

Image file size: 0.50 b Options...| [Z Help

"Expnsum Statu

Fig.K-2. VersaDoc acquisition window.

When the VersaDoc window first opens, no image will be displayed.

The control panel has been arranged from top to bottom to guide you through the
acquisition procedure. There are four basic steps to acquiring an image using the
VersaDoc:
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Select the application.
Position and focus the object to be imaged.

Set the exposure time.

E A

Acquire theimage.

K.2 Step I. Select Application

In Step 1, you select the appropriate filters and other imaging parameters for the type
of gel, blot, plate, or other object that you are imaging. Each set of parameters you
select is called an application.

The VersaDoc supports multichannel sequential imaging. This allows you to
automatically image the same object using up to four different applications (e.g., to
detect different types of stains on the same gel).

First you select a channel, then you select the application under that channel.

K.2.a. Selecting a Channel

Note:  Ilumination Flat Fielding will be disabled if you use multiple channels.

The four channels are accessed using the tabs under Step 1. Channel 1 isalways
enabled—that is, the VersaDoc will always capture an image using the application
settings selected under Channel 1 first.

To enable any of the remaining channels, click on a channel tab, then select the
Enable Channel checkbox and select the application for that channel as described
bel ow.

Enabled channels have a green check mark on their tabs.

Note: I you use the Optimize Exposure feature, only the application under the selected

channel tab will be imaged; other channels, even if enabled, will be ignored.

You do not need to enable Channels 2—4 in sequence. For example, you can set up
your four most common applications using the different channels, but only enable
Channel 4 for a particular gel. Channel 1 would be scanned first, Channel 4 second.
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Enabled channels are imaged sequentially. The separate scans are displayed and saved
as separate images. The total imaging time depends on the number and type of
enabled applications.

If you have selected Auto Save After Scan, the image created using Channel 1 will
have the base file name, and images created using subsequent channels will have the
base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image version
number does not necessarily correspond to the channel number. For example, if you
captured an image using only Channels 1 and 4, the image created using Channel 4
will be saved asversion 2 (v. 2).

K.2.b. Selecting an Application

To select an application (i.e., the appropriatefilter and illumination source for the type
of object you are imaging), click on the Select button under a channel tab.

Standard Applications

The standard applications and associated settings are listed in atree that expands from
left to right. When you select an application, the software automatically sets the
appropriate filter in the VersaDoc for that particular application.

First select your general application, then select the particular stain or medium you
are using. When you select the stain or medium, the software automatically sets the
appropriate filter (520L P, 530DF60, 610LP, clear, or none), light type (UV, white, or
none), and light source (Trans, Epi, or neither) in the VersaDoc for that particular
application.
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mucleic Acid Gels _

Protein Gels

Coomassie Blue
Blotting

Copper Stain
Densitometry PR

Silver Stain
Custom -_
8!

SYPRO Crange

SYPRO Red
Photographs

SYPRO Ruby
Clear White EPI Zinc Stain

0.5x Gain 1lxl Bin

Fig.K-3. The application tree in the VersaDoc acquisition window.

Note:  If you select an application that requires trans white illumination, you will need
to place the white light conversion screen on the sample stage area.

To exit the tree without selecting, press the Esc key or click outside the dialog box.

Your selection will be displayed below the Select button.

Custom Applications

If your applicationis not listed, if you want to use auser-installed filter, or if you want
to set the gain and bin settings manually, you can create and save your own custom
applications.

From the application tree, select Custom, then Create. Thiswill open adialog box in
which you can name your application and select your settings.
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Hucleic Acid Gels —

Protein Gels
Blottin £ Creat ¥ Doc A x
g Channel 3 || Channel 4 = LTEALE A NEVINEISEE —I
Censitametry - -
MHame: |Custom Application 3
Custom | |
Create...r\
Filker... E30DF70
Edit.. * | =]
Colorimetric
Delete llumination. .. |Trans TV -]
cl White EPI L
=8 e Custom Application 1 - T—>
lx Gain lxl Bi - Gain... 0.g
¥ obain o i Custom Application 2 an | * ﬂ
Binning... | 1xl ﬂ
Cancel| 0K

Fig.K-4. Creating a new custom application.
Enter a name for your application in the Name field.

Next, click on the buttons next to the Filter, [llumination, Gain and Binning fields to
change these settings.

Note:  Notethat if you select trans white illumination, you will need to place the white
light conversion screen on the sample stage.

A higher Binning setting (2x2, 3x3) provides optimal sensitivity for low-light
applications such as chemiluminescence. In this mode, the pixelsin the cameraare
“binned” (e.g., four pixelsare combined into one) to increase the amount of signal per
pixel without increasing noise. Note that combining the pixelsresultsin areductionin
the resolution of the image.

Selecting a higher Gain (4x) provides higher sensitivity without reduced resolution;
however, noise will also increase. Thisis useful for faint signals (bright spots will
saturate). Selecting alower gain (0.5x) is useful for brighter images that tend to
saturate. A gain setting of 1x provides the greatest dynamic range.

Click OK to implement your changes.

After you have created an application, you can select it from the application tree by
selecting Custom and the name you created.
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You can edit a custom application by selecting Custom, Edit, and the name of the
application. You can also use this feature to create a new custom application from an
existing one.

You can del ete acustom application by selecting Custom, Delete, and the name of the
application.

K.3 Step Il. Position/Focus

Before positioning and focusing the image, select the application that you will be
using under Step 1.

Note that the optimal position and focus will be different for afiltered image versus
an unfiltered one. (All standard applications except Chemiluminescence use afilter.)
Position

After you have selected your application, you are ready to center your gel or other
object within the camera frame. To do so, click on the Position button. The VersaDoc
will begin capturing a“live” image and updating it every second.

With the Position button selected, study the image in the acquisition window while
you position your object in the center of the sample stage. If you have azoom lens on
the camera, you can adjust the magnification while you position. (See the VersaDoc
User Manual for details on positioning.)

While you are positioning, you can select the Show Alignment Grid checkbox to
display atarget grid overlay on the image.

When you click on Position, the light inside the camera box automatically switches
on. To turn the light off while positioning, deselect the Light On checkbox.

When you are finished positioning, click on the Stop button.

Focus

Note:  Before focusing, you should adjust the f-stop on the camera to the lowest setting
(i.e., the maximum aperture). This reduces the depth of field, allowing you to
more accurately focus the camera. Then, after focusing, increase the f-stop to the
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desired setting. See Table 1, “Recommended Exposure Times and Lenses,” on
page 9.
After you have positioned your sample, click on the Focus button and look at the
image in the acquisition window while adjusting the focus on the camera lens. While
focusing, the camerawill limit its focus to asmall portion of the sample (thiswill not

affect any zoom lens adjustments you may have made.) (See the VersaDoc User
Manual for details on focusing.)

When you click on Focus, the light inside the camera box automatically switches on.
To turn the light off while positioning, deselect the Light On checkbox.

When you are finished focusing, click on the Stop button.

K.4 Step lll. Set Exposure Time

The “exposure time” is the period of time an image is integrated on the CCD. The
effect is analogous to exposing photographic film to light.

Setting an Exposure Time

Different applications have different optimal exposure times. If you areimaging using
multiple channels, you can select a different exposure time for each channel. First
select the channel using the tabs, then select the appropriate exposure time for that
channel.

See Table 1, “Recommended Exposure Times and Lenses,” on page 9.

You can enter an exposure time (in seconds) directly in thefield, or use the Arrow
buttons to adjust the exposure time in 10 percent increments.

2| ¥ QFeview

Fig.K-5. Selecting an exposure time.

|'5tep Il - Set Expozure Time [zec]————
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The following table provides recommended exposure times for various applications

Table 1: Recommended Exposure Times and Lenses

Recommended
Sample Exposure Lens & Filter | Accessories Used

Fluorescent Stain Gel | 3-30 sec. Zoom/IR None

Fluorescence End- 30 sec.—5 min. Zoom/IR None

Label Gel

Fluorescent Blot 0.5-5 sec. Zoom/IR Sample/Chemi
Tray (if sample is
small)

Chemifluorescent 0.5-5 sec. Zoom/IR None

Blot

Colorimetric Gel 0.1-1 sec. Zoom/IR White light con-
version screen

Colorimetric Blot 0.1-1 sec. Zoom/IR Sample/Chemi
Tray (if sample is
small)

X-ray film 0.1-1 sec. Zoom/IR White light con-
version screen

Weak 5-10 min. 50 mm Sample/Chemi

Chemiluminescence! Tray _
(if sample is
small)

Strong 10 sec.—2 min. 50 mm Sample/Chemi

Chemiluminescence® Tray _
(if sample is
small)

1For chemi applications, the 50mm lens is recommended. Always remove the 660 fil-
ter.
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Note:  For most applications, you can select an exposure time, capture an image, study
it, and then adjust the exposure time accordingly. Repeat this procedure as many
times as necessary to obtain agood image. For chemiluminescent samples, which
degrade over time and emit low levels of light, select a high exposure time
initially or use the Optimize Exposure command described on page 12.

Preview

For shorter exposures, you can use Preview to test different exposure times. Click on
the Preview button to create a preview exposure and display it in the acquisition
window.

Note:  The camera on the VersaDoc must be at the correct operating temperature before
capturing images. The temperature adjustment can take several minutes after the
camerais turned on, depending on your VersaDoc model and the ambient room
temperature. See your hardware manual for details.

A preview scan takes only half aslong to create as areal scan, because the preview
scan does not capture a“dark” image. The progress of the exposure will be displayed
in the Exposure Status bar at the bottom of the dialog box.

You cannot save preview scans.

If you want to stop a preview scan that isin progress, click on the Stop button.

K.5 Acquire the Image

You can acquire asingle exposure for each channel based on the time selected in Step
I11 (Set Exposure Time), or take a series of exposures for a particular channel over a
specified interval (Optimize Exposure).

lllumination Flat Fielding

For applications using the UV or white light transillumination, you should use the
appropriate reference plate to ensure a uniform intensity in the image. This will
compensate for normal variationsin image pixel intensity that occur with a
transilluminating light source.
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To enable this feature, select the Flat Fielding checkbox.

Note:  Flat fielding isonly available in single channel, single exposure mode. If you are
using multiple channels, or take multiple exposures using the Optimize Exposure
feature described below, Flat Fielding will be disabled.

UV Illlumination Flat Fielding: When you first select the Flat fielding checkbox, and
then acquire an image using the UV transilluminator, you will be prompted to remove
your sample and place the fluorescent reference plate on the VersaDoc sample stage
(seethe VersaDoc User Manual). A reference image of the plate will be acquired and
saved on your computer hard drive. The reference image will be applied to the sample
image to generate a Flat Field corrected image.

White lllumination Flat Fielding: When you first select the checkbox, and then
acquire an image using the white light conversion screen, you will be prompted to
remove your sample and collect an exposure of the conversion screen. A reference
image of the screen will be acquired and saved on your computer hard drive. The
reference image will be applied to the sample image to generate a Flat Field corrected
image.

For subsequent UV or white light trans exposures, you will be prompted to either use
the appropriate saved Flat Fielding image or acquire a new one. Any changesin light
source, filter, or lens setting will require the acquisition of anew Flat Fielding
reference image.

Acquire

Click on the Acquire button to capture a single image for each enabled channel. An
exposure will be taken for each enabled channel based on the time selected for that
channel in Step I11.

The progress of each exposure will be displayed in the Exposure Status bar at the
bottom of the acquisition window.

K-11



Quantity One User Guide

Expozure Status
| ]

Aocuiring Image

Fig.K-6. Exposure Status bar when acquiring an image.

Depending on which dark subtraction type you have selected under Options (see
section K.6, Options), adark image may be acquired immediately following image
acquisition.

If you want to stop an acquisition that isin progress, click on the Stop button. The
current acquisition will be terminated. If multiple channels are selected, you must
click on the Stop button once per channel to stop all acquisitions.

After an image has been acquired, a separate window will pop up containing the new
image. You can then analyze the image using the analysis functions.

Optimize Exposure

Optimize Exposure allows you to specify an interval over which a series of
progressively longer exposures are taken. All exposures are then displayed on the
screen, and you can choose the one that provides the best image.

Note:  Multiple exposures will be taken for only the selected multichannel tab. Other
channels, even if enabled, will not be used. Illumination Flat Fielding will be
disabled if you are using Optimize Exposure.

Click on the Optimize Exposure button. A settings dialog box will open in which you
can specify the total exposure time, starting exposure time, and number of exposures.
(The specified number of exposures will be taken at regular intervals between the
starting exposure time and the total exposure time.)
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£ Optimize Exposure x|

Settings

Total Exposure Time [zec.] [20.0

Starting Expozure Time [gec.] |1.0

Mumber of Exposures E

[15ave Images
Cancel| 0OF

Fig.K-7. Optimize Exposure dialog.

Note:  You should specify no more than 10 exposures in the Optimize Exposure dialog,
to avoid excessive build up of image background in later exposures. The fewer
the exposures, the less background will be added to the image. See the Release
Notes for additional instructions on reducing background in images captured
using Optimize Exposure.

Select the Save Images checkbox if you want to automatically save each exposure as
it istaken.

Click on OK in the settings dialog to begin taking exposures. If you selected Save
Images, a Save dialog box will open in which you can specify the base file name and
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the
starting exposure time and total exposure time. The exposure status bar will show the
progress of each exposure.

Depending on which dark subtraction type you have selected under Options, a dark
image may be acquired immediately following each exposure.

When each exposure is complete, an image window containing that exposure will
open in front of the VersaDoc window. Subsequent exposures are tiled in front of the
VersaDoc window.

Note that the first exposure will have the base file name; the default base file nameis
the computer user name and a time stamp. Each subsequent exposure will have a
version number (v2, v3, v4, etc.) appended to the base file name. (If you are using the
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default base file name, the time stamp may change in the course of the series of
exposures; in this case, the base file name will change and the version numbering will
reset for subseguent exposures.)

The highest version number will be the final exposure. If you did not elect to auto-
save the exposures as they were created, then each image will be unsaved.

To stop the image acquisitions, click on the Stop button.
Note:  Exposures captured before stopping will be displayed in image windows.
Study the different images and select the best exposure(s) to keep.

K.6 Options

Click on the Options button to open the Options dial og box.

£ YersaDoc Options x
rlnformation—————————— Dark Sublraction Type
Model: VersaDoe So00 & Mormal ™ Referenced (™ Mone
Firmware Yersion: 1.0 Fezet Beferenced
Hardware Yersion: 1.0
Wit EFILiche vailanie |[220F
Rl [JAuto Save After Scan
LW Tranz Light: Awailable e e e
~Dizplay

rImaging Area [CM)
\widthe ’T [JAuto-scale Transform After &cquisition

Height: |5. 1z

Cancel| 0K

Fig.K-8. Options dialog box.

K.6.a. Dark Subtraction Type

All CCD cameras accumulate electrons that produce asignal that is indistinguishable
from light. This“dark current” addsto the noisein your images, particularly for long
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exposures. In most cases, you will want to subtract this dark current from your
images.

The settings for subtracting the dark current are in the Options dialog box. Click on
the Options button in the acquisition window to open this dialog.

Normal

The Normal option button selects the default dark subtraction type. In this mode, after
you acquire an image, a“dark” image of the same exposure length will be taken, and
thiswill be subtracted from your image.

The progress of the dark exposure will be displayed in the Exposure Status bar
following the regular image exposure.

In Normal mode, adark imageis only acquired the first time you perform a scan with
particular application and exposure settings. If you perform subsequent scanswith the
same settings, no dark exposure will be taken.

Reference

If you do not want to perform adark exposure with each acquisition, you can take a
“reference” dark exposure that will be saved and subtracted from all subsequent
acquisitions. Click on the Referenced button to activate this feature.

Thefirst time you acquire an image after selecting this option, the VersaDoc will take
adark exposure that will be saved and used to subtract the dark current from all
subsequent acquisitions.

Note:  The VersaDoc 1000 will take a 60-second reference dark exposure; the VersaDoc
3000 and 5000 will take a 180-second reference dark exposure.

For image exposures that are longer or shorter than the reference dark, the reference
dark will be scaled accordingly and then subtracted. It is recommended that the
reference dark exposure time be equal to or greater than the sample exposure time.
You can change the default reference dark exposure time using the Reset Reference
button (see below).

If you deselect the Referenced button and then reselect it, the old reference dark
exposure will still be available.
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Separate reference dark exposures will be taken for images that have different levels
of binning or gain. Once you have created a reference dark for each level of binning
or gain, the appropriate reference dark will be used according to the settings of your
selected application.

Reset Reference

If you would like areference dark with an exposure time that more closely matches
that of your typical scans, click on the Reset Reference button.

A pop-up box will prompt you to enter a new dark exposure time in seconds.

Feset Reference Dark Image

"Dptions

Dark Exposure Time: SD_DDI Seconds
Ok, | Cancel

Fig.K-9. Reset Reference Dark pop-up box.

Click on OK to implement your change. The new reference dark will be created when
you acquire your next image.

Because of the high sensitivity of the CCD, fluctuations in background radiation and/
or temperature in the room can affect the level of dark count. If you feel that radiation/
temperature conditions have changed in the room since your last reference dark was
created, use the Reset Reference button to delete your old reference and create a new
one under current conditions.

None

If you do not want to perform dark subtraction, select None. No dark exposure will be
acquired or subtracted.
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K.6.h. Save

Auto Save After Scan

To automatically save any image you acquire using the Acquire button, click on the
Auto Save After Scan checkbox in the Options dialog box.

With this checkbox selected, when you click on Acquire, a Save As dialog box will
open asking you to specify afile name and location for the image you are about to
create. The scan will begin when you click on the Save button.

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first
select Auto Save After Scan, then select the Make Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in
the same directory as the scanned image. Windows backup files will have an .sbk
extension. Macintosh backup files will have the word backup after the file name.

K.6.c. Imaging Area Size

Theimaging areais the area of the sample (in centimeters) that is captured by the
camera and displayed in the scan window. To specify the size of this area, enter a
dimension in the appropriate field under Imaging Areain the Options dialog box.
Click on the Options button in the acquisition window to open this dialog.

When you change one imaging area dimension, the other will change to maintain the
aspect ratio of the cameralens.

The imaging areawill change depending on your zoom factor. For example, if you
have zoomed in on aareathat is 4.5 x 3.5 cm, then you would enter 4.5 for the width
(3.5 for the height would be calculated automatically).

Note:  Your imaging area settings must be correct if you want to do 1:1 printing. They
must also be correct if you want to compare the quantities of objects (e.g., using
the Volume Tools) in different images.

The imaging areadimensions also determine the size of the pixelsin your image (i.e.,
resolution). A smaller imaging areawill result in a higher resolution.
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K.6.d. Auto-scale Transform

Auto-scale Transform after Acquisition allows the user the option of having theimage
automatically perform the Auto-Scale transform function upon completion of image
acquisition. This eliminates the need to transform an image or re-scan an image when
the acquisition time was too short or the iris not opened enough.

To enable the auto-scal e transform function, check the box |abeled, Auto-Scale
Transform after Acquisition in the Options dialog.

K.7 Other Features

[*] Highlight 5 aturated Fixels

Image file size: 2. 60 Mhb Optianz | Help

"D izplay Optionz

Fig.K-10. Other VersaDoc acquisition window features.

Highlight Saturated Pixels

When this box is checked, any saturated pixelsin theimage will appear highlighted in
red in the scan window and in the pop-up image window. To view/hide saturated
pixelsin the pop-up image window, use the Transform command.

File Size of Images

Image File Size shows the size of the image file you are about to create. Thissizeis
determined by the resolution of the camera and any binning you perform when
capturing the image.

If you do not have enough computer memory for the specified file size, an error
message will appear when you attempt to acquire an image.

Macintosh users can increase the application memory partition. See your Macintosh
computer documentation for guidance.
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Appendix L
Cross-Platform File
Exchange

It is possible to move image data between Discovery Series software applications on
different platforms. There are different protocols depending on the platform (PC or
Macintosh) you are transferring from and to.

L.1 Macintosh to PC

To transfer afile from a Discovery Series application running on a Macintosh to a
Discovery Series application running on a PC, you need to tag the file name with the
suffix appropriate to the image file type (e.g., 1-D scan).

For 1-D gels (Diversity Database, Quantity One) use the suffix: .1sc

For DNA Scans (DNA Code) use the suffix: .dsc

L.2 PC to Macintosh

PC versions of Discovery Seriesfiles can be read directly by Macintosh applications,
with no required modifications.
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Appendix M
Other Features

Thefollowing features are available in Quantity One, but have more utility in its more
powerful companion application, Diversity Database. You can examine your gel
images in Quantity One and then database them using Diversity Database.

M.1 Categories and Attributes

User-defined <category> buttons are available in the Standards dial og box, Matched
Band Set dialog box, and Gel Layout dialog box. They allow you to categorize the
characteristics of your particular gel or any related gel to which you might apply the
same set of standards.

To define a new category, click on one of the <category> buttons. A dialog will pop
up in which you can select from alist of categories or create anew one.

£ Quantity __

Category

[

Edit | Attrbute
QK. Cancel

Fig.M-1. Category pop-up box.

To create a new category, click on the Edit button. Thiswill open another pop-up box
in which you can enter the name of your new category.
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= Edit Category E2

Cateqary

Altribute

v v |o|o|e |2

o

e | Select |

Delete | Dane |

Fig.M-2. Edit Category dialog box.

Type the name of the new category (e.g., “ Color”) next to the Category prompt and
list attributes of that category in the Attribute fields (e.g., “Red,” “Green,” “Blue,”
etc.). Theform will automatically sort your attributes alphabetically within the
Attribute fields. Categories and attributes can be defined for any characteristics of
your gel that would be useful to sort by. Typical categories might be “ Enzyme,”
“Primer,” “Probe,” “Type,” “Who,” etc.

Once you' ve created a category and attributes, you can use them in the dialog box.
Once again, click on a <category> button.

Select the category to be applied from the available categories on the list (or select
<none>). Click on the Attribute button to specify an attribute. Click OK to apply your
selection to the Standards box.

M.2 Gel Layout

In Diversity Database, you can use the Gel Layout dialog box to compare samples
across multiple gel images. In Quantity One, you can use it to enter general
information about your image.
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To open the Gel Layout form, select Gel Layout from the Edit menu.

£ Proteins - Layout

Mame Proteins Dezcription

12k rat organs
<categon>
<categon>

[Date RBun [0z-2ep-199& HlLanes |15 Width 7. 03mm

Background Subtract ¢« On  (OF (" Lane Dizk Size |S0

Lane # Hame CPi Loaded | <oategon: |

St Protein | | ﬂ
E|lz |cerebrum |18,268I |

E|lz |cerebellu.m |13,?40 |

E |4 |st,em |19,453 |

Els |t,hymus |5,939 |

El6 [mg |2, 012 |

E|? |heart |4,|:|17 |

Ejs |aort,a |'?,l385 | =

Cloze | Help |

Fig.M-3. Gel Layout dialog box.

The following information about your gel can be specified at the top of the Gel
Layout form:

e Category and attribute information (see above) for the whole gel.
* A brief description of the gel.

e Gé run date.

e Number of lanes.

e Lanewidth.
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e Lane-based background subtraction and disk size.

Each lanein your gdl hasits own line on the Gel Layout form. The following
information can be specified for alane.

e Band set type (standard or experimental).

e Lane number.

e Band set name.

e Sample name.

e Category/attributes information (see above) for individual lanes.

The pop-up buttons on the left side of the form offer anumber of choices pertaining to
theindividual lanes on your gel. Clicking on one will open the Lane Choices list.

Lane Report will open a customizable lane report form that can be printed or
exported.

Assign Band Set alows you to select the specific band set that is to be applied to that
lane.

Unassign Band Set allows you to remove the band set that is currently applied to that
lane.

View Band Set displays the band set form for the band set that is currently applied to
that lane.
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The Discovery Series™ Image Analysis Software
Softwar e License Agreement

READ THIS! THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE CUSTOMER,
AND BIO-RAD LABORATORIES, INC. ("BIO-RAD") CONCERNING THE ENCLOSED
COMPUTER PROGRAM ("THE PROGRAM"). YOU SHOULD REVIEW THE
FOLLOWING TERMS AND CONDITIONS OF THIS AGREEMENT CAREFULLY
BEFORE OPENING THIS PACKAGE. BY OPENING THIS PACKAGE YOU INDICATE
YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS. IF YOU DO NOT AGREE
WITH ANY OF THEM, YOU SHOULD PROMPTLY RETURN THE PACKAGE
UNOPENED, YOUR MONEY WILL BE REFUNDED.

LICENSE

Pursuant to the license granted to you by this Agreement, you may (@) use the Program on a
single computer; (b) copy the Program into any computer readable or printed form for back-up
or modification purposes in support of your use of the Program on the single computer (certain
programs, however, may include mechanisms to limit or inhibit copying; they are marked
"copy protected"); (c) modify the Program and/or mergeit into another program for your use on
the single computer, and (d) transfer the Program and license to another party if the other party
agrees to accept the terms and conditions of this Agreement.

Any portion of the Program merged into another program shall continue to be subject to the
terms and conditions of this Agreement. If you must transfer the Program, you must at the
same time either transfer all copies whether in printed or computer readable form to the same
part or destroy any copies not transferred, including without limitations all modifications and
portions of the Program contained or merged into other programs. You must also reproduce
and include the copyright notice on any copy, modification or portion merged into another
program.

YOU MAY NOT USE, COPY, MODIFY OR TRANSFER THE PROGRAM OR ANY COPY,
MODIFICATION, OR MERGED PORTION, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED FOR IN THIS AGREEMENT. If you transfer possession or any
copy modification, or merged portion of the Program to another party, your license is
automatically terminated.

TERM

The license is effective until terminated. You may terminate it at any other time by destroying
the Program together with al copies, modifications and merged portions in any form. It shall
also terminate upon conditions set forth elsewhere in this Agreement or if you fail to comply
with any term or condition of this Agreement. Upon such termination, you must destroy the
Program together with all copies, modifications, and merged portionsin any form.



LIMITED WARRANTY AND REMEDIES

BIO-RAD warrants the media on which the Program is furnished to be free from defects in
materials and workmanship under normal use for a period of ninety (90) days from the date of
delivery to you as evidenced by a copy of your receipt. Thiswarranty islimited to you and is
not transferable.

During the 90 day warranty period, BIO-RAD shall (a) replace any mediaitem not meeting the
foregoing warranty and which is returned to BIO-RAD or an authorized BIO-RAD dealer
("Authorized Dealer") with a copy of your receipt; or (b) if BIO-RAD of the Authorized Dealer
is unable to deliver a replacement media item which is free of defects in materials or
workmanship, you may terminate this Agreement by returning the Program, and you money
shall be refunded.

The following warranty does not extent to any media item which has been damaged as a result
of accident, misuse, abuse, or as aresult of service or modification by anyone other than BIO-
RAD or an Authorized Dealer.

EXCEPT AS EXPRESSLY SET FORTH ABOVE, THE PROGRAM IS PROVIDED "AS IS’
AND NO OTHER WARRANTIES EITHER EXPRESSED OR IMPLIED, ARE MADEWITH
RESPECT TO THIS PROGRAM, INCLUDING, WITHOUT LIMITATION THE IMPLIED
WARRANTIES OF MECHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
BIO-RAD WITHOUT LIMITATIONS EXPRESSLY DISCLAIMSALL WARRANTIESNOT
STATED HEREIN. YOU ASSUME THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM SHOULD THE PROGRAM PROVE DEFECTIVE.
YOU AND NOT BIO-RAD OR AN AUTHORIZED DEALER ASSUME THE ENTIRE
COST OF NECESSARY SERVICING REPAIR OR CORRECTION. SOME STATES DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM
STATE TO STATE.

BIO-RAD DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE
PROGRAM WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE
PROGRAM WILL BE UNINTERRUPTED OR ERROR-FREE. @ YOU ASSUME
RESPONSIBILITY FOR THE SELECTION OF THE PROGRAM TO ACHIEVE YOUR
INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS
OBTAINED FROM THE PROGRAM.

YOUR SOLE REMEDIES AND BIO-RAD'S ENTIRE LIABILITY ARE SET FORTH
ABOVE, IN NO EVENT WILL BIO-RAD BE LIABLE TO YOU OR ANY OTHER
PERSON FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION ANY
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST PROFITS, LOST
SAVINGS OR OTHER DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE



SUCH PROGRAM EVEN IF BIO-RAD OR AN AUTHORIZED DEALER HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY
OTHER PARTY.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF INCIDENTAL
OR CONSEQUENTIAL DAMAGES FOR CONSUMER PRODUCTS, SO THE ABOVE
LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

GENERAL

You may not sublicense, assign, or transfer the license or the Program except as expressly
provided in this Agreement. Any attempt to otherwise sublicense, assign or transfer any of the
rights, duties or obligations hereunder is null and void and not merely voidable.

If you have any questions concerning this Agreement, including warranty service, you should
contact BIO-RAD LABORATORIES, INC., 1000 Alfred Nobel Drive, Hercules, CA 94547.

This Agreement shall be governed by the laws of the state of California as applicable to
contracts between residents of California which are entered into and performed entirely within
Cdlifornia.

YOU HAVE ACKNOWLEDGED THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
YOU FURTHER AGREE THAT IT ISTHE COMPLETE AND EXCLUSIVE STATEMENT
OF THE AGREEMENT BETWEEN US WHICH SUPERCEDES ANY PROPOSAL OR
PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN USRELATING TO THE SUBJECT MATTER OF THIS AGREEMENT.






Bio-Rad
Laboratories, Inc.

Life Science Web site www.bio-rad.com USA (800) 4BIORAD Australia 02 9914 2800 Austria (01)-877 89 01 Belgium 09-385 55 11 Brazil 55 21 507 6191

Gn"Ol'Jp Canada (205) 712-2771 China (86-21) 63052255 Denmark 45 44 52-1000 Finland 358 (0)0 804 2200 France 01 47 0569 65 Germany 089 318 84-177
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